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INTRODUCTION

This Guidance Manual continues the discussion of and expands upon an earli-
er publication, Fundamentals of Remote Sensing: History and Practice. The book 
provides a guide on how to download, process, visualize, interpret, and analyze 
satellite images.

Satellite imagery contains large datasets, which can be derived and analyzed 
using the specialized software (SW) tools – GIS (geographic information systems). 
Today’s GIS software encompasses a broad range of proprietary and open-source 
applications. In this Manual, we will use mostly ArcGIS (commercial) and QGIS 
(open source) software.

ArcGIS is a family of commercial GIS software products by an American com-
pany ESRI (founder Jack Dungermond), which started developing GIS programs 
in the 1970s. In January 1997, ESRI decided to upgrade its GIS software platform, 
creating a single integrated software architecture – ArcGIS. In late 1999, ESRI 
released ArcMap 8.0 which ran on the Microsoft Windows operating system. The 
company regularly improves and updates its ArcGIS suite. As of mid-2020, the 
latest updated version is ArcGIS 10.8.

Quantum GIS (short name QGIS) is one of the most popular, free (under GNU 
GPL license), functional cross-platform GIS application, which is dynamically de-
veloping and used internationally in the academic and professional environments. 
Gary Sherman created Quantum GIS in 2002, and since then many developers from 
around the world have been working on its improvement. QGIS is maintained by 
an active group of volunteers who regularly update, fix bugs, and create new mod-
ules for QGIS. Currently, QGIS may be used in more than 40 languages (including 
Mandarin and Esperanto).

It is hard to imagine modern research in natural sciences without the use of 
remote sensing data (RS), as well as without their processing in GIS. Over the last 
few years, it has become possible not only to visualize features studied in dynamics 
but also to acquire new information from data analysis.

There are plenty of Internet resources (commercial and non-commercial) avail-
able now, which allow downloading satellite images of any location on our planet. 
This Guidance Manual has been developed based on the experience of the GIS and 
Remote Sensing Laboratory of the Copernicus Academy at the National Center 
“Junior Academy of Sciences of Ukraine”. In its educational activities, the Lab-
oratory uses satellite images collected by the European Space Agency within the 
framework of the Copernicus programme.

Copernicus is the European Union’s Earth observation programme (previously 
known as GMES – Global Monitoring for Environment and Security). The pro-
gramme offers information services based on the Earth observation satellite system, 



Sentinel, which includes five families of satellites: Sentinel 1 – designed to obtain 
radar data, Sentinel 2 and Sentinel 3 – provide data for land and ocean monitoring, 
Sentinel 4 and Sentinel 5 – designed for meteorological and climatic research.

In this Manual, we analyze the territories in Ukraine to provide examples of 
GIS application in scientific research. Upon mastering the research algorithm, you 
can do your scientific research in other locations. The methodology used by the 
authors for processing, visualizing, interpreting, and analyzing the satellite images 
contributes to the formation of numerous competencies in students that will help 
them adapt to the application of information technology in remote sensing surveys 
of natural and anthropogenic processes.

The proposed Guidance Manual may be useful for the students and experts of 
the Junior Academy of Sciences of Ukraine, students of higher education institu-
tions, teachers, as well as those who want to improve their knowledge in the field 
of RS and GIS. 



The authoring team expresses its gratitude to 
the Member of the National Academy of 

Sciences of Ukraine, Vadym Ivanovych Lialko, for fruitful, 
long-term collaboration with the Junior Academy 

of Sciences of Ukraine



HOW TO USE THIS MANUAL

To make the information contained in this Guidance Manual more accessible to 
you, we have used different color blocks:

– green color is for the “It Is Interesting” section;

– blue color is for additional information;

– all terms in the text are marked with yellow color;
– tips and warnings are written in red Italics.

To perform almost all tasks, we have used two main GIS applications, ArcGIS 
and QGIS, in this Guidance Manual. Each paragraph first identifies the task to 
be performed and briefly describes the theory required for better understanding 
the process, then describes the algorithm of operations in GIS applications, and 
provides step-by-step instructions for the usage of this algorithm in ArcGIS and 
QGIS (which buttons to press and which operations to perform). If you work in one 
of the applications (for example QGIS), you do not need to read the whole text; just 
read the task, the theory, and the algorithm sections and proceed to the instructions 
for the performance of the task in the application you use. Instructions for various 
software are additionally marked with color tabs located on the edges of pages: 
ArcGIS with blue and QGIS with green.

In addition to the main applications, ArcGIS and QGIS, some sections of the 
Manual comprise examples of the algorithms used in Google Earth Pro (software 
suitable for the youngest students), and Google Earth Engine (more complex soft-
ware for those who are interested in programming). These two applications are also 
marked with a gray-colored tabs on the edges of pa.

 ArcGIS – blue color tab 
(advanced level of training, commercial GIS 
software)

QGIS – green color tab 
(advanced level of training, free GIS software)

 

Google Earth Pro and Google Earth Engine – 
gray color tab  
(elementary level of training or Section for the 
Youngest Audience and For Those Interested in 
Programming section)



Section 1

ACQUISITION, PROCESSING, 
AND VISUALIZATION 
OF SATELLITE IMAGERY
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1. 1. Basic Characteristics of Satellite Imagery

Every day we come across many various images: photos, drawings, illustra-
tions, animations, etc. In this Guidance Manual, we will discuss in detail a special 
type of image – satellite imagery, which is the main data source for remote sensing 
observation of our planet.

Production of satellite imagery is a complex process of converting the energy 
of solar radiation reflected from the Earth’s surface into electromagnetic pulses, and 
their recording in a digital form, i.e. using binary codes. Such digital format images 
can be processed by your PC processor.

Please review the basic definitions below before we discuss the opportunities 
for the application of RS and GIS techniques in studying Earth’s surface.

Remote Sensing (RS) refers to Earth observation using aircraft and spacecraft equipped 
with various types of imaging devices, which measure the energy emitted from the Earth’s 
surface.

A satellite image is an image of our planet collected by spacecraft, which contains infor-
mation about electromagnetic radiation (EMR) reflected from different types of the Earth’s 
surface.

A digital image refers to an image represented in a digital format as bitmap files, obtained 
either directly via radio-frequency receivers from aircraft or spacecraft, or by digitizing ana-
log images using a scanner, TV, or video camera.

A raster is a method of digital representation of an image in the form of a rectangular grid 
of image elements – pixels (Fig. 1.1).
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A pixel (from English “picture element”) refers to the smallest element of a digital image, 
characterized by a square shape and size, which determines the spatial resolution of an 
image. 
 

Fig. 1.1. Raster structure [1]

 When selecting satellite imagery for the study, it is important to know the basic 
characteristics of sensor systems. Based on these characteristics, the decision may 
be made on the suitability of derived data for the particular task. There are four 
types of resolution: 

• spectral;
• spatial;
• radiometric;
• temporal.

Spectral resolution refers to the ability of a sensor system to register elec-
tromagnetic radiation of a specific frequency range, which is determined by the 
number of satellite bands, i.e. the intervals in wavelengths of the electromagnetic 
spectrum to which the sensor is sensitive.

The range of wavelengths used in remote sensing may be roughly divided into 
four types – radio waves, thermal radiation, infrared (IR) radiation, and visible light. 
This division is due to the differences in the interaction of electromagnetic waves and 
the Earth’s surface, and differences in the processes that determine electromagnetic 
reflection and radiation. The most widely used in scientific research is the optical 
spectrum (also called the light portion of the electromagnetic spectrum), which em-
braces the visible (380 ... 720 nm), near-infrared (720 ... 1300 nm), and mid-infrared 
(1300 ... 3000 nm) spectral regions. In this range, the reflected solar radiation con-
tains primarily information about the biochemical processes on the Earth’s surface. 
For example, the near-infrared spectral region may be effectively used to assess the 
condition of vegetation, determine the degree of its suppression or general health. 
In turn, the thermal IR radiation provides information about the surface tempera-
ture, allows to determine the temperature profiles of visible features and phenomena 
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(monitor forest fires, oil and gas flares dynamics), as well as investigate objects 
beneath the ground surface, such as subterranean rivers, underground pipelines, etc.

Depending on the spectral resolution (the number of bands corresponding to 
certain portions of the electromagnetic spectrum), sensor systems are divided into 
panchromatic, multispectral, and hyperspectral (Fig. 1.2).

Panchromatic Multispectral Hyperspectral

single broad wave-
length range (mostly 
in the visible spec-
trum) 

2 to 12 spectral bands (visible, IR, 
microwave, radio spectra)  

13 or more spectral 
bands (mostly in the 
visible and near-IR 
spectral regions)

Fig. 1.2. Panchromatic, multispectral, and hyperspectral satellite imagery

Typically, optical imaging is performed either in the full spectrum of visible 
light (panchromatic mode) or in several narrower spectral regions (multi-zone im-
aging). In panchromatic imagery, information is collected from the entire visible 
range of the electromagnetic spectrum (0.45–0.90 μm); such images usually have a 
higher spatial resolution than multispectral images and are used to clarify features’ 
boundaries, in particular in topography.

In contrast to multispectral, hyperspectral sensors divide the spectrum into 
many narrow bands (hundreds of channels). This helps to distinguish features more 
accurately according to their physicochemical composition, identify species and 
condition of vegetation, determine the geological structure, chemical composition 
of water, etc.

Spatial resolution refers to the size of the smallest identifiable features on the 
Earth’s surface. That is the size of a pixel. Currently, the best available spatial res-
olution (30 cm) is provided by the commercial images collected by WorldView 
3 satellite (adapted from Tvis website (Fig. 1.3, с)). This means that a 30×30 cm 
feature will appear in the image as a single pixel. This allows to identify a car in the 
image and determine its color (in case of color imagery). However, smaller details 
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(license plate number, design features, which help determine the make and model) 
will not be seen in the image. 

а b c

Fig. 1.3. Spatial resolution illustrated by the images of Obolon residential area in Kyiv city: 
30 m – Landsat 8 (a), 10 m – Sentinel 2 (b), 1.24 m – WorldView 3 (c)

Classification of satellite images according to spatial resolution:
• very low – 10,000–1,000 m;
• low – 30–1,000 m;
• medium – 10–30 m;
• high – 1–10 m;
• very high – 0.3–1 m.

WorldView 3 satellite is owned by DigitalGlobe Company, which has been pro-
viding satellite imagery to well-known online mapping services such as Google 
Maps, Yandex Maps, Bing for many years.

Radiometric resolution refers to the number of possible coded values for spec-
tral brightness in the data file for each band and is expressed in bits. It is determined 
by the number of gradations of color values, the corresponding transitions from the 
absolutely “black” to absolutely “white” brightness levels, and is expressed in the 
number of bits per pixel of the image (Fig. 1.4). 

 
Fig. 1.4.  Example of color gradation in the 8-bit image, where 1 byte of information 

contains 256 colors (e.g. shades of gray). Black represents a digital number of “0” and white 
represents a digital number of “255” [3]
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а b c 

Fig. 1.5. Contrast, or the number of color shades (radiometric resolution), illustrated by the 
images of the Dnipro River floodplain: 8-bit (a), 4-bit (b), 1-bit (c)

This means that in the case of a radiometric resolution of 6 bits per pixel, we 
have only 64 color gradations (26 = 64); in the case of 8 bits per pixel – 256 gra-
dations (28 = 256), and in the case of 16 bits per pixel – 65536 gradations (216 = 
65536). Previously, sensors mounted on remote sensing satellites had a radiometric 
resolution of 8 bits per pixel (Landsat 5). Currently, almost all new satellites have 
a radiometric resolution of at least 12 bits per pixel (for example, Landsat 8 has 
12 bits/pixel, and Sentinel 2 – 16 bits/pixel), which accordingly contributes to the 
increase in the physical size of satellite images, measured now not in mega- but in 
gigabytes of information. In turn, higher radiometric resolution of modern sensors 
influences the accuracy of determining the coefficients of spectral reflection and 
reduces the noise level of satellite imagery (Fig. 1.5).

Temporal resolution is defined as the 
amount of time needed to revisit and acquire 
data for the same location. The more often 
a satellite appears over a certain feature, the 
higher is the temporal resolution.

When applied to remote sensing satellites, 
the temporal resolution depends on the orbital 
characteristics of the satellite, the number of 
twin satellites, and the width of the imaging 
swath of the spaceborne sensor. It should also 
be noted that operators can adjust satellites’ 
orbits to increase the frequency of re-imaging 
(Table 1. 1).
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Table 1. 1

Temporal Resolutions of Some Satellites
Satellite  Temporal resolution (re-visit) Swath width, km

NOAA 30 min 2900

Aqua/MODIS 0.5 day 2300

Landsat 8 16 days 185

Sentinel 2A, 2B 5 days 290

RapidEye 5 days 77

PlanetScope 1 day 24

WorldView-3 1 day 13.1

         If you want to capture the temporal dynamics of a certain process, consider such force 
majeure factors as weather conditions over the studied area when selecting satellite images. 
Since passive spacecraft register only sunlight reflected from the Earth, which does not pass 
through the clouds, it is difficult to find a “clear and cloudless” image in spring and autumn.

 

Fig. 1.6. Identification of clouds and their shadows on the  
satellite image captured by Sentinel 2 

Tip on how to distinguish clouds from other features. If next to a white feature (cloud) you 
see a black (shadow) feature of exactly the same shape – be sure, it is a cloud! This principle 
can be used to check yourself and not confuse dark shadows with dark-colored water (Fig. 1.6).
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 1. 2. Sources of Remote Sensing Data

Some ten years ago, access to satellite data was limited to the world’s big-
gest militaries, wealthiest corporations, government agencies, and some scientific 
institutions. Currently, terabytes of satellite data are available to everyone. Using 
satellite images, we can see how our planet is changing every day.

For example, this is what our planet looked like on August 2, 2019 (Fig. 1.7). 
We can get such images almost every day, using spacecraft. Fig. 1.7 shows data 
collected by NOAA-20 satellite; available at: www.nnvl.noaa.gov/view/globaldata.
html#TRUE.

Fig. 1.7. View of the Earth from NOAA-20 satellite, August 2, 2019. 
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In the 21st century, there are many sources of free satellite data available. In 
particular, using data portals of the USGS (United States Geological Survey), the 
NASA (National Aeronautics and Space Administration), and the ESA (European 
Space Agency), we can download images collected by Landsat and Sentinel sat-
ellites for free and use them in GIS programs. After reading this section, you will 
know how to use the various websites to search for free Landsat and Sentinel imag-
ery of the area you are interested in and will be able to download image archives to 
your PC for further use in the ArcGIS and QGIS applications.

Satellite images are very large files. Therefore, if you want to upload an image, first make 
sure there is enough disc space on your computer. The download time depends on the Internet 
speed and file size, so be patient and wait a few minutes.

Task

Download satellite images of the Troieshchyna residential area in Kyiv and 
analyze what this area looked like in 1984 and 2019.

Historic reference. In 1980, there were several housing estates on the left bank of Kyiv 
(Voskresenka, Rusanivka, Bereznyaky, Sotsmisto of Darnytsia, Lisovyi, and Komsomolskyi). 
However, in the suburban villages of Vyhurivshchyna and Troieshchyna, locals still lived in 
one-story houses, took water from wells, and grazed horses on the edges of their villages. In 
1981, Vygurivshchyna was demolished (dozens of streets and almost one and a half thousand 
houses) [4]. First residents moved into new multi-story apartment buildings in 1983. That is 
how the Troieshchyna neighborhood appeared on alluvial soils (Fig. 1.8).

Fig. 1.8. Troieshchyna residential area. Photo by Semen Shyrochyn [5]
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If you haven’t seen yet the music video for Kamikaze song by a Danish singer MØ, check 
it out at www.youtube.com/watch?v=eVD9j36Ke94. It was filmed in Kyiv in the Troieshchyna 
residential area in 2015. The main location of this music video, similar to White Mercedes by 
Charli XCX, was a wasteland in Troieshchyna. This area has long been appreciated by many 
other foreign artists who come to the Ukrainian capital to shoot music videos. Some “winter” 
scenes of Chernobyl series were also filmed in Troieshchyna.

Task 1. Download a Sentinel 2 image of the European Space Agency capturing 
the territory of Troieshchyna neighborhood, Kyiv, as of September 10, 2019.

In the following paragraphs, 1.2.1 – 1.2.5, we will discuss in more detail free 
resources, from which you can easily download images and perform Task 1.

1. 2. 1. Copernicus Open Access Hub

It is a web platform for providing users with full, open, and free access to Senti-
nel 1 radar images, Sentinel 2 optical multi-spectral images, and Sentinel 3 surface 
data.

To gain access to the archive of satellite images for downloading, first, sign up 
and log in at SciHub – https://scihub.copernicus.eu/dhus/#/home. Click the Login 
button in the upper-right corner of the page, and select Sign up in the drop-down 
list (Fig. 1.9).

Fig. 1.9. Signing up at SciHub
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Following signup, return to the main page and log in.
To find satellite images on this site, zoom into the area of interest on the map 

using the scroll wheel of your mouse. We are looking for images of the Troiesh-
chyna residential area in Kyiv. Click the Switch to Area Mode button on the right 
sidebar. Define the area of interest on the map (polygon) using a mouse cursor. To 
finish drawing the polygon, double click the last point with the left mouse button 
(Fig. 1.10).

Fig. 1.10. Defining the area of interest, which will be used to search for images

Open the advanced search panel on the left sidebar by clicking the  icon (in 
the search bar). In this panel, you can set the time interval for images’ search, select 
a satellite, reduce cloud coverage, etc. 

In our example, check Mission: Sentinel 2 and click  Search icon. This 
website (Fig. 1.11) provides several options for images download:

1) click the Download URL link next to the image thumbnail on the left 
side of the screen;

2) click  icon next to the image thumbnail;
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Fig. 1.11. Options (1) and (2) for downloading satellite images

3) click  icon to display the image (Fig. 1.12) on the Footprint map and 
in Quicklook mode. 

In the popup box, click the long link at the top or  icon in the bottom-right 
corner of the screen. The download will start automatically.

Fig. 1.12. Option (3) for downloading satellite images

1. 2. 2. EO browser

1. Open EO browser webpage; to do this, type “EO browser” in Google or go 
to https://apps.Sentinelhub.com/eo-browser. 

EO browser allows browsing available online medium and low-resolution im-
ages collected by the European Space Agency’s satellites: Sentine1 1, Sentinel 2, 
Sentinel 3, Sentinel 5P, Landsat, Envisat Meris, MODIS, Proba V, GIBS (Fig. 1.13).

Official webpage: https://apps.sentinel‐hub.com/eo‐browser/.
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Fig. 1.13. Main screen of EO browser

2. First of all, create an account (Fig. 1.14) by clicking the Free sign up button 
on the bottom left-hand toolbar. In the popup box, enter your personal information 
and log in to the portal by clicking Sign up.

Fig. 1.14. Box for creating an account
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3. You will receive an email from Sentinel Hub asking to confirm your registra-
tion on the site (Fig. 1.15). Сlick Verify e-mail address button.

Check your spam folder to make sure the verification email didn’t end up there.

Fig. 1.15. Verification email in your inbox for finishing account setting up

4. Now log in to the site using your username and password. Click Login and 
enter your data (Fig. 1.16).

Fig. 1.16. Logging in to EO browser website
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5. To find a satellite image of the area of your interest, type the name of a settle-
ment, region, or geographical feature in the search bar in the upper-right corner of 
your screen, and select it from the dropdown list. 

In this example, we will find a satellite image of Kyiv city, namely of the 
Troieshchyna residential area (Fig. 1.17).

Fig. 1.17. Search for location, area of interest

6. Use the scroll wheel of your mouse or the navigation buttons in the bot-
tom-right corner of the screen  to zoom into the feature of your interest. You can 
move across the map by pressing and holding the left mouse button, and in this way, 
you may drag the map in the desired direction.

7. In the settings toolbar on the left side of your screen, select:
• Data source (satellite): Sentinel 2A / L1C;
• Max.cloud coverage: 10%;
• Time range: 2019-08-01 – 2019-11-10.
To select a date, choose it from the calendar rather than type because typing does not 

work (Fig. 1.18).

Fig. 1.18. Selecting the date from the calendar
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Click the Search button. The search result will provide a list of all available 
images, which match the submitted search query.

8. View the images by scrolling through the list in the left box, find the image 
from September 10, 2019 (2019-09-10), and click the Visualize button. As a result, a 
visualization tab will open with different visualization options and automatic indexes 
based on band combinations (Fig. 1.19).

Fig. 1.19. Image from September 10, 2019, to be visualized

9. The selected image will be displayed in the cartographic window, and a Vi-
sualization menu will open in the left panel to adjust the image display. By default, 
the image is displayed in True color, which means that it is visible to the human eye 
and looks like a photo taken from above. Take a look at the image, zoom into the 
Troieshchyna housing estate and geographical features located next to it. 

10. Save this image. Return to the search results tab and find the image you 
want download (in our case it is the image from September 10, 2019). Click the 

 icon next to the image date – a link will open for full-size images download.
11. Click the SciHub link. In step 1, we have created an account on this re-

source. Therefore, if the login was entered correctly, the download will start auto-
matically. Otherwise, a field will appear to enter the username and password to the 
SciHub directory (Fig. 1.20).
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Fig. 1.20. Satellite image download

12. The downloaded archive needs to be decompressed. The images may be 
found in the internal archive files in the GRANULE and IMG_DATA folders. 
You will learn how to work with downloaded data in the following paragraphs, 
1.3 and 1.4. 

Task 2. Download NASA’s Landsat 5 TM image of the Troieshchyna residen-
tial area of Kyiv city collected on April 7, 1984. 

1. 2. 3. USGS Earth Explorer

Using this resource, you can download the following images for free: Landsat, 
SPOT HRV (1986-1998 images of North America), Sentinel 2 images; SIR-C/X-
SAR radar images, as well as the SRTM digital elevation models (DEM). Besides, 
declassified archival aerial photographs of the United States and parts of the world 
are available for a fee, as well as images acquired by CORONA, EO-1 ALI, and 
Hyperion missions.

Official website: https://earthexplorer.usgs.gov/.

To download images, go to https://earthexplorer.usgs.gov/ or type Earth Ex-
plorer in the Google search bar.

You can create an account by filling out the form in English, or you can log in to 
your account if you have already registered. To create an account, click the Register 
button in the upper right corner of the main window. You will automatically jump to 
the questionnaire. Enter your data in required fields (Fig. 1.21, 1.22). 
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Fig. 1.21. The main window of Earth Explorer

Fig. 1.22. Creating a new account in Earth Explorer
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In your inbox, you will receive an email asking you to confirm your registra-
tion. Now, go to the site using your username and password. Click the Login button 
and enter your data.

You may either enclose the area for data search in a polygon with its upper 
points defined using the left mouse button (Fig. 1.23) or type a location or address 
in the search field. To perform the task, type “Troieschyna” in the search bar. Click 
the Show button to open the table of search results. Click the address in the table 
and a pin mark will be displayed on the map (Fig. 1.24). 

Fig. 1.23. Defining an area of interest on the map



REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS28

SE
C

T
IO

N
 1.

 A
C

Q
U

IS
IT

IO
N

, P
R

O
C

E
SS

IN
G

, 
A

N
D

 V
IS

U
A

L
IZ

A
T

IO
N

 O
F 

SA
T

E
L

L
IT

E
 I

M
A

G
E

R
Y

Fig. 1.24. Defining search area in the address field of the toolbar 

5. When the search area has been defined, we may proceed to time range se-
lection. Enter a date or date range in the Date Range field. By default, the Search 
month option includes all months of the specified time range. However, we can 
specify which months to search within the given date range. To do this, uncheck all 
other months. 

Select the beginning and ending dates, 01/01/1984 and 12/31/1985, and select 
all search months in the checkboxes (Fig. 1.25). 

Fig. 1.25. Selecting data range for the search

6. Go to the Data Sets tab, select Landsat in the data list, and open the list. 
Check the box for Landsat 4, 5 TM in Landsat Collection 1 Level 1 category. By 
clicking on the  icon, you can find out more information about each of the sat-
ellites (Fig. 1.26).
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Fig. 1.26. Selecting data sets for the satellite

7. Click the Additional Criteria tab, which allows entering additional search 
criteria specific to your query, for example, the Cloud Cover. To perform our task, 
we choose a cloud cover of 20%.

Fig.1.27. Entering additional search criteria

If you have selected more than one dataset (for example, Landsat 7 and 8, Sentinel 2), 
note that additional criteria will be applied separately to each dataset. You need to change the 
datasets and select the criteria one by one (Fig. 1.27).
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Fig. 1.28. List of search result images, and method of changing Data Set

8. By clicking the Results tab a list of the data selected for your query will be 
displayed (see above). 

If you have selected more than one dataset, you will need to change them one by one in 
the Data Set drop-down list (for example, Landsat 7, then Sentinel 2, etc.) because all images 
are filtered by type (Fig. 1.28).

Each search result includes ID (information on the scene), Acquisition Date 
(the date when the photo was taken), Path (scene column), Row (scene row), as 
well as the icon menu for scene level result controls (Fig. 1.29), where  Show 
Footprint displays the area covered by the image (scene of the image), Show 
Browse Overlay  displays a preview image.
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Fig. 1.29. Toolbar

а b
Fig. 1.30. Area covered by the image: the area of interest is displayed in red, image scene 

(a) or preview image (b) are displayed in purple

Using these tools, you can check if an image suits your purposes, and avoid 
downloading unnecessary data. If the image meets your requirements, click the   
Download options icon to download it (Fig. 1.30).

In the list of images in the Results tab, find the image of April 7, 1984, and 
download it (Fig. 1.31). 

Fig. 1.31. Image of April 7, 1984, to be downloaded
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9. A window will open (Fig. 1.32) with the download options for the dataset 
displayed. You should select the file of the largest size and download it (in this 
task, it is Level-1 GeoTIFF Data Product file (153.2 MB)). All other files are quick 
looks, which allow you to view the image using different combinations of bands. 
Thus, we have downloaded an archive, which must be decompressed before image 
processing. We will continue working with this archive in ArcGIS 10.5 in the next 
Section 1.3.

Fig. 1.32. Download options window

1. 2. 4. Earthdata Search

Earthdata Search is an open-source tool, which provides access to all Earth ob-
servation data collections from NASA, as well as from partner agencies. The resource 
enables users to search, visualize, compare and download Earth observation data. 

Official website: https://search.earthdata.nasa.gov/search.

To use this tool, first, you need to register. The 
registration process is no different from that to the 
previous three resources, which we have discussed 
above. By scanning the following QR-code, you can 
open a video tutorial on how to search for datasets on 
this website (Fig. 1.33, 1.34).

Рис. 1.33. QR-code. Step-by-step instructions for data search  
on NASA Earthdata Search website

The video is in English.
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Fig. 1.34. Main fields in the working window of the Earthdata Search tool  
(far left side of the screen – search box, bottom of the screen – list of collections matching 

your search criteria, main panel – search results map)

1. 2. 5. NASA – Giovanni
Giovanni displays Earth science data from various instruments on NASA satel-

lites in a variety of formats, including area plots, time series, meridional averages, 
animations, and numerical outputs, etc. This tool provides access to numerous sat-
ellite datasets, focused primarily on atmospheric composition, atmospheric dynam-
ics, global precipitation, hydrology, and solar radiation.

Users can download data on precipitation, temperature, humidity, and gas con-
centration, etc. With Earthdata Search registration you can log in and gain full ac-
cess to data and services within Giovanni.

Official website: https://giovanni.gsfc.nasa.gov/giovanni/.
By scanning the following QR code (Fig. 1.35), you can open a video tutorial 

on how to use Giovanni.



REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS34

SE
C

T
IO

N
 1.

 A
C

Q
U

IS
IT

IO
N

, P
R

O
C

E
SS

IN
G

, 
A

N
D

 V
IS

U
A

L
IZ

A
T

IO
N

 O
F 

SA
T

E
L

L
IT

E
 I

M
A

G
E

R
Y

Fig. 1.35. QR-code to open a video on quick start guide to Giovanni interface
The video is in English.

The algorithm for working with Giovanni is very similar to that of the resources 
we have discussed above. First, you need to select the data you want to download, 
then select the date range, and the area of interest. Then, specify the variables to com-
pare and download. More than 1,600 variables are currently available within Giovan-
ni [6]. A keywords search feature allows you to search for the appropriate variable. 
The generated map will be displayed automatically, and if you do not like the result, 
you can change its display mode, edit the area, etc. To download the data, click the 
Download button and choose the file format that works best for your needs.

To find out about additional resources which can be used to download images, 
see Annex 1.

1. 2. 6. Commercial Vendors of Satellite Imagery

In addition to free resources, many companies provide access to images on a fee 
basis. Their collections include extended high spatial resolution data sets, satellite 
images pre-processed for specific purposes, etc. Images of high (1–10 m) and very 
high (1 m or less) spatial resolution are available for a fee only. 

1. DigitalGlobe is an American company that creates images of the Earth’s 
surface and gives access to the satellite data of NASA, Google, and Terra-
Server. You can find satellite images in the Image Library menu – Search 
Imagery – https://discover.digitalglobe.com/.
Official page: www.digitalglobe.com/. DigitalGlobe’s image catalog is 
available at https://browse.digitalglobe.com.

2. Tvis Company offers images from all available commercial optical and ra-
dar satellites with spatial resolutions from 200 m to 30 cm per pixel, which 
may be used for numerous tasks (agricultural monitoring, monitoring de-
forestation, detection of illegal construction sites, tracking changes in the 
shorelines of water bodies, monitoring of floods and fires, etc.). In addition 
to satellite data access, the Company services include the compilation of or-
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thophotomaps, vector maps, digital elevation models (DEM), three-dimen-
sional models, etc. Go to http://www.tvis.com.ua/products/satellite-imagery 
to review the samples of satellite images offered by the Company, and read 
general information about satellites and their technical characteristics. From 
this website, you can also learn more about additional services provided by 
the Company, in particular, high-resolution UAV filming services (Fig. 1.36).

The images of high and very high spatial resolution are posted on GoogleMaps 
and Google Earth Pro. All these resources feature many tools (see paragraph 1.3), 
which allow users to create their own maps using high spatial resolution images and 
available base maps. They cannot be applied for automated analysis and interpreta-
tion but are sufficient for the creation of the simplest maps. 

It should be remembered that images provided by geo-services are subject to copyright, 
therefore, you must read the license agreement and define the permitted usage options before 
using the products.

Therefore, to select an image that suits your research the best, answer the fol-
lowing questions:

 – What is the size of features to be identified in the image; what is the scope 
of research?

 – What is the period and frequency of satellite images, i.e. how often should 
the data be updated?

 – Do you plan to use spectral indices, perform mathematical operations with 
bands or make a classification?

The answers to these questions will reveal the four main characteristics of sen-
sor systems (described in detail in paragraph 1.1), which determine the suitability of 
the selected data. Consequently, you will be able to select the proper satellite image 
to solve a given task.

Fig. 1.36. UAV filming services offered by Tvis Company
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1. 3. Applications for Satellite Images Processing  
       (ArcGIS, QGIS, Google Earth)

A geographic information system (GIS) is a computer system that provides the 
ability to use, store, edit, analyze, and display geographic data. With GIS maps it is 
possible to obtain the following information:

 – What is located in ...? (Identify the place).
 – Where is it located? (Identify the area).
 – What has changed since ...? (Identify temporary changes in a certain area).
 – What spatial structures do exist? (Identify overlays of features or phenom-

ena).
 – What will happen if? (See what happens if, for example, we add a new 

road).
To add information to a map, such information should be georeferenced (con-

tain data about feature’s longitude and latitude). 
The features in GIS projects are arranged in layers. For example, the boundaries 

of the continents and islands are represented in one layer, administrative units are 
represented in another layer, roads, buildings, etc. – in other layers. A cartographic 
layer is a representation of the features of the same class on the map (rivers, ponds, 
settlements, roads). That is, each layer has a set of features of common class and 
geometry. During visualization, each data file is presented as a separate layer. This 
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is similar to a multi-layered cake, where each layer carries information about itself, 
and all layers superimposed make a map. This representation of data on the map 
allows a user to display the layers required at a particular time easily and flexibly, 
and adjust the legends, captions, and visibility of each layer separately, etc. 

Representation of the features on the map 

а b c
Fig. 1.37. Types of geographical features’ representation: real-world (a), 

satellite image (raster) (b), vector (points, lines, polygons) (c)

1. Vector Data
According to the type of feature geometry, there may be the point, polyline, and 

polygon layers. Within each layer, individual legends – symbols, colors, and text – 
are used to visualize the information (Fig. 1.37). 

Points are used to indicate geographical features for which the location rather 
than the shape or size is important (for example, building address, mountain top). 
The point has one pair of coordinates: latitude and longitude. Polylines represent 
linear objects that have length but have no area value (rivers, streets, state borders); 
polygons are features characterized by the area and perimeter (boundaries of seas, 
parks, states, etc.). The features on the maps are arranged in layers. For instance, 
one layer represents a transport infrastructure (e.g. roads), the other layer represents 
houses, yet another – forests or parks, etc. (Fig. 1.38).
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Polylines – street data

Points – buildings data 

Polygons – vegetation data

Integrated data of vector layers – the 
map

Fig. 1.38. Arrangement of vector layers on electronic map [7]

The Shapefile is the most popular format used to work with vector geographic 
data. This vector data format was first introduced in ArcView GIS in 1990 and has 
become very popular since then. A Shapefile file is made up of at least four relat-
ed files with the same name but different extensions (an abbreviation following a 
period in the file name). Each of these files contains specific information, so when 
copying, you must always transfer all of the files (Fig. 1.39). The list of Shapefile 
files is given below: 

• .shp – the main file that contains information about a set of features – points, 
lines, or polygons;

• .dbf – an attribute file that contains the attribute data for all the features de-
scribed in the .shp file in dBase format;

• .shx – an index file which contains supporting information and is used to 
link .dbf and .shp files;

• .prj – a file which contains information about map projection of files [8];
• .sbx аnd .sbn are spatial index files that speed up operations with geometric 

features. 

An important feature of Shapefile is that one file can contain features of one type only 
(polygons, lines, or points). 
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Fig. 1.39. A Shapefile in standard explorer window (a) and ArcCatalog (b)

2. Raster Data
A raster is a dataset consisting of pixels (cells), which provide continuous cov-

erage of a certain area on the Earth’s surface. Raster data are stored as sets of values, 
i.e. pixels, which have a rectangular shape and are arranged as a rectangular grid.

Each pixel of the image contains a numeric value which represents a spectral 
brightness of the feature located on the earth’s surface at a given point. The spectral 
brightness depends on the spectral band covered by this image. Several images of 
different bands can be merged into a color satellite image (Fig. 1.40). Satellite im-
ages are examples of raster data. Each pixel of the image contains both data about 
the spectrum of the feature on the earth’s surface and geodata about its location. 

To select an application for processing satellite images, follow the algorithm 
described below.

1. If you want to study small features (e.g. houses, local felling areas), compare 
images with other data, visually interpret and digitize features with clear bound-
aries, choose Google Earth Pro application (https://www.google.com/intl/en/earth/
download/gep/agree.html), which provides free access to high-resolution satellite 
imagery.
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Fig. 1.40. Satellite image collected by Sentinel 2 on 10.09.2019. Shpola town,  
Cherkasy Oblast

2. If you need to work with spectral bands, to use them separately, visually 
interpret features with complex boundaries, create maps, perform a classification 
(automated designation of features with clear boundaries), choose ArcGIS or QGIS 
applications, which allow carrying out all these image processing operations.

3. RS data may also be processed at a professional level, which refers to a com-
plex classification (automated designation of features with blurred boundaries), use 
of different algorithms, or automation of process with software code. This requires 
knowledge of the following software tools and libraries: GDAL, IDRISI, ENVI, R 
or Google Earth Engine.

In this section, we will take a closer look at the 1st and 2nd algorithms, and show 
you how to work with Google Earth Pro, ArcGIS 10.5, and QGIS 3.4. 
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This subsection discusses the use of ArcGIS 10.5 software. 
It is a fee-based GIS, where you can create digital maps and 
work with satellite images. ArcGIS is a GIS software supplied 
by the American company ESRI (Environmental Systems Re-
search Institute).

You can download the 21-day free trial version of ArcGIS 
Pro at: www.esri.com/en-us/arcgis/products/arcgis-for-person-
al-use. ArcGIS is intuitively simple to install, you just need to 

follow the prompts. At the link above, you can also buy a one-year subscription for 
the software for individual use. 

ESRI Company offers various free ArcGIS versions for schools, colleges, and 
universities. To take advantage of this offer, contact your local ESRI representative, 
register your educational institution in the system and obtain free licenses for in-
stallation on PCs. 

A student or teacher cannot do this independently; the management of the educational 
institution should be contacted, as it is important to fill in the form correctly. You can complete 
the training independently by creating a free ArcGIS public account at https://learn.arcgis.
com/en/. During the training, you will learn how to work in ArcGIS Online (cloud-based version 
of ArcGIS) and practice various data analysis features. 

ArcGIS software is used by the majority of higher educational institutions of 
the world, including some Ukrainian universities: Taras Shevchenko National Uni-
versity of Kyiv, the National Defense University of Ukraine named after Ivan Cher-
niakhovskyi, Ivan Franko National University of Lviv, etc. 

ArcGIS has a set of applications, which can be used to solve many geoin-
formation tasks: mapping, data entry, data analysis, and share access to spatial 
information (Fig. 1.41).

 Fig. 1.41. Set of applications in ArcGIS
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ArcGIS for Desktop consists of several integrated applications, the primary of 
which are ArcMap and ArcCatalog. ArcCatalog manages the storage of spatial data, 
the structure of databases, and recording and viewing of metadata. ArcMap is used 
to create and edit maps, as well as to perform cartographic analysis. ArcMap con-
tains ArcToolbox, which is used for data conversion and geoprocessing (Fig. 1.42). 

ArcMap is the main ArcGIS application used to create and edit maps. With 
ArcMap, it is possible to add legends to maps, prepare maps for printing and publi-
cation. In ArcMap, the geographic information is represented as a set of layers and 
other map elements.

ArcMap features a Catalog window (Figure 1.43), where you can organize 
all sets of GIS data, map documents, other ArcGIS files, geoprocessing tools, and 
many other GIS element.

Fig. 1.42. The interface of the working window of ArcMap project

Catalog is a structure for organizing the storage of various types of GIS data. 
You can create personal geodatabases on your PC, or use Catalog tools to create or 
import feature classes, tables. 
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

Fig. 1.43. Catalog window in ArcMap

ArcToolbox window contains many GIS tools for data geoprocessing. Simple 
tasks are performed using the tools represented in the form of dialog boxes. Each 
of the Toolbox sections contains certain tools that can be viewed by left-clicking 
the “+” icon next to the section name (Fig. 1.44).

Fig. 1.44. Example of shortcut menu in ArcToolbox

QGIS is a free and open-source geographic information sys-
tem application with a flexible system of functional modules, 
which is maintained and improved by a group of volunteer 

developers. This software allows users to visualize, edit, analyze data, prepare maps 
for printing, etc.

To download and install this application on your computer, go to https://qgis.org/
uk/site/ or just type QGIS in the Google search bar and then go to the first link in the 
search results. To download the installer to your computer, click the Download Now 
button. A window will appear with a list of possible downloads. You can download 
QGIS for Windows, Mac OS X, Linux, BSD, and Android. Different versions of 
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this software are available: Long term release – a stable version, and Latest release 
featuring the latest updates. We recommend installing Long term release version to 
avoid problems with the application functioning. In this Manual, we use QGIS 3.4 
Madeira version (Fig. 1.45).

Fig. 1.45. Versions of QGIS software

There are two more versions of this application designed for 64- and 32-bit operating 
systems. You can check what type of operating system you are currently running on your com-
puter in the Control Panel → All Control Panel Items → System section. Install the version that 
matches the operating system of your PC.

The Documentation section on the official QGIS website features user guides 
and training manuals for both beginners and experienced users. All these docu-
ments are available in different languages.

The QGIS user interface is divided into five components (Fig.1. 46):
1. The Menu Bar provides access to all QGIS features using a standard hierar-

chical menu.
2. The Toolbar provides access to most of the functions in the menus, plus 

additional tools for interacting with the map. You can display or switch off every 
toolbar using the right mouse button in the context menu. Every toolbar can be 
moved around according to your needs.

3. The Layers panel lists all the layers in the project. The checkmark next to 
each layer is used to show or hide it. The order of their presentation in the legend 
determines the order of their display on the map. Right-click on a layer activates the 
shortcut menu. It differs depending on the layer type (Fig. 1.47).
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

Fig. 1.46. User interface of QGIS project

а b

Fig. 1.47. Shortcut menu of layers in QGIS: vector (a), raster (b)

я
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4. Map View. The map displayed in this window will depend on the layers you 
have chosen to load in QGIS. When you add data to the Layers panel, the map 
display will also change.

5. Status Bar is located at the bottom of the working window and shows the 
current position of the mouse cursor in the units of the map (e.g. in meters or deci-
mal degrees). It also demonstrates the scale of the map view, which can be changed 
using the mouse (you can zoom in/out in the status bar, or use a scale selector, 
which allows you to choose between predefined and customs scales in the same 
line). There is also a checkbox in the status bar which can be used to temporarily 
prevent layers from being rendered to the map view. On the right side of the status 
bar, you will find the  icon (the current project coordinate referencing system 
(CRS)). Clicking on it opens the Project Properties dialog window with the Coor-
dinate system tab.

QGIS modules
Most of the functions in QGIS are implemented as Core Plugins or External Plugins:

• Core Plugins are maintained by the QGIS Development Team and automat-
ically included in every distribution of the program;

• External Plugins are stored in external repositories and maintained by the 
individual authors. If a plugin is popular with users, it can be added to the 
set of basic QGIS plugins.

Management of plugins includes activation, installation, updating, or removal 
of plugins using the QGIS plugin manager. To install or activate plugins in QGIS, 
go to the Menu Bar: Plugins – Manage and Install plugins. 

To install the plugin, go to the Not installed tab, find the appropriate plugin 
using the Search box, and click the Install plugin button. The installed plugin will 
appear in the Plugins menu. Some plugins will appear as separate toolbars, which 
can be disabled/activated at any time (Fig. 1.48).
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Fig. 1.48. Installing a new plugin

Task

Create a project in the GIS application, open B05 band of the downloaded 
Landsat 5 satellite image and B08 band of Sentinel 2 image. Calculate the in-
crease in the area of the Troieshchyna neighborhood in Kyiv over 35 years.

Data

The territory of Kyiv in Landsat 5 satellite image collected on April 7, 1984, 
and Sentinel 2 satellite image collected on September 10, 2019 (we have dis-
cussed the downloading of these images in paragraph 1.2; if you don’t have them, 
repeat the download according to the instructions).

Task Performance Algorithm

1. Unzip downloaded satellite data
In paragraph 1. 2, we have downloaded two satellite images, from Landsat 

and Sentinel. These downloaded files must be unzipped using any standard ar-
chiver, such as 7-zip (www.7-zip.org). 

After complete decompression, the Landsat 5 satellite image folder will contain 9 files as 
black-and-white images for different bands (the number of available bands will depend on the 
Landsat source (for example, if you have downloaded data from Landsat 8, there will be 11 
such images)) and text files with metadata. The unzipped folder of Sentinel 2 satellite image 
has a more complex structure and contains 14 files in the “IMG_DATA” folder for image bands. 
Each band is a black-and-white image, which represents the intensity of reflection of electro-
magnetic radiation by surface features in a given spectral range. 

The file names are almost the same, except for the sequence number at the end 
of the name after the letter B (B refers to “band”). For example, B01 is the first 



REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS48

SE
C

T
IO

N
 1.

 A
C

Q
U

IS
IT

IO
N

, P
R

O
C

E
SS

IN
G

, 
A

N
D

 V
IS

U
A

L
IZ

A
T

IO
N

 O
F 

SA
T

E
L

L
IT

E
 I

M
A

G
E

R
Y

band of the satellite image. Each satellite has its own band specification, which 
can differ significantly in different satellites. The bands of Sentinel 2 and Landsat 
5 satellites are shown in Fig.1.49.

Fig. 1.49. Bands of Sentinel 2 and Landsat 5 / 7 / 8

Different image bands may have different spatial resolutions (see paragraph 1.1 
for more details). For example, the spatial resolution of B02 band (green – i.e. the 
band corresponding to the green region of the spectrum) of the Landsat 5 satellite 
image is 30 m, while the spatial resolution of B06 band (thermal infrared) is 120 
m.  The B03 band of Sentinel satellite image has a spatial resolution of 10 m, and 
the B01 band – 60 m. See the detailed characteristics of the different images in the 
Table (Annex 2).

Each band of the image can be opened in GIS applications (QGIS or ArcGIS) 
separately as a black-and-white image. The downloaded images have a defined geo-
graphical projection, so there is no need to refer to geographic coordinates and the 
images may be superimposed on other map data. 

2. Open GIS application and create a project
Launch the application from the Start menu, or find the ArcMap 10.5 or QGIS 

3.4 icon on your computer desktop. 
Use of any GIS application starts with downloading various data (raster, vector, 

tabular), setting their display and order, and scaling. That is, with the creation of 
an operating environment or working project, where all selected settings are saved 
automatically.

Project is a special file, which records the current state of a working session, 
and therefore, this file can be further used to restore the operating environment [9]. 
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It should be noted, however, that each GIS application creates projects in its own 
format, and they can be opened only in the application they were created in. There-
fore, you cannot open an ArcGIS project in QGIS and vice versa.

Creating a project is a very simple procedure. You need to find the Save project button on 
the toolbar, click it, choose a project name (it is better to use the Latin alphabet), and select a 
folder to save the project by clicking the Save button.

Saving a project allows you to preserve all the data, the scale, the set, and place-
ment of panels and toolbars in the GIS application until next opening of the project.

The project stores links to data, not the data itself. If you want to transfer the project 
to another computer, you need to move all data folders. When you save a project, a path is 
recorded for each layer which indicates its location on the computer. When you transfer or 
rename files uploaded to a project, the path changes, and the next time you open the project, 
you will not be able to download these data automatically. 

Create a folder on your computer and name it “Kyiv_RS”. We recommend that 
you save all the files we will work with during tasks’ performance to this folder. 
Move the unzipped folder of the downloaded satellite image with all the files to this 
folder and save the created project.

3. Add the OpenStreetMap base map
We recommend that you add OpenStreetMap (OSM) as a base map, a source 

of our data. There are many types of base maps, such as that of the National Geo-
graphic, cadastral map of Ukraine, topographic maps, ocean mas, etc. You can 
change the type of a base map depending on the task. 

OpenStreetMap is a volunteer project aimed at collecting, storing, analyzing, and free 
sharing geodata. The project was launched in 2004 in the UK at the initiative of Steve Coast. 
It is similar to Wikipedia, but instead of articles, it features maps, geographic data and lay-
ers. All data offered by this resource are distributed under the Open Database License, i.e. 
they can be used for any purpose, including commercial, subject to giving credit to the data 
source. You may join the OpenStreetMap community and review the current tasks in the 
blog at https://blog.openstreetmap.org/ (you can communicate with like-minded people in 
Ukrainian). Official website: www.openstreetmap.org.

Loading maps from OpentStreetMap source may take much time and slow 
down all the processes in the application, so it’s better to disable OpentStreetMap 
map by unchecking the box when you are not using it. 
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Fig. 1.50. Adding a base map to the project: the map is displayed in the map window (a), the 
map is opened in the project but not displayed in the map window (b)

4. Zoom into Troieshchyna neighborhood
Using the toolbar navigation buttons, Zoom In, Zoom Out, and Pan, zoom into 

Troieshchyna residential area to make the map window of the GIS application look 
like shown in Fig. 1.51.

Fig.1.51. Map window of base OSM map of Troieshchyna residential area

5. Open the bands of downloaded satellite images in the application: B05 
band for Landsat 5 and B08 band for Sentinel 2

These two bands capture NIR (Near Infrared) radiation, i.e. light within 
the near-infrared region of the spectrum (this is discussed in more detail in 
paragraph 1.1), however, there is a significant difference between them because 
the spatial resolution of the B05 band of Landsat 5 is 30 m, and that of the B08 
band of Sentinel 2 is 10 m (Annex 2). Therefore, the level of detail will differ 
on these two images (Fig. 1.52).
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Fig. 1.52. B05 band of Landsat 5 in ArcMap Catalog (a) and B08 band of Sentinel 2 in 
QGIS Browser (b)

There are several ways to load the data into GIS application but the best is to 
use Catalog and Browser panels in ArcMap and QGIS, respectively, which allow 
you to activate any data folder for further work. You may add various data – raster, 
vector, tabular, etc. To add a file to the application layers, you need to place the 
cursor over it, hold down the left mouse button and drag it from Catalog/Browser 
to the map window. 

If you have added data not required for your project, you may delete it by 
right-clicking on the layer and selecting Remove from the drop-down list – the layer 
will disappear.

6. Adjust the order of layers’ visualization and rename them
The layers of your map project are stored in the Table of Contents (ArcMap) 

or Layers (QGIS) panels. You may change the drawing order of the layers and their 
visibility. You can disable and enable the layers you work with. This is especially 
convenient when the map has many layers. There is a mark    in the box next to 
each layer. When this box is checked, the layer is displayed on the map. 
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The drawing order of the layers is important because it sets up the order of their 
display on the map. When you change something in the Table of Contents or Lay-
ers, the view of the map displayed in the working window changes automatically.

Sometimes it is necessary to rename the layer, especially when we deal with 
long names of satellite image bands, as in our case. You may both make the layer 
name shorter or rename the layer completely. This may be done very easily in the 
mentioned above Table of Contents or Layers panels in ArcMap or QGIS, respec-
tively (Figure 1.53).

а b

Fig. 1.53. Drawing order of layers in the Table of Contents in ArcMap (a)  
and Layers in QGIS (b)

7. Visually compare two images and calculate the increase in the area of the 
Troieshchyna neighborhood over 35 years

By adding two overlapping images you can easily see the changes in the area 
occupied by the neighborhood. Unchecking the box next to the layer name  and 
using the navigation buttons  allows you to view the images in detail 
and see different features (Fig. 1.54).

Measure the area occupied by the neighborhood using the Measure button on 
the toolbar. To do this, enclose the area of the neighborhood in a polygon in each 
image. Please note, to ensure matching of the units of measurement, use either 
square kilometers or hectares to measure the area. 
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Fig. 1.54. Various features displayed in the Landsat 5 image collected on April 7,  
1984 (B05 band)

8. Save the project 
Since we have already created the project in step 2, to save it, click  Save 

icon on the toolbar and close the application.
We hope that the algorithm described above is clear to you. Below are the op-

tions for using this algorithm in two applications – ArcGIS and QGIS. Choose the 
application and let’s start our work!

Performing a Task in ArcGIS

1. Unzip downloaded Landsat 5 and Sentinel 2 satellite 
images

We will work with two images – Landsat 5 of April 7, 
1984, and Sentinel 2 of September 10, 2019. You need to de-
compress the files. Unzipped Landsat 5 image folder will look 
like shown in Fig. 1.55.

Sentinel 2 archive contains many supporting data, and the .jpg images are found 
in the “IMG_DATA” subfolder. Below is the path to this folder. Let’s open it:
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Fig. 1.55. Folder containing all spectral bands of downloaded Landsat 5 image

Fig. 1.56. The path to the folder with archived Sentinel 2 satellite images

2. Open ArcGIS 10. 5 and create a project
To run ArcMap, click Start → Programs → ArcGIS → ArcMap 10.5, or find the 

program icon  on the desktop and press it. ArcMap 10.5 interface will open and 
the home screen will appear, where you can create New Maps or open the Existing 
Maps (Fig. 1.57), however, if you run the application for the first time, this list will 
be empty. At the bottom of the screen, there is a box to access the created map. Se-
lect New Maps – Blank Map – Ok. ArcMap working window will open. 
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A new map may be created using several other ways (Fig. 1.58): 
• in the Menu bar, select File → New; select Blank Map in the new window 

→ Ok (a);
• click the New button (b) on the toolbar in ArcMap and select Blank Map in 

the new window → Ok.

Fig. 1.57. Getting started in ArcMap

а b

Fig. 1.58. Creating a new map document in ArcMap using the Main menu (a)  
or the Standard toolbar (b)
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The interface of ArcMap application is discussed below. We will review the 
main toolbars, the buttons contained therein, their functions, and respective icons. 

The Standard toolbar is the place to find all the buttons, which provide access 
to the main functions of the application (Fig. 1.59).

Fig. 1.59. ArcMap Standard toolbar buttons and their functions

Using the Tools toolbar, you can access the attribute table, zoom in/out, mea-
sure the distance, select features, search, etc. (Fig. 1.60).

Fig. 1.60. The Tools toolbar

In addition to the toolbars discussed above, there are many more, which can be 
added to the project where needed.

To perform the task, the Standard and Tools toolbars should be checked in the 
boxes of the main menu, Customize → Toolbars. To do this, find these toolbars in 
the list and check them – any toolbar may be added to the ArcMap working window 
that way.

All toolbars in ArcMap are dynamic, i.e. you can change their location in the application’s 
working window. You can move the toolbars using the cursor. Place the cursor over a far-left 
border of the toolbar. The cursor turns from an arrow into a crosshair. You may drag and place 
the toolbar whenever you feel comfortable.

Create a new project using the File → Save As buttons. Go to the “Kyiv_RS” 
folder in the dialog box that will appear. We have recommended that you save all 
project files to this folder (Fig. 1.61). In the File name box, type “Kyiv_84_19”. 
Left-click the Save button. 



SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY 57

SE
C

T
IO

N
 1.

 A
C

Q
U

IS
IT

IO
N

, P
R

O
C

E
SS

IN
G

, 
A

N
D

 V
IS

U
A

L
IZ

A
T

IO
N

 O
F 

SA
T

E
L

L
IT

E
 I

M
A

G
E

R
Y

Fig. 1.61. Creating a new project in ArcMap 10.5

In ArcMap, the project is saved as two files with *.MXD (project) and *.MXT (template) 
extensions. If you want to move the project to another folder, you must transfer both files.

3. Add the OpenStreetMap base map 
To find the boundaries of Kyiv city and determine the location of the Troiesh-

chyna residential area, add an OpenStreetMap base map to the project. Open Add 
Data tool by clicking the arrow next to the tool icon and select Add Basemap. 
Select OpenStreetMap map in the window that opens (Fig. 1.62).

Fig. 1.62. Adding a base map to the project

As a result, the base map layer will appear in the Table of Contents.
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4. Zoom into Troieshchyna neighborhood
Using the navigation tools, find Troieshchyna residential area on Opent-

StreetMap (which is located on the left bank in Kyiv city, on its northern out-
skirts), and zoom in to get the neighborhood completely displayed on the map as 
shown in Fig. 1.63.

Fig 1.63. Zooming into the boundaries of Troieshchyna neighborhood in the map view

5. Open B05 band for Landsat 5 and B08 band for Sentinel 2
By selecting Add Data  from the menu, you can add data from different 

sources, as we did with OpenStreetMap. However, the Catalog window provides 
the best opportunities for searching and adding geospatial data from all available 
sources. It opens if you click the Catalog button on the right-side panel in ArcMap 
10.5 application. If this button is missing in your software version, you may add it 
through the main menu, Windows → Catalog.

Choose Connect to Folder in the dialog box of the Catalog window and specify 
the path to the desired geodata folder. In this task, specify the path to the folder named 
“Kyiv_RS”, which you have created to store all project data (see page 51), and click 
Ok (Fig. 1.64). 

The location of your folder depends on where you have saved it and is different for every-
one. Try to save a folder with project data in a place where you can find it quickly.

The selected folder appears in the Folder Connections list of the Catalog win-
dow and will always be displayed there until you delete it. Open this folder (left-
click the node to the left of the folder). As shown below (Fig. 1.65), this folder 
contains two folders with uploaded satellite images and a project file.
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Fig. 1.64. Connecting the “Kyiv_RS” folder to the Catalog

Fig. 1.65. Satellite image data in the project folder
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For instance, if we open the folder of Landsat 5 image, we will see thumbnails 
next to file names, which represent visually the type of the spatial features con-
tained in the file. In our case, the thumbnails show that the folder contains bitmap 
files and several text files.

Find the B05 band in the Landsat folder (LT05_L1TP_18…), and the B08 band 
in the Sentinel folder (S2A_MSIL1C_2019…) and relocate them to the applica-
tion’s map frame. To do this, simply hold them down with the left mouse button and 
drag them from the Catalog to ArcMap 10.5 map frame (Fig. 1.66). 

а b

Fig. 1.66. Location of bands to be downloaded in ArcMap: B05 band of Landsat 5 (a),  
and B08 band of Sentinel 2 (b)

If you add a raster image, a dialog box appears with the question, “Do you want 
to create a pyramid file for the raster dataset?” Click Ok.

Building pyramid layers of original raster datasets allows for quick display of data at vary-
ing resolutions. They are simplified versions of the output raster dataset.

6. Adjust the order of layers’ visualization and rename them
Select the name of the B5 Landsat 5 layer, and drag it to the bottom of the Table 

of Contents panel while holding down the left mouse button, and place it below the 
B8 Sentinel 2 layer name (Fig. 1.67).
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Fig. 1.67. The dialog box for creating a pyramid file for a raster image

Fig. 1.68. Changing the order of layers display in ArcMap
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As we see, the very first top layer in the Table of Contents draws on top of the 
layers below it. The order of layers visualization within the Table of Contents spec-
ifies their drawing order in the data frame. The check box  next to each layer 
indicates that its display is currently turned on. You can turn off the layer display by 
unchecking the box, and then turn it on again as needed (Fig. 1.68).

Sometimes it is necessary to rename the layer, especially if it is a long name of a 
satellite image band, as in our case. You can do this by double right-clicking the lay-
er name, “LT05_L1T P_182025_19840407_20171213_01_T2_B5”. The Properties 
window will appear. Click the file name in the first General tab in the Layer Name 
line – it will become editable. Rename the layer to “Landsat_B5_1984” (according 
to the following principle: satellite name_band name_year the image was collected) 
and click Ok. Similarly, rename the B08 band of Sentinel image (Fig. 1.69).

Fig. 1.69. Renaming the layer

Using the same Properties window, Source tab (Fig. 1.70), you can find out 
more information about the file and check whether the spatial resolution specified 
in the Cell Size line matches that stated in Annex 2.
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7. Visually compare two images and calculate the increase in the area of the 
Troieshchyna neighborhood over 35 years

By unchecking the box next to the top image in the Table of Contents, compare 
how the residential area changed in 2019 vs 1984. Note that all sandy areas, light 
spots in the 1984 image, are occupied with residential buildings in the contempo-
rary image.

Fig. 1.70. Verifying the raster cell size

To measure the area of the neighborhood, find the Measure  button on the 
toolbar. By clicking, the mouse pointer will change to a crosshair. Make the first 
point at the border of the residential area. A new window will open. Select the 
Area button, then open the drop-down list next to the Σ button and select Area → 
Kilometers. Enclose the area occupied by the neighborhood in 2019 into a polygon. 
Repeat the same procedure for the area of the neighborhood in 1984. You can com-
plete drawing the polygon by double-clicking the last point. The area of the polygon 
will display in the Measure window, Area line (Fig. 1.71).
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Fig. 1.71. Measuring the area in ArcMap using the Measure tool

Determine the changes (in square kilometers) in the area occupied by the 
Troieshchyna neighborhood over the period from 1984 to 2019. Write down the 
area of each polygon in your notebooks and calculate the difference (subtract one 
from another). The resulting area may differ from what is shown in Fig. 1.72, which 
is due to the accuracy of the polygon drawing.

8. Save the project
Since the project has already been created in step 2, now we will just save 

the changes by clicking the Save  icon on the toolbar. The application can be 
closed now. To reopen the project you have worked with, left-click the Open  
icon and go to the place where you saved it, or open it via the Catalog (Fig. 1.73).
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

а b

Fig. 1.72. Comparing the area of Troieshchyna neighborhood in 1984 and 2019:  
approximate area in 1984 according to Landsat 5 image (a),  
approximate area in 2019 according to Sentinel 2a image (b)

Fig. 1.73. Saving the project in ArcMap

Performing a Task in QGIS

 1. Unzip downloaded satellite images
The archives of Sentinel 2 data of September 10, 2019, 
and of Landsat 5 data of April 7, 1984, must be decom-

pressed using any archiver, such as 7zip (www.7-zip.org). The Sentinel 2 archive 
contains many supporting data, and the images are stored as .jpg files in the “IMG_
DATA” subfolder. The path to this folder is shown in Fig. 1.74.
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Fig 1. 74. The path to Sentinel 2 satellite imagery in the archive

A sample unzipped folder of the Landsat 5 image is shown in Fig. 1.75.

Fig. 1.75. Folder with all spectral bands of the downloaded Landsat 5 image

2. Open QGIS 3.4 and create a project
Launch QGIS 3.4 by clicking the Start → Programs → QGIS Desktop 3.4.13 

with GRASS 7.8.0 button (it is better to use this version of QGIS). You may also find 
the icon  on the desktop and run the program. 
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

To install QGIS 3.4, go to official website at https://qgis.org/uk/site/forusers/download.
html and choose the version that suits your operating system. You can read more about down-
loading this software in the theoretical part of this section above. 

The QGIS 3.4 interface will open and the home screen will appear. It has the 
following options: creating a New Project or opening Recent Projects. If the pro-
gram runs for the first time, however, the list of recent projects is empty. Therefore, 
we will create a new project by clicking the icon (New Project) on the toolbar 
(Fig. 1.76).

Fig. 1.76. QGIS 3.4 home screen

Make sure that the Browser, Layers and Spatial Bookmarks panels are open. If 
you do not see them, go to the top menu, View → Panels, and check the boxes near 
Browser, Layers and Spatial Bookmarks (Fig. 1.77). 
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Fig. 1.77. Enabling the Browser, Layers, and Spatial Bookmarks panels
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

All toolbars in QGIS 3.4 are dynamic, i.e. you can relocate them within QGIS interface. To 
do this, place the cursor at the far-left border of the toolbar (the cursor will turn from an arrow 
into a crosshair), and move the panel wherever you feel comfortable.

Create a new project using the Project → Save As buttons. Go to “Kyiv_RS” 
folder in the dialog box. We have recommended saving all project files to this folder 
(Fig. 1.78). Type “Kyiv_84_19” in the File name line. Left-click the Save button.

Fig. 1.78. Creating a new project in QGIS 3.4

3. Add the OpenStreetMap base map
To find the boundaries of the Troieshchyna residential area, add an OpenStreet-

Map map to the project. To do this, open XYZ Tiles on the Browser panel, and 
double-click the OpenStreetMar layer to open it in the Layers list and in the map 
view window (Fig. 1.79). 

4. Zoom into Troieshchyna neighborhood
Using the navigation tools listed in Table 1.2, find the Troieshchyna residential 

area on OpentStreetMap (it is located on the left bank in Kyiv city, on its northern 
outskirts), and zoom in to get the neighborhood completely displayed on the map 
as shown in Fig. 1.80.
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Fig. 1.79. Adding the OpenStreetMap base map to the project

Fig. 1.80. Zooming into the boundaries of the Troieshchyna neighborhood in the map view window
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

Таble 1.2 

QGIS Navigation Tools 

Menu Button Functions 

 
Pan map

 
Pan map to selection

 
Zoom in

 
Zoom out

 
Zoom full

 
Zoom to selection

 
Zoom to layer

5. Open B05 band of Landsat 5 and B08 band of Sentinel 2
The Browser function provides the greatest opportunities for searching and 

adding geospatial data from all available sources. The Browser window opens if 
you click the Catalog button on the left-side panel of QGIS 3.4 (Figure 1.81). 

In the Browser dialog box, expand the path to the required geodata folder 
(namely, “Kyiv_RS”), which you have created before to store all project data, and 
click Ok (Fig. 1.82). 

The location of your folder depends on where you have saved it and is different for every-
one. Try to save a folder with project data in a place where you can find it quickly.
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Open this folder (left-click on the tri-
angle to the left of the folder). As you can 
see, the folder contains two more folders 
with downloaded satellite images and 
a project file. If you open, for example, 
the Landsat 5 image folder, you will see 
thumbnails next to the file names, which 
are visual representations of the type of 
spatial features contained in the file. In 
our case, the thumbnails show that the 
folder contains bitmap files and several 
text files.

Fig. 1.81. “Kyiv_RS” folder in the  
Browser panel

Find the B05 band in the Land-
sat folder (LT05_L1TP_18….) 
and the B08 band in the Sentinel 
folder (S2A_ MSIL1C_2019…), 
and relocate them to the map view 
window. To do this, just hold down 
the band with the left mouse but-
ton and drag it from the Browser 
to the QGIS map view window  
(Fig. 1.83). 

Fig. 1.82. Satellite image data in the  
project file
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

а b

Fig. 1.83. Location of bands to be downloaded to QGIS: B05 band of Landsat 5 (a),  
B08 band of Sentinel 2 (b)

If you have added an unnecessary layer, you can remove it (Fig. 1.84). Just 
right-click such layer, and select Remove Layer in the drop-down box.

Fig. 1.84. Removing a layer in QGIS



REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS74

SE
C

T
IO

N
 1.

 A
C

Q
U

IS
IT

IO
N

, P
R

O
C

E
SS

IN
G

, 
A

N
D

 V
IS

U
A

L
IZ

A
T

IO
N

 O
F 

SA
T

E
L

L
IT

E
 I

M
A

G
E

R
Y

6. Adjust the order of layers’ visualization and rename them
Select the name of the B5 Landsat 5 layer, and drag it to the bottom of the Lay-

ers panel while holding down the mouse button, and place it below the B8 Sentinel 
2 layer.

Fig. 1.85. Changing the order of layer visualization in QGIS

As we can see, the very first layer in the Layers panel draws on top of the layers 
below it. The check box  next to each layer indicates that its display is currently 
turned on. You can turn off the layer display by unchecking the box, and then turn 
it on again as needed (Fig. 1.85).

Sometimes it is necessary to rename the layer, especially when working with a 
long name of a satellite image band, as in our case (Fig. 1.86). You can do this by 
double right-clicking the layer name, “LT05_L1TP_182025_19840407_2017121
3_01_T2_B5”. The Layer Properties window will appear. Click the file name in 
the Source tab in the Layer Name line – it will become editable. Rename the layer 
to “Landsat_B5_1984” (according to the following principle: satellite name_band 
name_year the image was collected) and click Ok. Similarly, rename the B08 band 
of Sentinel image.

In the same Layer Properties window, particularly in the Information tab, you 
can find more information about the file and verify whether the spatial resolution 
(Fig. 1.87) specified in the Pixel Size line matches that stated in the Table (Annex 2).
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

Fig. 1.86. Changing layer name

Fig. 1.87. Verifying pixel size of the raster
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7. Visually compare two images and calculate the increase in the area of 
the Troieshchyna neighborhood over 35 years 

By unchecking the box next to the top image in the Layers module, determine 
how the area changed in 2019 vs 1984. Note that all sandy areas (light spots in the 
1984 image) are occupied with residential buildings in the recent image.

To measure the area of the neighborhood, find the Measure  button on the 
toolbar. By clicking the triangle next to it, a drop-down menu will appear. Select 
Measure Area in this menu.

а b

Fig. 1.88. Measuring area in QGIS using the Measure tool: opening Measure Area tool (a) 
and adjusting units of measurement (b)

The mouse pointer will turn into a crosshair, and a dialog box will appear where 
you need to select the units of measurement – square kilometers (Fig. 1.89). Put 
the first point at the border of the neighborhood. Enclose the area occupied by 
the neighborhood in 2019 into a polygon. Repeat this operation for the area of the 
neighborhood in 1984. You can complete drawing the polygon by right-clicking 
the last point. To start enclosing a new area into a polygon, click the New button in 
the Measure window. The area of your polygon will be displayed in the Total bar 
expressed in square kilometers.

Determine the changes (in square kilometers) in the area occupied by the 
Troieshchyna neighborhood over the period from 1984 to 2019 (Fig. 1.89). Write 
down the area of each polygon in your notebooks and calculate the difference (sub-
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

tract one from another). The resulting area may differ from what is shown in Fig. 
1.89, which is due to the accuracy of polygon drawing.

а b

Fig. 1.89. Comparing the area of Troieshchyna neighborhood in 1984 and 2019:  
 approximate area in 1984 according to Landsat 5 image (a),  

  approximate area in 2019 according to Sentinel 2a (b) image

8. Save the project

Since the project has already been created in step 2, now we will just save the 
changes by clicking the Save Project  icon on the toolbar (Fig. 1.90). Close the 
application now. To reopen the project you have worked with, left-click the Open  

 icon and go to the place where you saved it, or open it via the Browser panel.

Fig. 1.90. Saving the project in QGIS
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REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS

Section for the Youngest Audience

Google Earth is a free program, a “virtual globe” from 
Google that allows users to view 3D-models of Earth, Mars, 
and Moon with superimposed high-resolution aerial photog-
raphy and satellite images, and various data layers, including 
detailed celestial maps.
Currently, there are two simplified versions of Google Earth: 

a web version for exploring 3D locations in the browser, and a 
version for mobile devices, which enables browsing the globe 
with a swipe of your finger on your phone or tablet (Fig. 1.91).

However, the most convenient for the users who need advanced features is an ex-
tended desktop version of Google Earth Pro, which allows you to import and export 
GIS data, and go back in time with historical imagery. 

To download and install Google Earth on your computer (Fig. 1.92), go to the 
official website https://www.google.com.ua/earth/ and click the Earth Versions tab 
on the homepage to select the required version of the application, namely – Google 
Earth Pro on desktop (Download Earth Pro on desktop). 

 Fig. 1.91. Official Google Earth website; selecting an application version [10]
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Fig. 1.92. Google Earth for Chrome; available layers

Below is a detailed description of Google Earth Pro functions. When you 
launch the application, the Earth appears in the 3D viewer within the user in-
terface. It is possible to change the position of the view through the navigation 
controls (Fig. 1.93). In Fig. 1.94, we have zoomed into Mount Hoverla – the 
highest mountain in Ukraine (Fig. 1.94). The mouse navigation provides wide 
capabilities:

• with the left mouse button held down, you can pan the map relative to the 
point where the cursor is fixed;

• with the right mouse button held down, you can zoom in by moving the 
mouse down, and zoom out by moving it up;



80

SE
C

T
IO

N
 1.

 A
C

Q
U

IS
IT

IO
N

, P
R

O
C

E
SS

IN
G

, 
A

N
D

 V
IS

U
A

L
IZ

A
T

IO
N

 O
F 

SA
T

E
L

L
IT

E
 I

M
A

G
E

R
Y

REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS

• with the right button or mouse wheel held down, you can rotate the map by 
dragging the mouse to the left or to the right;

• with the mouse wheel held down, you can change the tilt by dragging the 
mouse up and down.

Fig. 1.93. The web version of Google Earth for Chrome; 1,000,000 years of Volcanoes layer

The panel on the left-hand side of the screen allows you to search for locations 
by their names (Search module), manually digitize the areas of your interest, and 
export them to GIS (Places module), or view available layers (Layers module). The 
most interesting reference information is contained in the application’s thematic 
layers. In particular, the Gallery layer has the information about the features avail-
able from the Internet, or other data such as: “360 cities”, Discovery channel, You-
tube, Everytrail, National Geographic Magazine, and many more. With the Photos 
layer, it is possible to explore our planet based on the photos taken by different users 
in remote parts of the world and upload your own photos of a specific location. 
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Fig. 1.94. Google Earth Pro user interface

The Menu and Toolbar at the top of the Google Earth screen give access to a 
variety of program settings and features (Fig. 1.95). Some tools allow you to create 
your own placemarks, routes, make virtual trips, record and save them for playback. 
Using other tools, you can create animations, visually illustrate changing seasons, 
the revolution of the Earth around the Sun, and the day and night cycle. There are 
also tools that allow you to measure the exact distance between geographical fea-
tures, view celestial bodies in a virtual planetarium, and save and share other screen 
images via email, and print, view specific features using Google Maps service. 

Fig. 1.95. Google Earth Pro Toolbar

The use of Google Earth Pro application for studying the development of one of 
the residential areas of Kyiv (Troieshchyna) is discussed below.
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REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS

Task

Calculate the increase in the area of the Troieshchyna neighborhood in Kyiv 
over 35 years.

1. Zoom into the Troieshchyna neighborhood
In Google Earth Pro, you can search for a specific location by entering geo-

graphical coordinates or simply using the map navigation. The easiest way, how-
ever, to find the Troieshchyna residential area is to type the name in the search bar 
(Fig. 1.96).

 Fig. 1.96. Searching for the Troieshchyna neighborhood by entering the name in the  
Search bar

2. Find the oldest and most recent images
To see how the residential area looked like in the past, use the historic imagery 

function of the application, namely select the tool Show Historical Imagery. Use 
the time slider to move between acquisition dates. This tool can also be called a 
Chronograph. It allows you to see how much the land has changed using the sat-
ellite images.



SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY 83

SE
C

T
IO

N
 1.

 A
C

Q
U

IS
IT

IO
N

, P
R

O
C

E
SS

IN
G

, 
A

N
D

 V
IS

U
A

L
IZ

A
T

IO
N

 O
F 

SA
T

E
L

L
IT

E
 I

M
A

G
E

R
Y

Fig. 1.97. Searching for images from 1984 using Show historical imagery tool

3. Visually compare two images and calculate the increase in the area of the 
Troieshchyna neighborhood over 35 years

Use a time slider to scroll through imagery collected at different dates and 
see how much the neighborhood has changed. In particular, Fig. 1.97 shows the 
Troieshchyna residential area in 1984, when it was covered with floodplain mead-
ows. White areas in the satellite image represent areas of hydraulic fill intended for 
construction. To measure the area of the neighborhood, click the Show ruler  
button on the toolbar. The mouse pointer will turn into a crosshair, and a dialog 
box will appear where you should select a shape – Polygon, and units of measure-
ment – Area, Square kilometers (Fig. 1.98). Add a starting point on the edge of 
the neighborhood and smoothly outline the neighborhood’s boundaries by holding 
down the left mouse button. Draw polygons for the areas of 2019 and 1984. To save 
your polygons, click Save.

Calculate the changes (in square kilometers) in the area of the Troieshchyna 
neighborhood over the period from 1984 to 2019. Write down the results obtained 
for two polygons and calculate the difference.

This application has many other interesting functions, which will be further 
discussed in Section 2.1. One more Google service, Google Timelapse, is described 
in Annex 3. 



84

SE
C

T
IO

N
 1.

 A
C

Q
U

IS
IT

IO
N

, P
R

O
C

E
SS

IN
G

, 
A

N
D

 V
IS

U
A

L
IZ

A
T

IO
N

 O
F 

SA
T

E
L

L
IT

E
 I

M
A

G
E

R
Y

REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS

а

b

Fig. 1.97. Measuring the area of the Troieshchyna neighborhood in 2019 (a) and 1984 (b)
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1. 4. Pre-Processing and Visualization of RS Data

As you already know from the previous Section, “raw” satellite images may 
provide little information when you first see them. However, using appropriate vi-
sualization and processing tools, we can retrieve enormous amount of information 
from satellite imagery.

Task 

In this task, we will create a color satellite image of Kyiv city and identify a 
fire seat in Darnytsia forest using the images collected by the satellite (Sentinel 2) 
on October 4, 2015.

Data

Two Sentinel 2 images of the territory of Kyiv dated October 4, 2015; tile num-
bers: 36UUB and 36UUA.

Task Performance Algorithm

1. Selecting and downloading images
If we look at the scheme of scenes (tiles) on the Sentinel 2 satellite imagery, 

which depends on the satellite’s orbit, we will notice that to create a comprehensive 
satellite image of Kyiv city it is necessary to combine two satellite images: tile 
numbers 36UUB and 36UUA or 35UQS and 35UQR (Fig. 1.99).

Fire in Pampa region, Argentina;  
Landsat 8 satellite image collected on  
07.01.2017
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Fig. 1.99. Sentinel 2 tiles (blue lines) within Kyiv city territory

Sentinel 2 images provided by the European Space Agency to a wide range of users are 
split into the so-called tiles – granules or cells covering the area of 100 x 100 km (Fig. 1.100). 
The tile grid for each orbit is created based on the NATO Military Grid Reference System 
(MGRS).

 

 Fig. 1.100. Scheme of tiles grid [11]

The image scene is a single frame made by a sensor. The size of a frame depends on the 
orbit and the swath width (Fig. 1.101). 
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Fig. 1.101. Satellite sensor swath (a) and comparison of image sizes (b)

 We will find and download two images of Kyiv city collected by Sentinel 2 
on 04.10.2015 (tile numbers 36UUB and 36UUA) using downloading instructions 
of Copernicus Open Access Hub catalog described in paragraph 1.2 (Fig. 1.102).

Fig. 1.102. Selecting images for the task using Copernicus Open Access Hub catalog

As a result, we will have two files, which must be unzipped using any standard 
archiver, such as 7zip (https://www.7-zip.org). 

2. Band combination and synthesis for identification of fires
Band synthesis refers to the merge of satellite image bands into one color image. 
Different terrestrial objects (e.g. forests and water) reflect different wavelengths 

of light (within different spectral ranges) (see Fig. 1.103.
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Fig. 1.103. Bands of Sentinel 2 with spectral curves of water and vegetation

For example, the forestland on the Sentinel 2 image collected in the band B04 
(red) will have low values and appear as a dark area (color gradation is usually dis-
played from black to white), while the road will be displayed in a lighter color. (Fig. 
1.104). At the same time, the forestland will appear as a light area in the band B08 
(infrared) image and the road – as a dark area, since vegetation high reflectance in 
this band. Using the combination of bands of different sections of the electromag-
netic spectrum allows identifying the phenomena or properties of terrestrial objects 
invisible to the naked eye.

As you can see, the forest cover appears differently in the two images. 

Find areas in the forest which differ in the two images collected in different bands – these 
areas may be indicative of different species, ages, and condition of trees.

To create a color image, you need to perform band synthesis using ArcGIS or 
QGIS tools. Any color image is composed of three bands: Red, Green, and Blue. 
Such images are also called RGB images – this principle is shown in Fig. 1.105. 
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Fig. 1.104. The appearance of forestland in red (a) and infrared (b) bands

Fig. 1.105. Synthesis of satellite bands: of the available black-and-white images  
(various bands), we can select any three and represent them in blue, green, and red colors; 

these colors produce the whole range of colors when combined
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Fig. 1.106. Place of fire in the satellite image collected by Sentinel 2: a combination of B04, 
B03, B02 bands (a), a combination of B12, B08, B02 bands (b)

To make natural-color image (such as seen by the human eye), it is necessary 
to select three satellite bands that register EMR in the red, green, and blue ranges, 
respectively, for bands synthesis (a portion of the spectrum visible to the human 
eye). According to Table in Annex 2, these bands for the Sentinel 2 satellite are, 
namely: B04, B03, B02.

Using the combination of bands in natural colors (Fig. 1.106, a) we can clear-
ly notice the clouds of smoke at the site of a forest fire. However, it is quite 
difficult to determine the area covered by the fire. You can detect the fire area 
using a thermal (infrared) band. For example, with the combination of bands, 
B12 (Mid-IR), B08 (Near IR), and B02 (Blue), the forest area damaged by fire 
becomes visible (Fig. 1.106, b).

To learn more about the combination of bands of Landsat 8 and Sentinel 2 sat-
ellite images, see Annexes 4 and 5.

3. Clipping images
Clipping an image refers to the extraction of a required area from a satellite im-

age for further study. This is important both for a better visual representation of the 
area of interest and for accelerating data processing by the computer. Large image 
files can use too much CPU; therefore, you should work with the area of study only, 
not the entire satellite image scene.

There are many ways to specify the area for clipping:
• using the contours of the rectangle defined by specific x and y minimum and 

maximum coordinates (i.e. the coordinates of the top left and bottom right 
corners of a rectangle that defines the area of interest; 
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• using the extent of the current work window (map extent);
• using the contours of another raster or vector layer.
Since Kyiv city is located at the junction of two Sentinel 2 images, and each of 

the images covers a much larger area than required to create an image of the city 
(Fig. 1.99), it is worth clipping the images to limit the display to the studied area 
only rather than displaying the whole scene (covered area). It is also important to 
clip the image to make its processing faster.

4. Mosaicking
A mosaic is a combination or stitching two or more images to create a single 

raster dataset. This tool allows getting an integral image of the area under study.

5. Image enhancement 
Sometimes the image may appear too dark or too light. To enhance the image, 

you may use image brightness and contrast adjustment tools, or histogram stretching 
in the layer properties window. Histogram stretch function analyzes the pixel values 
of the entire image and enhances its display, for example, in the range from the min-
imum to the maximum pixel values. Another common type of the histogram stretch 
is percent clip, which allows you to display the image within a specified percentage 
of values, such as 95% of the pixel values of the image, ignoring 5% of the highest 
and lowest pixel values, which may be erroneous, unimportant or caused by sensor 
failure (Fig. 1.107, 1.108). 

Fig. 1.107. Histogram of image pixel values
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Fig. 1.108. Example of histogram stretching: not adjusted image (a),  
image following Percent Clip histogram stretching (b)

Performing a Task in ArcGIS 

To begin with, run ArcMap application, create a new proj-
ect and open the OpentStreetMap layer following the instruc-
tions in paragraph 1.3. 

Using the navigation tools, find Kyiv city on the OpentStreetMap map and 
zoom into the map so that the whole city is fully displayed on the map as shown in 
Fig. 1.109.

In our example, we will perform image clipping. To use the same map area in 
different image processing procedures, such an area may be saved to bookmarks, 
and you will be able to return to it easily after moving across the map. To do this, 
click the Bookmarks tool in the top menu and select Create Bookmark. If neces-
sary, invent a name for the bookmark and click Ok (Fig. 1.110). 

By reopening the Bookmarks menu, you can select the desired bookmark for 
the saved map area, and the desired location will be automatically displayed in the 
map window. The OpenStreetMap layer can be disabled in the project to prevent the 
slow running of the application. 

Open ArcToolbox in the top menu. The ArcToolbox toolbar will appear to the 
right of the map view window. Select Data Management Tools tab, Raster tab, and 
Raster Processing. Double-click Composite Bands tool.

You will see a window for band synthesis. Specify the bands you want to merge 
in the Input Rasters line. To do this, click the folder icon in the Input Rasters line, 
find the folder that contains the image bands and select the required bands. 
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Fig. 1.109. Zooming into Kyiv boundaries in the map view window

Fig. 1.110. Creating a bookmark for a certain map area

First off, create an image in natural colors, i.e. familiar and visible to the human 
eye (Fig. 1.106, a), using B04, B03, B02 bands (see Annex 2). It is important to 
select the bands in the following sequence: red (B04), green (B03), and blue (B02). 
You can select three bands at once by holding down the Shift or Ctrl key on the key-
board. Then, click the Add button and the selected images will be displayed in the 
input window. Next, specify the Output Raster by opening the folder again using 
the icon and saving the image under a new name (for example, Kyiv_ 36UUA for 
the image with the tile number T36UUA). 

It is better to name files using Latin letters since Cyrillic is not always read correctly by 
the applications.
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Next, clip the output image along the borders of the map view window (if nec-
essary, first return to your previously saved map area in the bookmarks). To clip the 
output image, click the Environments button, and open the Processing Extent tab 
in the Environment Settings window, expand the drop-down menu, select Same as 
Display, and click Ok. Fig. 1.111). 

Fig. 1.111. Composite Bands tools
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Fig. 1.112. Composite Bands tools: selecting bands

Fig. 1.113. Environment settings

Then click Ok in the Composite Bands window. It may take some time to create 
the synthesized image. When the process is completed, a new color raster layer will 
open in the cartographic window of the project (Fig. 1.112, 1.113).

The boundaries of the city may be easily distinguished in the image by 
the building density. Kyiv is located on both banks of the Dnipro River (clear-
ly seen in the center of the image) and is partially surrounded by forests (dark 
green areas). Within the forestland in the north-eastern part of the image, you can 
see a strip of smoke caused by the fire (Fig. 1.114). Get closer to this place us-
ing the navigation tools. As you can see now, the fire broke out in the forest near 
the buildings and the road. Apart from determining the size of smoke clouds, it  
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Fig. 1.114. Combination of bands to display the image in natural color

is important to identify the area covered by the fire. This may be done with the func-
tion of composite bands, using the infrared (thermal) range (Fig. 1.106). 

Go back to the saved area of the map (Bookmarks menu) and open the Composite Bands 
tool. Select B02, B08, and B12 bands and perform settings of the Environments as described in 
this section above to clip the image, and click Ok. Note, the B12 band has a spatial resolution 
of 20 m, and the B02 and B08 bands – 10 m (Annex 2). The resulting image will have a spatial 
resolution of the first input layer, so you should select the bands in the following sequence: 
B02, B08, B12. Upon bands synthesis, change the bands display to B12, B08, B02. 

To rearrange the bands of the synthesized image, right-click the image layer in 
the Layers panel to open the context menu (Fig. 1.115), and select Properties. A 
layer properties window will open, in which you need to expand the Symbology tab. 
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а b

Fig. 1.115. Layers menu (a) and band combination window (b)

Expand the tab next to Red, Green, Blue, and change the combination of bands. 
Select from the drop-down menu Band_3 for Red, and Band_1 for Blue, and click Ok. 

As a result, a false-color image will open in the project with the following com-
bination of bands: B12, B08, B02. Zoom into the area of fire on the map. It is much 
easier to identify the area covered by the fire now. 

Create the same synthesized image with a combination of bands B12, B08, 
B02 for the second downloaded image archive (tile number 36UUB). This image 
should complement the image of the northern part of the city. Don’t forget to open 
first the map area saved in the Bookmarks, and then perform the above operations. 
As a result, two images will be created and opened in the project: Kyiv_36UUA 
and Kyiv_336UUB.

Mosaicking 
In the top menu, select Windows → Image Analysis to open an image analy-

sis panel. The Image Analysis panel allows performing multiple image processing 
tasks. Using this tool, you can interactively adjust the histogram stretch, brightness 
and contrast, turn off the black background around the image, clip part of the im-
age of any shape, calculate spectral indices, such as NDVI, and even calculate the 
height of trees by their shadows and many more. Some of these operations will 
be discussed in the following sections. Now, we will use this panel for images’ 
mosaicking. 
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When the Image Analysis panel is activated, both images appear in the list at 
the top of the window. Select them and click the Blend tool at the bottom of the 
window as shown in Fig. 1.116.

Fig. 1.116. Creating a mosaicked image using Image Analysis tools

The resulting mosaicked image will open in the project. Now open the Layer 
Properties tab and swap the Band_1 and Band_3. Do not close the Layer Properties 
window – we will use it to adjust the image contrast. 

Image enhancement
Adjust image brightness and contrast using the Layer Properties tools. Usually, 

the Percent Clip is set by default in the Symbology tab as an image enhancement 
method. In general, this method provides the best adjustment of the image display. 
Another effective way to enhance the image view is to use the Standard Deviations 
function. Open the drop-down menu next to the Stretch Type, select Standard De-
viations, and press Ok. 
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Fig. 1.117. Selecting image enhancement method

Which version of the image display (Fig. 1.117) do you like more: the first one, 
where the Percent Clip function was used, or the second one, where the Standard 
Deviations function was employed? Use the Percent Clip enhancement method 
again. 

You can quickly open the Layer Properties window by double-clicking on the desired layer 
in the table of contents using the left mouse button. 

You can also manually change the image contrast and brightness. Open the Lay-
er Properties window and select the Display tab. Increase or decrease the Contrast 
or Brightness values. You can enter negative numbers as well. For example, if the 
image is too light, you should decrease its brightness by entering a negative value 
such as “-5” in the Brightness field. You can also adjust the layer transparency in 
this window using the Transparency function. Click the Ok button if you have 
entered all desired values (Fig. 1.118). 
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Fig. 1.118. Adjusting image brightness and contrast

In the end, you should save the resulting synthesized image to your folder be-
cause the mosaicked image of the territory of Kyiv city, created using Image Anal-
ysis tools, is stored in temporary files of the ArcGIS system. To do this, left-click the 
“Mosaic” layer in the Layers panel and select Data → Export Data in the context 
menu. In the data export window, specify the folder for saving the image in the 
Location field, and the name of the output image in the Name field (Fig. 1.119). 

You can also use the export tool to clip an image within a map view window. In our task, 
we clipped the image during band synthesis by setting up the environment. In other cases, you 
can use the export tool to quickly clip the image. To do this, select Data Frame in the Extent 
module at the top of the window. 
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

Fig. 1.119. Exporting the image

We have performed image clipping in the previous step. Therefore, in this task, 
we need to select the Raster Dataset function in the Extent module. This means that 
the coverage area will be the same as that of the input image. Then click Ok to save 
the created image in the working folder; it can also be added to the project. 

Performing a Task in QGIS

First, open QGIS Desktop 3.4.13 application with GRASS 
7.8.0 (it is better to use this version of QGIS) and create a new project following the 
instructions described in paragraph 1.3. Make sure that the Browser, Layers, and 
Spatial Bookmarks panels are open in the project. If these panels are missing, add 
them and the OpenStreetMap base map as described in paragraph 1.3. 

Using the navigation tools, find Kyiv city on the map and zoom into it. The city 
should be fully displayed on the map as shown in the figure below. 

In this example, we will clip the image along the map area (Fig. 1.120). You can 
save the map area in the bookmarks and use this area in different image processing 
operations later (Fig. 1.121). To do this, select the Add bookmark tool in the Spatial 
Bookmarks panel, and a New bookmark option will appear in the bookmarks bar. 
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Fig. 1.120. Adding the OpenStreetMap base map to the project

Fig. 1.121. Saving a spatial bookmark

You can change the name of a bookmark, for example to Kyiv, by double-click-
ing it with the left mouse button. Now zoom into any Kyiv district using the navi-
gation tools, and double-click the bookmark. The map will automatically be posi-
tioned on the saved area.

To blend black-and-white bands of a satellite image (Fig. 1.122) into one color 
image (i.e. to perform band synthesis) in QGIS, select Raster in the top menu, ex-
pand the Miscellaneous tab, and select Merge.
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

Fig. 1.122. Selecting a tool for satellite bands merging

A window for band synthesis will open. In this window, specify the bands you 
want to merge in the Input Layers line. To do this, click on the  icon next to the 
Input Layers line. In the Multiple selection window, click Add files and find the 
folder where the image bands are saved and select the desired bands (Fig. 1.123). 

Fig. 1.123. Band merge tools: selecting bands

First, create an image in natural colors (Fig. 1.106, a) using B04, B03, B02 
bands (see Annex 2). You can select three bands at once by holding down the Shift 
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or Ctrl key. Click Open, and the selected images will be uploaded to the Multiple 
selection window. It is important to select the bands in the following sequence: R 
(red -B04), G (green - B03), and B (blue - B02). Therefore, drag the bands so that 
the order of their display is as follows: B4, B3, B2, and click Ok (Fig. 1. 124). 

Fig. 1.124. The sequence of bands combination

The number of selected bands (3) will be displayed in the Input layers line of 
the Merge window (Fig. 1.125). Now, check the box next to the Place each input 
file into a separate band, and click the  icon next to the Merged line. Select 
Save to file, find the path to the folder and give a name to your file (for example, 
Kyiv_ T36UUA for the image with T36UUA tile number), and click Run.

It is better to use the Latin alphabet to name the files since Cyrillic is not always read 
correctly by the applications.
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

 Fig. 1.125. Creating merged image

It may take some time to create a merged image. Upon completion of the pro-
cess, a new color raster layer should open in the project map window.

Now you need to clip the merged image (Fig. 1.126) along the map canvas to 
prevent the application from processing unnecessary areas of the image (if required, 
first return to the area of the map saved in the bookmarks). To do this, right-click 
the merged image in the project and select Export → Save As in the context menu.

Fig. 1.126. Image clipping along map area

In the Save Raster Layer window, click  icon next to the File Name line and 
specify the path to the folder for image storing, as well as its name. 
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In the Extent module, select Map Canvas Extent and click Ok. 

Fig. 1.127. Clipping according to map canvas extent

A new merged image will open in the map view window. It consists of true 
colors combination and was clipped according to map canvas extent (Fig. 1.127). 
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

Fig. 1.128. Combination of bands in natural colors

The boundaries of the city may be easily distinguished in the image by the 
building density. Kyiv is located on both banks of the Dnipro River (clearly seen 
in the center of the image) and is partially surrounded by forests (appear as dark 
green areas). Within the forestland in the north-eastern part of the image, you can 
see a strip of smoke caused by the fire (Fig. 1.128). Get closer to this place using 
the navigation tools. As you can see now, the fire broke out in the forest near the 
buildings and the road. Apart from determining the size of smoke clouds, it is im-
portant to identify the area covered by the fire. This may be done with the merge 
bands function, using the infrared (thermal) range (Fig. 1.106). 

Go back to the area of the map saved in the bookmarks (the Bookmarks menu) 
and open the Merge tool. Select B02, B08, and B12 bands and press Ok. 

Clip the image according to map canvas extent as described above. Note, the B12 band 
has a spatial resolution of 20 m, and the B02 and B08 bands – 10 m (Annex 2). The result-
ing image will have a spatial resolution of the first input layer, therefore, you should select 
the bands in the following sequence: B02, B08, B12. When the merge process is completed, 
change the order of bands display to B12, B08, B02. To swap the bands of the merged image, 
right-click the image layer in the table of contents. The context menu will open, from which 
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you should select Properties. A Layer Properties window will open (Fig. 1.129). Expand the 
Symbology tab here. 

Fig. 1.129. Adjusting layer symbology

On the map, zoom into the place of the fire. As you can see, it is much easier to 
distinguish the area covered by the fire now.

Create the same merged image with a combination of bands B12, B08, B02 for 
the second downloaded image archive (tile number 36UUB). This image should 
complement the image of the northern part of the city. Don’t forget to open first 
the map area saved in the Bookmarks, and then perform the above operations. As 
a result, two images will be created and opened in the project: Kyiv_36UUA and 
Kyiv_336UUB.
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

Mosaicking
Now we need to stitch two pictures of the northern and southern parts of Kyiv to 

get a whole image of the city. We will use again the Merge tool. Open this tool from 
the menu: Raster → Miscellaneous → Merge (as described in this section above) 
and specify as Input Layers two images, which were obtained, merged, and clipped 
along the map canvas window (Fig. 1.130). 

Fig. 1.130. Creating a mosaicked image using Image Analysis tools

The resulting mosaicked image will open in the project. Now open the Layer 
Properties tab and swap the Band_1 and Band_3. Do not close the Layer Properties 
window – we will use it to adjust the image contrast. 
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Image enhancement
Adjust image brightness and contrast using the Layer Properties tools. In the 

Symbology tab, select Stretch to Min/Max in the Contrast enhancement field. 
Open the drop-down menu in the Min/Max Value Settings field, check the box next 
to Mean +/- standard deviation as shown in the figure below, click Apply and Ok 
(Fig. 1.131).

Fig. 1.131. Choosing image enhancement method

To open the Layer Properties window quickly, double-click the desired layer in the table of 
contents with the left mouse button. 

You can also manually change the image contrast and brightness by increasing 
or decreasing the Contrast or Brightness values in the Symbology box. You can 
enter negative numbers as well. For example, if the image is too light, you should 
decrease its brightness by entering a value such as “-5” in the Brightness field. 
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SECTION 1. ACQUISITION, PROCESSING, AND VISUALIZATION OF SATELLITE IMAGERY

Have a look at the image on the map. What else objects are better interpreted in 
a false-color image than in an image in the visible spectrum? For example, if you 
look at the forestland to the north of the fireplace, you can identify yet another place 
of a recent fire, already extinguished. Damaged trees appear here in dark red-purple 
colors, which allows to determine the area of fire and calculate the losses (Fig. 
1.132). 

Fig. 1.132. Extinguished fire on Sentinel 2 satellite image

This extinguished fire, which consequences are shown in Fig. 1.132 above, occurred a 
month before the image was collected by the satellite. The rescue team shot a video at the 
scene of fire using a drone. To watch the video, go to Youtube at https://youtu.be/fzhE2m-
vbeb4. Try to compare the area displayed in the image and the video, and determine the 
place the rescue team launched the drone from. 
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REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS

For Those Interested in Programming
The images may also be processed in JavaScript using a web-based Google 

Earth Engine Code Editor. The Code Editor is a part of Google Earth Engine’s 
cloud-based platform for the analysis of satellite data, which allows processing 
large arrays of images without uploading them to the computer.

Task

The task is to perform band synthesis, image clipping, and mosaicking as 
described in pp. 88–92 (namely, to create a color satellite image of Kyiv city and 
identify a fire seat in Darnytsia forest from the images collected by the satellite 
(Sentinel 2) on October 4, 2015) using software code. 

It is not necessary to install specialized software to use the cloud-based plat-
form. All you need to run the Code Editor is an internet connection. To access Goo-
gle Earth Engine, you should have a Google account (sign in to Gmail) and sign up 
for Google Earth Engine at https://signup.earthengine.google.com.

Within a few hours or days after the registration, you will receive a confirma-
tion letter to the e-mail address provided during signup. Now you can access the 
code editor at https://code.earthengine.google.com. 

To get started, open the data directory at https://developers.google.com/
earth-engine/datasets, select the Sentinel tab, Sentinel 2, and Top-of-Atmosphere 
Reflectance (at-sensor reflectance values). A page will open with a description of 
Sentinel 2 images. Expanding the Bands tab, you will see a complete list of satellite 
bands and their spatial and spectral resolution values. This information is available 
for all satellites contained in the Google Earth Engine catalog.

At the bottom is a code for Sentinel data display, and we will start editing it 
now. Find the Open in Code Editor button at the bottom of the screen and click it. 
The Code Editor interface will open with the downloaded code in the editing panel. 
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Fig. 1.133. The user interface of the Google Earth Engine Code Editor

Press the Run button to execute the script. As a result, a color satellite image 
with a combination of true color bands will be displayed on the map canvas. You 
can move across the map, zoom in or out using the navigation tools and the mouse 
(Fig. 1.133). 

Let’s return now to line 23 of the code editor (for convenience, each line of the 
code is numbered), where we can select images available in the dataset by date. You 
can see the date of image collection – it is the period from 2018-01-01 to 2018-06-
30 (note, the date is displayed in “year-month-day” format). Change these dates to 
the day of the fire, namely October 4-5, 2015. Line 23 should read:

23 .filterDate(’2015-10-04’, ’2015-10-05’)

Below, in lines 29-33, is specified a combination of bands used for producing 
a color image. Namely, these are true color bands, B4, B3, and B2. Change this 
combination to the following: B12, B8, B2 – this will make it easier to determine 
the area of the fire. Line 32 should read:

 

32  bands: [’B12’, ’B8’, ’B2’]

Find Kyiv on the map and determine its coordinates (Fig. 1.134). To do this, 
you can use the Search places and datasets box. Open the Inspector tab and click 
on Kyiv location on the map. The Inspector tab shows information about the cursor 
location (coordinates). Copy this information. 
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REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS

Fig. 1.134. Searching for a place on the map and determining the coordinates

Find line 34 of the code, which positions the map according to the specified 
coordinates, and replace the first two numbers in parentheses (coordinates of the 
city in Portugal) with the copied coordinates of Kyiv. Line 34 should look like this 
(decimal values of coordinates may vary depending on which part of the city you 
put the cursor):

34 Map.setCenter(30.5272, 50.4547, 12)

Press the Run button and view the result. A color image of Kyiv as of October 
4, 2015, should display on the map canvas. 

As you can see, the image displayed in the map window covers a large area, 
much larger than that of the Kyiv city. Therefore, we need to limit the selection to 
the territory of Kyiv and clip the image (Fig. 1.135). 

To select the area for image clipping, use  tool (Draw a rectangle) from 
the left corner of the map canvas, and draw a rectangle so that Kyiv is completely 
inserted inside it (Fig. 1.136). 
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Fig. 1.135. Uploading image collected by Sentinel 2 to the map canvas in  
Code Editor Google Earth Engine

Fig. 1.136. Selecting the area of interest

If you look at the code again, you may notice a new line that automatically ap-
peared at the top, which indicates a new variable (polygon) and is called “geometry”. 
Now add the task for image clipping outside the polygon, namely clip(geometry) 
to the last code line (35) (this line choose and compute median value of previous 
collection, dataset.median). Line 35 should read:

35 Map.addLayer(dataset.median().clip(geometry), rgbVis, 
’RGB’)
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REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS

To find the required task, use the Docs tab from the top left menu. Now we need 
to export the image to disk. Our code can upload the image to the map canvas only. 
However, you may need to use the resulting image later in ArcGIS or QGIS applica-
tions, for example, to compare it with other data or prepare a map layout. Therefore, 
open the Docs tab and type “export” in the toolbar search box (Fig. 1.137). 

Fig. 1.137. Searching for the Export image to Drive task

In the search results, click Export.image.toDrive. This function allows you to 
save the image in GoogleDrive (data repository linked with your Google account), 
from which you can download the processed image to your computer. The informa-
tion about the task will be displayed. Copy the text written on a blue background 
in the window title – this is the exact name of the task (function) and additional 
parameters, which may be specified in the code (Fig. 1.138). 

Not all the parameters mentioned in the parentheses need to be specified in the 
code; we will leave the essential ones only. 

The first important parameter is the image. You need to specify a variable, i.e. 
an image you want to export. In our case, it is a dataset (Sentinel 2 images filtered 
by date, cloud coverage, and territory, lines 22–27). However, it would be incor-
rect to mention the dataset since the territory of Kyiv is covered by two images 
as discussed in paragraph 1.4. Therefore, it is necessary to make a stitched image 
from the available ones. Thus, instead of dataset, specify dataset.median (averaged 
image from a set of images). In addition, we want the color image to be created 
from the bands B12, B8, B2, so we specify not just a mosaic, but - dataset.median.
select([‘B12’, ‘B8’, ‘B2’]). Finally, clip the image by the shape drawn on the map. 
The resulting image parameter should read: dataset.median.select([‘B12’, ‘B8’, 
‘B2’]).clip(geometry).
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Fig. 1.138. Parameters of the Export image to Drive task

The next essential parameter is the description – the name of the output file, for 
example, ‘Kyiv_0410_2015_Sentinel2’.

Then, it is important to specify the scale; in our case, it is the spatial resolution 
of the output image in meters, i.e. 10 m for Sentinel 2 imagery.

Specify the region too: geometry (i.e. the area inside the polygon).
The last parameter to be specified is crs (coordinate system). It is convenient to 

use for Kyiv a projected coordinate system, WGS 84 / UTM zone 36N, or its code 
name, EPSG:32636.

Therefore, to export an image to a disk, you need to add the following text to 
the code, starting from line 37:

37
38
39
40
41
42
43

 Export.image.toDrive({
 image: dataset.mean().select([’B12’, ’B8’, ’B2’]).clip(geometry),
 description: ’Kyiv_0410_2015_Sentinel2’,
 scale: 30,
 region: geometry,
 crs: ’EPSG:32636’
 }).

The code is ready now. You can save it by clicking the Save button at the top of 
the code editor, and run it by pressing the Run button. 
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REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS

Note that you need to confirm again image saving to disk in the Tasks menu. To 
do this, after running the code, go to the Tasks tab and click the Run button next to 
the name of the output file (Fig. 1.139). 

Fig. 1.139. Exporting an image to Google Drive

Following image uploading, the line of the image name in the Tasks menu will 
highlight in blue. Point the mouse cursor over it and a question mark will appear. 
Click on it. In the window that opens, select Open in Drive (Fig. 1.140).

Fig. 1.140. Opening a file saved to Google Drive

The Google Drive and saved image will open. Right-click on the image and 
select Download and save the image to a folder on your computer (Fig. 1.141).
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Fig. 1.141. An image of Kyiv saved to Google Drive

As a result, you will get a color image of Kyiv, which can be used later in var-
ious applications (Fig. 1.142). 

Fig. 1.142. The resulting color image of Kyiv (combination of bands: B12, B8, B2)

To open the ready code, go to: https://code.earthengine.google.com/c5b1c1e11fd3cb476f-
b5a7fd765a06a8. 
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2. 1. Manual Interpretation 

Processing RS data involves the use of a large number of different methods, 
their only goal, however, is to generate a map based on satellite images. The result-
ing map should reflect the information about certain features and phenomena im-
portant for the researcher. This process is called image interpretation. Depending 
on the task and available data, automatic, semi-automatic, and manual interpreta-
tion of images may be used.

To recognize the features, you need to know the basic characteristics of their 
display on the images. It is best if the analysis of satellite images is supported by 
ground surveys that can be used to verify remote data. Any reference information 
may also come in useful, such as open data of OpenStreetMap and thematic geo-
portals, photos of the site, etc.

Interpretation of high- and medium-resolution satellite images is somewhat dif-
ferent because it directly depends on the size of the smallest features, which can be 
seen and detected from the images. In particular, high-resolution images are more 
suitable for the elementary level of GIS technology use since they can be easily 
“read” without training. Such images are freely available on Google Earth Pro, the 
main properties of which have been discussed in paragraph 1.3. The advantage of 
such data usage is the opportunity to detect the slightest changes in landscapes, 
accumulation of landfills, landslides, forest diseases, coastal development, etc. 

Deforestation on the territory of Narodytske 
Specialized Forestry Enterprise, SE, 
Zakusylivske Forestry District, Zhytomyr Oblast, 
WorldView-3 satellite image, April 23, 2015.
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SECTION 2. ІINTERPRETATION (DECODING) AND ANALYSIS OF SATELLITE IMAGES

However, there are some disadvantages of using Google Earth Pro – such detailed 
images do not cover the entire territory of Ukraine and are often insufficient to 
track the dynamics of the process over time. Besides, these images visualize the 
Earth’s surface in the visible range of the spectrum only, in a single combination of 
“true colors”. Therefore, more thorough research studies are carried out based on 
multi-band medium resolution images, and more complex GIS applications such as 
ArcGIS and QGIS.

Below we will discuss some examples of image interpreting at the elementary 
and advanced levels of GIS knowledge. We will use the medium resolution images 
to detect deforestation areas in the Kyiv Oblast using the ArcGIS and QGIS pro-
grams, and high-resolution images to digitize the sand wash in the Dnipro River 
floodplain near Kyiv in Google Earth Pro.

Thematic Mapping of Deforestation

Deforestation is cutting, felling, or chipping trees and shrubs to obtain wood, as well as 
to rehabilitate, restore forests and increase their productivity.

Before starting work, let’s get acquainted with an interesting resource that will 
allow you to review the global dynamics of deforestation and the consequences of 
forest fires.

The Global Forest Watch (GFW) is an online forest monitoring system that allows ev-
erybody interested to access real-time information about the state of forests around the 
world. This project was launched in 2014 by Google together with the World Resources Insti-
tute based on Landsat satellite images with a resolution of 30x30 cm per pixel. The interac-
tive map of this portal shows forest cover, its changes over time, land use, and forest protec-
tion activities around the world, but does not reveal the causes of forest loss. The Tree cover 
loss thematic layer shows the annual loss of forest cover, which is defined as the change in 
the level of vegetation over 5 m within the selected area (displayed in pink). The layer in blue 
color – Tree cover gain – reflects the growth of forest cover (reforestation).

According to the Global Forest Watch portal [1] data on deforestation over  
2011-2018, forests occupied 11.3 million hectares of the territory of Ukraine (more 
than 19% of the total country's area) in 2010, and by 2018, our state lost 74.2 hect-
ares of forests.

The four top regions of Ukraine with the largest “forest losses” are Zhytomyr, 
Rivne, Kyiv, and Volyn Oblasts.
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 Fig. 2.1. www.globalforestwatch.org/map interface.  
Displayed: Fastivskyi District of Kyiv Oblast

According to Global Forest Watch, most of the “forest losses” in Ukraine result 
from continuous fellings in the framework of forest management programs by state 
and municipal forestry enterprises. Almost all of these areas are reforested either by 
planting (“development of forest crops”) or by facilitating a natural regeneration if 
natural conditions allow (Fig. 2.1). 

For more details about the prospects of deforestation of Ukraine, use the online map of 
the “Forest in a Smartphone” pilot project launched by the State Forest Resources Agency. 
Go to the website https://lk.ukrforest.com/map/general to review the information on the 
issuance of permits for logging. You can also check the legality of felling on the map (Fig. 2.2).
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SECTION 2. ІINTERPRETATION (DECODING) AND ANALYSIS OF SATELLITE IMAGES

Fig. 2.2. Planned felling on the territory of Dorohynske Forestry District. Source:  
website https://lk.ukrforest.com/map/general

The Task to be performed in ArcGIS and QGIS

Digitize and display on the map the dynamics of deforestation over the period 
from 2015 to 2019 in the Dorohynske Forestry District of Fastivske Forestry Enter-
prise based on the Sentinel 2 satellite images. 

Data

Sentinel 2 satellite images collected on October 4, 2015, and September 10, 
2019, of the territory of Fastivske Forestry Enterprise (we have downloaded these 
images in paragraph 1.2. If you do not have them, repeat downloading according to 
the instructions).

Task Performance Algorithm

1. Creating thematic layers
You know that cartographic information in digital format is displayed as the-

matic layers. Each layer is a set of features that share a common attribute and data 
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type (points, polygons, or lines), e.g. a landfill layer, a logging layer, a lake layer, 
a park layer, etc. Such presentation of data on the map allows users to easily and 
flexibly display those thematic layers that are required at a certain point of time – 
to adjust symbols, captions, and visibility for each layer separately, etc. 

As you already know, according to the features’ geometry, there may be vector 
layers: point (Point), linear (Polyline), and polygonal (Polygon), as well as raster 
layers. A satellite image is a raster layer, and the features selected based on image 
interpretation are mostly vector layers. To obtain a visual representation of each 
layer, we should use individual map keys: symbols, colors, and text. One of the 
most common formats for saving vector layers in GIS applications is the Shapefile 
format. 

Note that every Shapefile consists of six separate files, although in fact, it is one the-
matic layer. Therefore, all six files must be transferred when copying. For more details, see 
paragraph 1.3.

2. Working with vector layers
Following the creation of a vector layer, we can proceed to digitization (draw-

ing, contouring, outlining) of the studied features. In our case, it is the manual de-
lineation of the felling area. To identify and digitize correctly the area of felling, it 
is necessary to recognize it in a satellite image. A satellite image is like an encrypted 
drawing, and you need to learn to read it like a book using certain attributes for 
interpretation. Note that the interpretation is based on such characteristics as color, 
shape, size, texture, shadows and terrain features, etc. Let's discuss the recognition 
of felling areas based on these signs. The foremost characteristic feature is the color 
– areas of felling always appear as contrasting light spots on a dark background of 
mature forest. The example of the view of felling area on a synthesized Sentinel 2 
satellite image in a combination of colors (SWIR, NIR, Red) is shown in Fig. 2.3. 
The felling area can be easily recognized by the pink color on the background of 
a green forest. By color, you can also identify the segments of felling that differ 
in habitat conditions or undergo different stages of reforestation (by age and pre-
vailing species). In particular, forest areas that have recently been cut down and 
replanted with young trees appear as light green spots, and we may determine how 
long ago the reforestation was carried out, by the color intensity.



127

SE
C

T
IO

N
 2.

 I
N

T
E

R
P

R
E

T
A

T
IO

N
 (D

E
C

O
D

IN
G

)  
A

N
D

 A
N

A
LY

SI
S 

O
F 

SA
T

E
L

L
IT

E
 I

M
A

G
E

S

SECTION 2. ІINTERPRETATION (DECODING) AND ANALYSIS OF SATELLITE IMAGES

Fig. 2.3 View of felling areas in Sentinel 2 satellite image

The next feature is the shape of felling area, which is rectangular and homoge-
neous. In general, most man-made artificial features (reservoirs, fields, roads, forest 
belts, buildings, etc.) have a rectilinear geometric shape, while natural objects, in 
contrast, have smooth, tortuous, and inhomogeneous shapes (rivers, swamps, flood-
plains, etc.) 

The scale of felling directly depends on the type of felling technique employed. 
There are four main types of felling methods according to the intended purpose: 
main use, maintenance felling, sanitary and complex. Let's discuss in more detail 
large-scale main use logging operations, which are carried out for timber procure-
ment, as well as their appearance on satellite images in Google Earth Pro. Depend-
ing on forest characteristics, this type of felling may be:

• Selective – recurrent felling of individual trees or groups of trees;
• Gradual – felling of forest stand in several steps;
• Clear cut – felling of entire forest stand in a cutting area at once.
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а b c

Fig. 2.4. Shapes of felling areas on Google Earth Pro satellite images. 
The following types of felling are presented: selective (a), gradual (b), clear cut (c)

The age of a mature forest may also be determined by the shadows. The taller 
the trees, the more shadows they produce on the felling border (Fig. 2.4).

3. Working with attribute data
Along with geometric (spatial) information about environmental objects, vector 

layers contain attribute information, i.e. accompanying tabular information, which 
is the basis for identifying their properties. This information allows to visualize, 
build queries and analyze thematic vector data. In general, Attribute Tables consist 
of columns (fields) that describe a particular attribute or characteristic of features 
of a certain type (for example, text, number, date, or sequence number) and lines 
that contain the values of these characteristics for each feature of a vector layer, 
respectively. It means that the number of lines in the Attribute Table corresponds 
to the number of thematic layer features. Note: when a Shapefile is created, it is 
automatically assigned a table with special fields that contain information about 
the geometry of thematic features. Such fields are the Shape and ObjectID or FID 
(Unique Identifier of a Feature). Users can create other fields of the Attribute Table 
independently, for example, a field with the name of each feature or its physico-
chemical properties, date of observation, or information about its status.

4. Designing map layout
A map design (layout) is a set of map elements arranged in a certain way to 

enable map printing. As a rule, these elements include a scale bar, a north arrow, a 
coordinate system, a map title, a text description, and a legend. You can also add a 
coordinate grid to display a geographic spatial reference (Fig. 2.5). 
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Fig. 2.5. Main elements of map layout

An appropriately designed (mounted) map can be exported to a raster file and 
used electronically to illustrate the research result in an essay or a presentation. 
However, the main purpose of layout settings is printing the map, in particular 
when designing a poster. The page layout can be landscape (extended in length) or 
portrait (extended in height) [3].

Performing a task in ArcGIS

1. Let’s discuss the creation of thematic layers in *.shp 
format

To begin with, run ArcMap application, open a new project, and 
upload two Sentinel 2 images collected in 2015 and 2019. Adjust 
the combination of bands 7, 4, 3 for these images in the project 



REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS130

SE
C

T
IO

N
 2.

 I
N

T
E

R
P

R
E

T
A

T
IO

N
 (D

E
C

O
D

IN
G

)  
A

N
D

 A
N

A
LY

SI
S 

O
F 

SA
T

E
L

L
IT

E
 I

M
A

G
E

S

(this procedure was described in more detail in Section 1.4). Using the navigation 
tools, find the forest area in Fastivskyi District (OSM map will help you find the 
right place; Section 1.3 describes how to add it to the project). 

Next, use the  ArcCatalog module. First, select the folder for storing the the-
matic layer of felling (Fig. 2.6). 

Fig. 2.6. Arc Catalog module

Upon selecting a folder, right-click it and select the New → Shapefile from 
drop-down menu. A dialogue box will appear (Fig. 2.7) for creating a new shape-
file – Create New Shapefile.

а b

Fig. 2.7. Creating a new shapefile using the drop-down menu in the Catalog window (a);  
Create New Shapefile dialogue box (b)

In this window, you must specify the following information:
• name of a thematic layer (Name) – write the word “felling” in English;
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The name of the thematic layer should be specified in Latin without additional characters 
due to the potential of errors with the use of some tools if the name is in Cyrillic (this also 
applies to the names of folders where you save your files). 

• type of geometry of thematic features – Feature type. In our case, the polyg-
onal type suits the best as we plan to calculate the felling areas;

• XY Coordinate System. To determine the required spatial reference, click 
the Edit button; select the appropriate coordinate system and projection in 
the Spatial Reference Property window. The easiest way to assign it from 
the image opened in the project is to click the Import button. Then, find the 
image in the Browse for Dataset window, select it, and click Add. A descrip-
tion of the assigned map projection will appear in the Spatial Reference 
module. Click Ok to finish creating the Shapefile. A new Shapefile will be 
automatically displayed in your project (Fig. 2.8).

Now we need to select a convenient mode of a Shapefile display.
To access the tools adjusting the display of Shapefiles, right-click on the felling 

layer and select Properties from the drop-down menu. Go to the Symbology tab in 
the Layer Properties window. You can choose the mode of displaying Shapefile 
features in the left part (Show) of this window. The Single Symbol option displays 
all the features contained in the selected Shapefile equally. This method is useful 
when the features in the same layer have no attributes to represent them by different 
symbology. Therefore, this method of display is suitable for a start because we have 
not drawn any polygon yet. Click on the square icon below Symbol and choose a 
convenient Shapefile display mode from the Symbol Selector window, selecting the 
colors for contours and fills, and contours width (Fig. 2.9). 
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а b

Fig. 2.8. Assigning spatial reference to vector layer from the satellite image (a)  
and description of the coordinate system (b)

Fig. 2.9. View of the Symbology tab in the Layer Properties window
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Another display option, Categories, allows you to display the layer features 
according to their properties, namely: Unique value – in this case, features will 
be displayed based on different values of a particular attribute, such as the «year» 
field (year of felling). We will describe this mode below when all felling areas are 
digitized and require display in different colors based on a unique sign – the year of 
felling (2015 or 2019).

Note! To quickly change the color, you can open the Symbol Selector window by hover-
ing over the square of the conditional color of the Shapefile in the Layers window and dou-
ble-clicking with the left mouse button (Fig. 2.10). 

Fig. 2.10. The window for selecting the symbol for the polygonal layer

2. Starting editing the vector layer
Editing vector data in ArcMap of ArsGIS is done through the Editor toolbar. To 

use this toolbar, you first need to know how to start and finish drawing a polygon 
(Fig. 2.11).

The first left button on this tollbar is Editor, which has a drop-down menu that provides 
access to advanced functions. The first in the menu is the Start Editing function. When ac-
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tivated, this function initiates editing the felling Shapefile, which we have created. To finish 
editing the felling vector, you will first need to click the Save Edits and then Stop Editing 
buttons. If you click Stop Editing first, a window will automatically appear asking you to save 
the edited data.

а b

Fig. 2.11. Editor toolbar (a) and dialogue box to confirm data saving after editing (b)

Therefore, when you click Start Editing, a new Create Features dialogue win-
dow opens (Fig. 2.12). This window displays a list of editable Shapefiles (at the top) 
and the types of features geometry, Construction Tools (at the bottom).

Fig. 2 12. The window for creating features in thematic layers

To digitize the felling, we shall use a Polygon tool, which is designed to create 
planar features of complex configuration and further calculate the area. Finally, we 
may start performing our task. First, it is necessary to digitize all the felling in the 
2015 satellite image.

Basics of digitization: for step-by-step manual digitization of felling, place a 
vertex by vertex, each time left-clicking, or digitize in the Streaming mode by hold-
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ing down the left mouse button and gently moving the cursor along the contours of 
the feature. In the streaming digitization mode, when you move the mouse cursor 
over the map, Arc Map adds vertices automatically at a specified interval. To start 
digitizing in a streaming mode, specify the first vertex from which the digitization 
will begin, and press the function key “F8”. 

Fig. 2.13. Digitization of the polygon in streaming mode

You will see a series of green dots and one red dot indicating the last point 
where you stopped, and thus showing the direction of digitization (Fig. 2.13). 

The polygon may be not continuous; for example, part of the trees inside the 
compartment felling area may remain uncut. In such a case, you need to cut out part 
of the polygon using the Cut Polygons Tool in the Editor toolbar. Note: pre-selec-
tion of the feature for cutting is required (Fig. 2. 4, Fig. 2.15).

Having digitized all the “fresh” felling areas captured in the 2015 satellite im-
age (the vector of felling is shown in yellow on Fig. 2.16), we obtained a map of 
felling for 2015.

Fig. 2.14. Editor window – a tool for cutting polygons
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Fig. 2.15. Using the Cut Polygons Tool 

 Fig. 2.16. Digitized felling on the 2015 satellite image

3. Working with attribute data
To assess the scale of felling over four years, you must first select all felling 

areas in the image as of 2015 and assign it a code “2015” in the attribute data, and 
then digitize the felling areas in the image as of 2019 and assign a code “2019” to 
new features. Therefore, the first stage – digitizing the felling areas of 2015 – has 



SECTION 2. ІINTERPRETATION (DECODING) AND ANALYSIS OF SATELLITE IMAGES 137

SE
C

T
IO

N
 2.

 І
IN

T
E

R
P

R
E

T
A

T
IO

N
 (D

E
C

O
D

IN
G

)  
A

N
D

 A
N

A
LY

SI
S 

O
F 

SA
T

E
L

L
IT

E
 I

M
A

G
E

S

been completed. Now we need to create a special column in the Attribute Table, 
assigning it appropriate code.

To access the Attribute Table, right-click the desired thematic layer or table 
(Fig. 2.17) and select the Open Attribute Table command in the shortcut menu.

Note! You can create new columns only when the Shapefile is not being edited, i.e. in the 
Stop Editing mode.

Fig. 2.17. Open Attribute Table drop-down window 

The Add Field ... command allows adding new fields to the existing table to fill 
in the attribute data of the appropriate type (Fig. 2.18). 
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Fig. 2.18. Add Field… drop-down menu

When this command is activated, a corresponding dialogue box appears, allow-
ing you to specify the name, type, and properties of the field being created. Among 
the field types in ArcGIS for the *.SHP format, it is possible to enter values in Short 
Integer and Long Integer, decimal values with a fixed Double and Float decimal 
point, Text, and Date information. The Field Properties module allows you to spec-
ify the number of characters (including spaces and other valid characters) a field 
can contain, the number of decimal values, and the default values.

When creating a new column with the code of the year of felling, write the 
title of the column, for example, “year”, and choose Type (data type) – Text with a 
default length of 50 characters in the Add Field window. Add another column (Fig. 
2.19), which we will need later to calculate the felling area. The name of the column 
“area” and Type (the type of data) – Float (digital values with a comma).
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Fig. 2.19. Parameters for creating new columns in the Add Field window

Calculating the area. To calculate the basic cartometric parameters, such as 
area, the Calculate geometry command is used. To activate this function, right-
click on the title of the “area” column. A dialogue box appears. Select the type of 
cartometric parameter (area, perimeter or length, coordinates of central points, etc.), 
coordinate system, and units of measurement. Each type of geometry of spatial 
features has its own set of cartometric parameters to choose from. In our case, we 
need to select the “area” as a parameter and “hectare” as a unit of measurement 
and click Ok (Fig. 2.20).

Fig. 2.20. View of the Attribute Table after creating two new columns



REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS140

SE
C

T
IO

N
 2.

 I
N

T
E

R
P

R
E

T
A

T
IO

N
 (D

E
C

O
D

IN
G

)  
A

N
D

 A
N

A
LY

SI
S 

O
F 

SA
T

E
L

L
IT

E
 I

M
A

G
E

S

We have chosen the Text data type for the “year” field, although we will enter 
numbers (2015 or 2019) here. This value is a code and we do not plan to use it for 
mathematical calculations, so it is advisable to use the Text data type instead of nu-
merical. The area field, on the contrary, will be used to sum the area of all polygons 
or perform other mathematical operations, so it is important to keep the values as 
accurate as possible, therefore we have chosen the Float data type for this field. 

Now select all digitized features and assign them a code “2015”. For this pur-
pose, click Table options in the Attribute Table and use the Select All command to 
select all the features within the felling vector. The next step is to assign the code 
“2015” to the selected features. To do this, use the Attributes table in the Editor 
toolbar. In this table (Fig. 2.21), click the “year” field and assign code “2015” to 
the selected features.

Fig. 2.21. Table options drop-down menu (a)  
and a short Attributes table (assigning a new code ”2015” to the selected features) (b)

Then, digitize the new felling in the 2019 image and assign the code “2019” to 
new features (Fig. 2.22). To do this, first select the newly created features using the 
Select by Attributes ... tool.
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Fig. 2.22. Alternative ways to access the Select by Attributes… command using the  
Selection menu and the Table options tab in the Attribute Table window

The command allows selecting vector features based on attribute data. This 
command is also available in the corresponding Selection menu. In the working 
window of the Select by Attributes tool, specify “year” = “0”, i.e. selecting features 
without a code (Fig. 2.23).

Fig. 2.23. The window for selecting features by defined attributes, Select by Attributes…
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Upon assigning the codes, paint the created polygons of felling using different 
colors, such as yellow for 2015 and red for 2019. You can do this through the Cate-
gories menu, the Symbology tab in the Layer Properties window, as was described 
above at the end of the first paragraph of this Task (Fig. 2.24, Fig. 2.25).

Fig. 2.24. Selecting display styles for the felling vector by category and the code of felling 
year, respectively

Fig. 2.25. The Calculate geometry dialogue box
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The Statistics command will also be useful. It enables you to quickly retrieve 
information about the main statistics and the frequency of distribution of the select-
ed field values. Upon selecting it, a dialogue box appears containing information 
on the main statistical indicators in the right part, and the distribution of values in 
the left part (Fig. 2.26). Thus, you can calculate the total felling areas for 2015 and 
2019.

Fig. 2.26. The Dialogue box for displaying the main statistical indicators

4. Designing map layout
To switch to the layout view mode, click the Layout View icon at the bottom 

of the screen (Fig. 2.27). The layout size and orientation are selected using the File 
menu and the Page and Print Setup command.

Fig. 2.27. Switching between map display modes

Setting up the map layout items using the Insert menu commands. The ele-
ments that can be inserted in the layout of the map (Fig. 2.28) include:
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Fig. 2.28. Page and print setup

• Legend – this command enables to adjust the view of the symbols and their 
parameters. Upon selecting this command, the corresponding dialogue box 
appears, in which a list of thematic layers is sequentially set. These thematic 
layers will be displayed in the symbols and parameters of the Legend in-
scription;

• North Arrow… – this command enables to display a symbol on the map in 
the form of an arrow pointing to the north to determine the cardinal direc-
tions;

• Scale Bar… – displays the scale of the created map in the form of a dimen-
sional ruler;

• Scale text… – displays the scale of the created map in the form of text 
inscription;

• Picture command enables adding the imagery to the layout in raster and 
vector formats that are supported by ArcGIS Desktop;

• Object command enables to add an item from other software.
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Fig. 2.29. Access to the Insert menu command with the North Arrow tool and its properties

Fig. 2.30. The completed map of felling in Dorohynske Forestry District for four years
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In addition to the mentioned elements, you can also add to a map layout a 
coordinate grid (geographical and rectangular), an index grid, a fragment of the 
Attribute Table, graphs and charts, reports created using the appropriate tools in the 
ArcGIS Desktop environment (Fig. 2.29).

Dorohynske Forestry District’s felling map is an example of the completed lay-
out (Fig. 2.30

Performing a Task in QGIS

1. Create thematic layers in *.shp format

 To get started, run QGIS Desktop. Open a new project and add two Sentinel 2 
images as of 2015 and 2019. Adjust the combination of bands 7, 4, 3 for these im-
ages in the project (it was described in detail in Section 1.4). Using the navigation 
tools, find the forest area in Fastivskyi District (OSM map will help to find the right 
place (Section 1.3 describes how to add it to the project). 

On the toolbar, select New shapefile layer. In the window that opens, next to 
the File name field, click on the tool  to find the desired folder for saving a new 
vector layer with selected felling areas. Enter its name, for example, “felling”, and 
click Save.

The name of the thematic layer should be specified in Latin without additional characters 
due to the potential of errors with the use of some tools if the name is in Cyrillic (this also 
applies to the names of folders where you save your files). 

Select Polygon from the drop-down list in the dialogue box for creating a 
shapefile in the Geometry type field. In our case, the polygonal type suits the best, 
as we plan to calculate the felling area after digitization thereof (Fig. 2.31). 

Below the geometry field, there is another drop-down list with the names of 
the projected coordinate systems. Open it and select the WGS 84 / UTM zone 36N 
projection. This drop-down menu displays the most often used projected coordinate 
systems (Fig. 2.32). If you haven't specified the projected coordinate system yet, it 
may not be available in the list. In this case, click on  icon and write “WGS 84 
/ UTM zone 36N”, in the top bar Filter in the window that opens. As a result, this 
projection will be displayed in the Coordinate Reference System window. Select 
it and press Ok. 
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Fig. 2.32. The window for selecting projected coordinate system

Create a new field with the attribute “year”, i.e. the field in which we will enter 
the year of felling for each vector feature (digitized polygon of felling). To do this, 
specify Name – “year”, Type – Text data (Text Code) and click on Add to Fields 
List in the New field window. A new field, “year”, will be added to the Fields List 
window. 

You can also create new fields with attributes for existing vector layers, i.e. not only when 
creating a new vector layer. We will discuss this method in the section below.

 

Finally, click Ok and a new layer, “felling”, will automatically open in the 
project layers. 
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Now we need to find a convenient style for displaying the Shapefile.
To access the shapefiles settings toolbar, right-click on the felling layer and 

select Properties from the drop-down menu. Then go to the Symbology tab in the 
Layer Properties window. 

Fig. 2.33. View of the Symbology tab in the Layer Properties window

At the top of this window, you can select the option for displaying the shapefile 
features. The Single Symbol option displays all the features in the selected layer in 
the same way. This method is useful when the features in one layer have no classi-
fication attributes. We can use this method at the start of the project since we have 
not drawn yet any polygon (Fig. 2.33). 

Another common way to display a layer is the Categorized one, which enables 
to display layer features based on their properties. In this case, the features will be 
displayed according to different values of a certain attribute, such as the “year” field 
(year of felling). We will describe the usage of this method below when we digitize 
all fellings. You will have to display them in different colors based on a unique 
feature – the year of felling (2015 or 2019).

At this stage, we will leave the Single Symbol display type. You can select be-
low in the Fill field the style of polygon fill. In our case, select the Simple fill type – 
the fields for setting up the polygon stroke and fill style will open. Polygons which 
are displayed only by a stroke without fill are more convenient for digitization, 
therefore, select No Brush in the Fill style field, and for example color red from the 
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drop-down menu in the Stroke color field, and enter number 1 (i.e. the width of a 
contour will be equal to 1 mm) in the Stroke width field, and press Ok. 

2. Start editing the vector layer
Editing vector layers in QGIS is done using the standard tools, as well as the 

advanced toolbar. By default, this panel is not displayed in the top toolbar, so you 
need to open it first (Fig. 2.34). To do this, click on the View → Toolbars menu and 
check the box next to Advanced Digitizing Toolbar. 

As a result, the digitization tools appear in the upper toolbar (Fig. 2.35).
Tool icons are displayed in gray because they are not active. This panel includes 

many useful tools, but first and foremost, you need to know how to start and com-
plete the polygon drawing.

To begin with, activate the vector layer editing mode: select the layer you want 
to edit in the Layers menu (in our case, the “felling”) by left clicking on it, and then 
click on the  Toggle Editing tool. You can see that after enabling the editing 
mode, some tool icons gained on color, i.e. became active. One of them is a tool 
for digitizing polygons . Select it and start outlining the fellings in the image 
(Fig. 2.36). 
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 Fig. 2.34. Adding advanced toolbar for digitization
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Fig. 2.35. Advanced toolbar for digitization

Fig. 2.36. Activating the editing mode

For stepwise manual digitization, place a vertex by vertex, each time left click-
ing. When you complete drawing the polygon, right-click to finish the job. A win-
dow for entering attribute data will appear. The “id” (feature ID) field can be left 
unchanged, it will be filled in automatically, and enter 2015 in the “year” field, click 
Ok or press the Enter key (Fig. 2.37). 

You can also leave the “year” field blank while continuing digitizing other 
polygons. We will enter this value for all polygons at once later, when working with 
the Attribute Table, as all polygons will be created according to the 2015 image. 
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Fig. 2.37. Manual digitization and attribute data input when creating vector features

To complete digitizing the entire vector feature layer, click the Save tool again, 
and then click Toggle Editing. If no edit changes have been saved before selecting 
this feature, a window will appear asking whether to save the edited data. Click 
Save if you want to save all changes (Fig. 2.38). 

Fig. 2.38. A dialogue box for confirmation of saving data after editing

Now everything is ready to start the task performance. First, you need to dig-
itize all the felling in the 2015 satellite image (check the map window; it should 
display the image as of 2015. For more information on changing the order of layers’ 
display in the Layers panel, see Section 1.3). 

The polygon may be interrupted, for example, part of the trees inside the com-
partment felling area may remain uncut. In such a case, you need to use the  
Add Ring tool, which is located on the Advanced Digitizing Toolbar, by selecting 
it and delineating the hole inside the existing polygon (Fig. 2.39). 

Fig. 2.39. Add Ring tool on the Advanced Digitizing Toolbar

Thus, having digitized all the “fresh” fellings in the 2015 satellite image, we 
obtained a map of fellings for 2015 (Fig. 2.40).
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Fig. 2.40. Digitized felling in the 2015 satellite image

5. Working with attribute data
To assess the scale of felling over four years, first, select the whole area of fell-

ing in the 2015 image and assign it "2015" code in the attribute data, then, digitize 
the felling in the 2019 image and assign “2019” code to new facilities. Therefore, 
the first stage is completed: we have digitized the felling data for 2015, and now we 
have to assign appropriate code to them.

To open the Attribute Table (Fig. 2.41), right-click on the desired thematic layer 
or table in the Layers panel and select the Open Attribute Table command.
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Fig. 2.41. Open Attribute Table drop-down window

In the Attribute Table that opens, enable the editing mode by clicking on the 
Toggle Editing tool , select the “year” field from the drop-down list, enter 
“2015” in the line for values, and click Update All.

Note! You can enter data into a table or create new columns only after enabling layer 
editing mode.

Since the objective of our Task is to calculate the areas of felling, we need to 
create another field in the Attribute Table – the “area” field, in which we will cal-
culate the area of each polygon (Fig. 2.42). 
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Fig. 2.42. Assigning a code in the Attribute Table

To add a new field in the Attribute Table, click on the New field tool , and in 
the window that opens, specify the name of the new field in the Name box, select 
the Decimal number from the Type box, and click Ok (Fig. 2.43). 

Fig. 2.43. New field drop-down window

Among the types of fields (Fig. 2.44) in QGIS for the format *.SHP, it is possi-
ble to enter values in integers (Whole number/integer and integer 64 bit), decimal 
numbers (Decimal number), text value (text/string), as well as in the form of date 
(Date) and date and time (Date & time). The properties of the value field enable us 
to determine the number of characters (including spaces (length)). 
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When creating the vector layer (see paragraph 1), we have selected a text data 
type for the “year” field. Although we have entered the numerical value (2015) 
in this field, this value is a code, and we are not going to use it for mathematical 
calculations, so it is advisable to use the text data type rather than numerical. The 
“area” field, on the contrary, will be used to sum the area of all polygons or per-
form other mathematical operations, so it is important to keep the values as accurate 
as possible, therefore we have chosen the Decimal number data type for this field. 

Now we need to digitize the felling in the 2019 image. When digitizing new 
features, do not enter a year for each polygon separately – we will select all new 
features and assign them a common code, “2019”. For this purpose, when you 
complete digitizing all polygons, reopen the Attribute Table and you will see that 
the new polygons for which we did not enter a year, have the “Null” value in the 
column “year”. This means that the data is missing. We will select these features 
and assign them the code “2019” using the tool Select features using expression. 
The command allows you to select vector features based on a certain attribute 
(Fig. 2.45).

In the middle of feature selection window, select the Fields and Values tab to 
open a list of all layer attributes. Double-click on “year” to display the field name 
in the box with the expression to the left. Then click on the All Unique button in the 
right part of the window – a list of all unique values in the “year” field, in our case 
it is “2015” and “NULL”, will appear below. Double-click on “NULL”, and the 
expression “year” NULL will appear in the window on the left. At the bottom of 
the window for the expression, you can see the inscription in red letters, Expression 
is invalid. Now type the word “is” on the keyboard so that the expression looks 
like “year” is NULL. Now you can see that the red inscription at the bottom has 
disappeared, which means that the expression is correct. Therefore, the system un-
derstands this expression as our intention to select all the features from the Attribute 
Table with NULL value in the “year” field. Since the “year” field is a text one, we 
use the operator “is” for the sample. In this case, you need to use the operator “=” 
for the numeric field. This is how the commands are created in the SQL program-
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ming language. To select the desired features, click Select features at the bottom of 
the window (Fig. 2.46). As a result, information that 39 features were chosen out of 
the total number of features (68) will appear at the top of the Attribute Table. 

Fig. 2.45. Selecting features by expression

Fig. 2.46. Information about the number of selected features from the Attribute Table

Then check whether the layer editing mode is enabled, and select the field 
“year” for editing (Fig. 2.47), enter the value “2019” and click Update Selected. 
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Fig. 2.47. Assigning a common field value to selected features

Upon completing the code assignment, paint the features in different colors. 
For instance, we will use yellow stroke line for 2015 and red for 2019. Open Layer 
Properties as described above at the end of the first paragraph of this Task, then – the 
Symbology tab and select the display type Categorized. Below you need to specify 
which categories of the field you want to display (Fig. 2.48). That is, in the Column 
line, select the “year” field from the drop-down list and click Classify. Then adjust 
the desired color and shape for each year by double-clicking on the polygon symbol 
next to the year, and click Ok. 

Fig. 2.48. View of the Symbology tab in the Layer Properties window  
with activated Categorized type of display  
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Fig. 2.49. View of digitized felling in the 2019 satellite image

Area calculation. Let's compare the felling areas in 2015 and 2019 (Fig. 2.49). 
To do this, open the Attribute Table again and calculate the area of each polygon 
(feature). Above, we have created the field “area” to calculate the area of each poly-
gon. So, make sure that the editing mode is enabled, select the “area” field in the 
operations box, and click on the Expression tool. In the new dialogue box, open the 
Geometry tab, double-click the operator “$area” to display it on the left side of the 
window, and click Ok. Then click Update all in the Attribute Table, and the area of 
polygons will be automatically calculated in the field “area” (Fig. 2.50). 
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Fig. 2.50. Calculating the area of polygons

Note that the area of polygons was calculated in m2 (Fig. 2.51). If we want to 
get it calculated in km2, divide the expression “$area” by “10,000”. 

Fig. 2.51. Calculating the area in km2

Show Statistical Summary tool  on the toolbar is also useful (if the tool is 
not displayed on the toolbar, you need to enable it via the View menu → Statistical 
Summary, and this toolbar will appear in the left part of the window). Select the 
layer (felling) and the field (area) for which you want to calculate statistics.  The sta-
tistical indicators will be automatically displayed in the statistics window (Fig. 2.52). 
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Fig. 2.52. Using the Show Statistical Summary tool

Alternatively, you may first select the features by a certain parameter (for exam-
ple, 2019) and check the box next to the Selected features only box at the bottom 
of the statistics window. The statistics will be displayed for selected features only. 
Therefore, we can see that the area of felling was 67.3 km2 in 2019 and 178.5 km2 
in 2015 (values may be different depending on what part of the images you have 
digitized – smaller or larger). 

6. Designing the map layout
To switch to layout and map layout mode, open the Project menu and select → 

New Print Layout. A window may appear asking you to name the layout, in which 
case add an arbitrary name or leave the box blank and click Ok (Fig. 2.53).

In the window for creating a map layout, open the Add item menu and select 
Add map from the list. You will see that your mouse cursor has changed; outline 
the area on the white sheet of the map layout where you want to place it (Fig. 2.54). 
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Fig. 2.53. Creating a new print layout

Fig. 2.54. Designing the map layout
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Using the Add item menu, add a legend to the map – the Add legend tool, the 
north arrow – Add Arrow or Add Shape, the scale bar – Add Scale Bar.

Then you can save the layout (Fig. 2.55) as Image or PDF using the appropriate 
commands from the Project menu.

Fig. 2.55. Saving the map layout

Here is an example of a completed layout – the map of felling in Dorohynske 
Forestry District (Fig. 2.56).
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Fig. 2.56. The completed map of felling in Dorohynske Forestry District for four years

Section for the Youngest Audience

Interpreting sand washing in the  
Dnipro River floodplain

Kyiv is the capital of our state. It is a city with an official population of about three mil-
lion and, according to unofficial statistics, more than five million. The number of metropolitan 
residents increases every year, and, respectively, the city is growing rapidly. However, as the 
areas for construction in the central part of the city are almost exhausted, the urban plan-
ning vector is gradually shifting to the suburbs. In particular, the new mass elite buildings are 
erected on the floodplains of the Dnipro River. 

Now, we will discuss the development of the southern edge of Kyiv, on the right 
bank of the Dnipro River, near Kozyn urban-type settlement and Pliuty village. 
Originally, there was a series of shallow, well-heated, overgrown with aquatic vege-
tation ponds, which were valuable spawning and feeding grounds in this area along 
the banks of the Dnipro River. Currently, the intensified construction in aquatic 
buffer, which is the territory with a limited regime of land use, causes irreparable 
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harm to the natural environment. Sand for building new residential areas is extract-
ed from the Dnipro riverbed using hydraulic installations, which leads to a radical 
transformation of the river floodplain (Fig. 2.57).

Fig. 2.57. Sand washing near Kozyn urban-type settlement [4]

We will use Google Earth Pro to perform this Task. The program's mapping 
tools allow us to draw our own routes, polygons, features, overlay various images, 
links, etc. We can also add color, size, style, inscription to our choice for each added 
element. This allows us to easily create maps of different areas of study. Also, the 
advantage of this resource is a large number of satellite images with a high spatial 
resolution of up to 1 m, using which you can trace the smallest changes in any area, 
such as coastline construction and, accordingly, sand wash, which will be discussed 
in more detail below. 

Performing Task in Google Earth Pro

To digitize the areas of sand wash for construction in the floodplain of the Dni-
pro River from the contemporary and archival satellite images available in Google 
Earth Pro and display the dynamics of their changes in the form of a map.
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Data

Satellite images collected on May 23, 2005, and May 24, 2018, for the territory 
of the Dnipro River floodplain near the Kozyn urban-type settlement, Pliuty village.

Task Performance Algorithm

1. Search for the area of interest on the Virtual Globe of Google Earth Pro.
2. Create thematic layers.

The main format of geospatial data in the Google Earth Pro program is *.kml/
kmz – Keyhole markup format. By default, all thematic layers you create will be dis-
played in the Places section. If you want to share them with friends or open them in 
other GIS programs, you need to save them to your computer (Fig. 2.58) as *.kml or 
*.kmz files.

Fig. 2.58. Saving the created thematic layer in the *.kml format

3. Work with thematic layers (editing). 
4. Design the map layout.

Performing a Task

1. Search for the area of interest on the virtual globe of Google Earth Pro
First, find the area of interest by typing its name in the search bar, in our case – 

“Kozyn”, and review the historical view of the Dnipro River floodplain using the 
Show historical imagery tool. The sand massifs are clearly distinguished in satellite 
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images by their bright white color, so you can easily recognize (identify) them by 
this characteristic (Fig. 2.59).

Fig. 2.59. Search for Kozyn urban-type settlement by name in the Google Earth Pro search 
bar and identification of newly created sand massifs

2. Create thematic layers
To create a vector map of the reclaimed artificial islands, it is necessary to digi-

tize the shore line data of the Dnipro River near Kozyn urban-type settlement, Pliuty 
village, for two periods: the oldest (the 2005 image is available in the program) and 
modern (the 2018 image), as well as to compare in more detail the changes in the 
shape of natural and newly formed artificial islands and calculate their area.

First, create a working folder (Fig. 2.60). To do this, go to the Places section 
and right-click on the My Places thematic layer. From the drop-down menu, Add, 
select Folder, and name the new folder “Reclaimed Islands”.
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Fig. 2.60. Creating a working folder

The next step is to create a new polygonal feature (Fig. 2.61). To select the 
outline of the feature (in our case – the reclaimed islands as of 2018), use the Add 
Polygon tool.

Fig. 2.61. The Add Polygon tool 

To do this, click Add Polygon on the toolbar. The New Polygon window will 
open automatically. Type the Name of the feature you are creating (in our case 
“2018”), and change the color and width of the line in the Style tab (optional), for 
example, select the red color, the line thickness “2”. For the convenience of digiti-
zation, change the type of fill from Filled to Outlined.

3. Work with thematic layers (editing) 
Now you can go to the map window and start manual digitization. Left-click on the 

map to delineate the boundaries of the feature without closing the New Polygon win-
dow. Save the changes by clicking Ok. To continue editing the same feature, right-click 
on the created polygon “2018” → Properties, and the Edit Polygon window will open 
again, and you can continue digitizing (Fig. 2.62).
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Fig. 2.62. View of the New Polygon working window

Digitization particulars: for step-by-step digitization, put a vertex, each time 
left-clicking, or digitize in the Trace mode holding down the left mouse button and gen-
tly moving the cursor across the screen. You will see a series of red vertices and one blue 
vertex, which indicates the last vertex you stopped on and, thus, shows the direction of 
drawing. If you have drawn an incorrect segment or made the wrong move in the Trace 
mode, you can cancel it by clicking the appropriate vertex with the left mouse button (it 
will change color to green) and right-clicking on it to delete (Fig. 2.63).

Fig. 2.63. Editing a polygon’s vertices

Try to draw the polygon as accurately as possible to get the correct area values.
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When you have completely outlined (digitized) one island, go to the Measure-
ments tab and see what area it occupies in the Area menu, selecting the usual units 
of measurement, such as Square Kilometers, and write down the result (Fig. 2.64). 
Save the changes by clicking Ok. To enclose the next island into a polygon, you 
need to create a new polygon again, using the New Polygon tool.

Fig. 2.64. View of the outlined reclaimed sandy massif with an open window of the area

Next, create a general map displaying changes of the islands, which will consist 
of the contours of the Dnipro River shoreline near Kozyn urban-type settlement, 
Pliuty village, for two periods (the oldest and modern). To do this, use the Add Path 
tool (Fig. 2.65).

Fig. 2.65. Add Path tool

First, outline the shoreline of the Dnipro River from Pliuty to Kozyn using the 
contemporary image, which is displayed by default on the program screen. The date 
of the image is displayed in the central bottom part of the window, “The date of 
image acquisition” (in our case it is 24.05.2018). When you have finished editing 
the path, save the changes by clicking Ok in the New Path window. Next, using 
the Show historical imagery tool, move the slider bar to the first available archival 
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image and see what this area looked like in the past, namely on 23.05.2005, and 
create a corresponding contour of the shoreline by analogy with 2018 (Fig. 2.66).

 а b

Fig. 2.66. Comparing the views of the islands using the Show historical imagery tool.  
The red color of the shoreline for 2018 and the yellow for 2005 are superimposed  

on the image: 2005 (a), 2018 (b)

4. Designing the map layout
At the final stages of this task, you need to choose the colors to display each 

year, create a legend and save a map of the Dnipro River coastline. 
You can change the color of the shoreline for each year in the Edit Path win-

dow → Style tab.
To save the created map, use the Save image tool. Write the name of the map, for 

example, “Map of artificial islands of the Dnipro River floodplain”, and a descrip-
tion in the  field. Select a convenient legend scale and style for displaying 
the background from satellite images in the Map options window (Fig. 2.67).
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Fig. 2.67. Saving the created map using the Save image tool

Finally, save the map to your computer in a good (high) resolution by selecting 
4800 × 3678 from the drop-down menu (Fig. 2.68).

 Fig. 2.68. Selecting the resolution in the Save image tool

Important to know – in the symbols on the map, only the captions in English are displayed 
correctly, i.e. if you gave polygons or paths the names in Ukrainian, replace them with numbers 
and decipher their meaning separately from the figures in the sub-text captions.
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2. 2. Semi-Automatic Interpretation: Calculation of Spectral
Indices and Threshold Classification

Spectral indices are indicators, which characterize the ratio of EMR reflection 
in different bands of satellite imagery. Initially, they were used in remote sensing 
to assess the state of vegetation, therefore they are called vegetation indices. A 
list of the most common spectral indices can be found in Annex 6. Spectral band 
transformation is used to obtain a normalized range of values that provides the most 
suitable information for studying a particular feature, in other words, to select the 
necessary and remove the redundant data. This method allows improving the results 
of both visual interpretation and simple automated classification techniques.

Index Data Base (IDB) refers to a database that organizes information about all ex-
isting spectral indices. It contains data on 519 indices, 167 satellite sensors, and 43 types of 
indices application.

IDB page contains four lists: a list of indices, a list of satellite sensors, a list of possi-
ble applications of the indices, and a list of references. However, there is confusion on the 
website between the names of satellites and the names of sensors. In some cases, a satellite 
name is used instead of a sensor name [5], so it is worth checking the information. 

Official website: www.indexdatabase.de.

Water “blooming” in the water area of the Kyiv Cistern 
opposite Hlibivka village, WorldView-2 satellite image 
from 07.09.2014
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SECTION 2. ІINTERPRETATION (DECODING) AND ANALYSIS OF SATELLITE IMAGES

The Normalized Difference Vegetation Index (NDVI) is the most popular 
vegetation index. Based on biomass activity data, this index is used to assess the 
condition of crops at a particular time or in dynamics. During photosynthesis, the 
green plants absorb the majority of wavelengths of light within the visible light 
spectrum and reflect near-infrared waves (Fig. 2.69). The NDVI index is calculated 
by the following formula:

NDVI = (NIR – Red) / (NIR + Red), 

where RED is the red part of the spectrum with wavelengths in the range of 0.62 – 
0.75 μm (which accounts for the maximum absorption of solar radiation by chlo-
rophyll;
NIR is the area of the near-infrared part of the spectrum with wavelengths in the 
range of 0.75 – 1.3 μm (the spectral region with the maximum reflection of energy 
by the cellular structure of the leaf).

Thus, NDVI calculation is based on the two most stable (independent of other 
factors) sections of the plants’ reflectivity curve (see Fig. 1.49 in Section 1). 

NDVI is directly associated with the presence of chlorophyll in biomass, and 
by this logic, forests have the highest NDVI values, shrubs have lower values, and 
grassy vegetation has the lowest NDVI values. In practice, however, this correlation 
is very rare. The agricultural lands, fires, pest activity, wetland vegetation – all this 
violates the regular distribution of biomass and, consequently, deciduous forests 
have the same NDVI value as some crops, and the NDVI value of a forest affected 
by pests is equivalent to that of dry grass.

Fig. 2.69. Determination of vegetation status based on NDVI values
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It should be noted that in addition to vegetation, this spectral index is used to 
study water bodies, soils, snow, separation of land boundaries from water, etc. In 
this Task, we will learn to use the NDVI index to detect clusters of planktonic algae 
(water “blooming”) in the Kyiv Cistern.

You will also learn how to combine data into classes, in other words, to carry 
out the threshold classification, as this enables to reveal data trends. 

The purpose of the threshold classification is to divide features into classes according to 
the value of a certain indicator or property (attribute value). 

When classifying, similar features are grouped into classes by assigning the 
same character to each class unit. Defining a class range outlines the features that 
belong to that class and how they will be displayed on the map. By changing the 
boundaries between classes, you can change the display of a particular phenomenon 
on the map. The number of classes may be determined manually or using a standard 
classification scheme, for example, there are selected scales for vegetation indices 
in certain colors.

You can create classes manually so that the features meet certain criteria or 
can be compared with certain valid values. To do this, specify the upper and lower 
limits for each class. Data can also be classified manually to select a specific range 
of values, for example, located above or below the threshold. For example, you can 
select an area below a certain elevation, which is prone to flooding.

That is, a threshold is set, and if the value of the attribute is below this thresh-
old, the features are assigned to one class, and if such value is above this threshold, 
to another one. It is also possible to set several thresholds and make a scale of cor-
responding ranges of values.

Therefore, single-band raster layers may be displayed either in the shades of 
gray (low values = black, high values = white) or using different colors, when indi-
vidual colors are assigned to the same values. In addition, single-band rasters can 
be displayed using a color palette. 

You will learn how to change the display of a gradient thematic image to make 
a gray raster colored. GIS programs feature three modes for displaying the distri-
bution of values:

• interpolated (linear): the final color is the result of linear color interpolation;

• discrete: a color used corresponds to or is larger than the color of the respec-
tive value of the color map;

• exact: no interpolation, only pixels are displayed according to the values 
available in the color map.
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SECTION 2. ІINTERPRETATION (DECODING) AND ANALYSIS OF SATELLITE IMAGES

Task

Analyze the water “blooming” phenomenon in the Kyiv Cistern in August 2016 using 
satellite images.

Water is one of the most valuable resources on our planet. Therefore, the dete-
rioration of its quality causes a number of hazards for the health of the population, 
the environment, and the state in general. The problem of water “blooming” is very 
acute for various water areas. Intense “blooming” is characteristic of reservoirs 
with weak flows, in particular, such as the Dnipro reservoirs cascade. Residents of 
settlements located near these artificial reservoirs suffer the most because they use 
the Dnipro water for domestic and industrial needs. 

Water “blooming” is a phenomenon that is manifested in the change of wa-
ter color due to the mass growth of microscopic blue-green algae (cyanobacteria), 
which is accompanied by a significant deterioration in water quality. These algae 
are very small and are freely transported by water masses to any part of the reser-
voir; their distribution directly depends on the directions of flows and wind. The 
increase in the manifestations of this process is caused by a set of factors, the main 
of which are shown in Fig. 2.70. It should be noted that no less important factor 
that affects the dynamics of the intensity of water “blooming” is the annual rainfall 
and, above all, the amount of precipitation and rainy days at the “blooming” peaks.

Fig. 2.70. Key causes for reservoirs blooming [6] 

Over the last 10 years, the level of phosphates in wastewater coming from 
Kyiv to the Bortnytska Aeration Station (the station responsible for water supply 
and water treatment in Kyiv) has increased from 8 to 30%. None of the treatment 
plants in Ukraine is able to completely clean water off that large amounts of phos-
phates. Many EU countries have legal restrictions on the phosphate content in 
commercially available detergents. There are no such laws in Ukraine yet.
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What is the effect of detergents on water “blooming”?
It is correct to say the effect of phosphates! They are usually found in detergents. The 

main negative impact of phosphates on the environment is that they contribute to the mass 
growth of algae in water bodies. As a result, such water becomes unsuitable for domestic use. 
These algae differently color the water, and this process is called the “blooming” of reservoirs. 
Rotting processes during the death of algae produce an unpleasant odor. The reservoirs be-
gin to lack oxygen causing the oxygen starvation and death of fish and other fauna.

When we use a 400 g package of washing powder with 15% phosphate content, 60g of 
phosphates are released in the wastewater. Therefore, the next time you buy a detergent, pay 
attention to its composition.

Another process that affects the condition of water bodies is “weediness” – 
a natural process of higher aquatic plants’ growth in water bodies. These plants are 
much larger than microscopic algae causing the water “blooming” phenomenon. 
Aquatic plants grow and spread in shallow water only, up to 2.5 m deep (i.e. along 
riverbanks or on sand bars only). Usually, intensive growth of aquatic weeds leads 
to bogging of water bodies, i.e. lakes gradually turn into swamps.

Obtaining data on the phytoplankton condition, particularly relevant data – a 
rather time-consuming and costly process. That is why there was a need to develop 
an algorithm for operational remote monitoring of large-scale clusters of planktonic 
algae and methods for quantifying their density using satellite imagery data. Meth-
ods of processing satellite images to identify water “blooming” areas usually are 
based on the analysis of the difference in the spectral characteristics of a water body 
with the clean surface and subsurface layers and the same covered with aquatic 
plants.

How to find “blooming” areas in satellite images? Water blooming areas may 
be easily identified using the vegetation index (NDVI). In addition, the image 
structure can serve as an additional decoding feature in the visual identification of 
water “blooming”. Areas of intense “blooming” are often characterized by a spe-
cific filamentous texture. In particular, satellite images show that areas of intense 
water “blooming” run along the flows and enter the vortex motions. During the 
periods of prolonged warm, sunny and windless weather, cyanobacteria combine 
into aggregates that come to the surface, forming surface or subsurface clusters 
(Fig. 2.71). 
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SECTION 2. ІINTERPRETATION (DECODING) AND ANALYSIS OF SATELLITE IMAGES

а b

Fig. 2.71. An example of the difference between the water “blooming” and weeding in the 
south of Kyiv in the Google Earth images: the view of an island overgrown with higher 

aquatic plants (a), water “blooming” (b)

Task

Identify the areas of water blooming in the Kyiv Cistern based on the threshold 
classification of the vegetation index.

Data

Sentinel 2 satellite images dated August 6 and 9, 2016 of the territory of the 
Kyiv Cistern (we have discussed downloading in paragraph 1.2., please repeat 
download according to the instructions).

Task Performance Algorithm

1. Downloading images and opening them in a new project
Download images from the USGS Earth Explorer website (official site – 

https://earthexplorer.usgs.gov/). We have described in paragraph 1.2 the procedure 
of using the website and downloading an image from this resource. If you have 
not signed up to this resource, go to paragraph 1.2.3 and download two Sentinel 2 
images of the Kyiv Cistern collected on August 6 and 9, 2016 (Fig. 2.72).

Open a new project and images in the GIS program. Adjust the combination of 
bands 11, 8, 4 (SWIR, NIR, Red) for these images in the project (it was described in 
more detail in paragraph 1. 4). With this combination, clear deep water will appear 
very dark, shallow water or water containing sediments will be displayed in the 
shades of light blue, healthy vegetation will appear bright green, and soils – purple. 
The combination of B11, B08, B04 bands is useful for studying vegetation and is 
widely used to identify water “blooming” areas. 
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Fig. 2.72. Downloading the Sentinel 2 image dated August 6, 2016

а b

Fig. 2.73. Sentinel 2 satellite images of the Kyiv Cistern: August 6, 2016 (a),  
August 9, 2016 (b)
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SECTION 2. ІINTERPRETATION (DECODING) AND ANALYSIS OF SATELLITE IMAGES

By the way, where do you think the water stagnates more: upstream of the Kyiv Hydropow-
er Plant (HPP) dam or at the source of the reservoir? In what way does the direction and speed 
of flow affect the distribution of the most heated water mass?

Using the navigation tools, find the Kyiv Cistern – the largest water body in the 
image (the OSM map will help you to identify the right place (see section 1.3 for 
instructions on adding this map to the project). Take a closer look at the satellite im-
ages of the Kyiv Cistern. As you know, the clear water surface in this combination 
of bands appears as dark blue. This is how the entire Cistern looked like on August 
6. However, in three days, bright green spots appeared – the water “blooming” 
areas carried by the wind, which have a wavy shape. Thus, you have performed the 
visual analysis of the satellite image and identified water “blooming” areas. Now 
you can analyze in which part of the Cistern and near which bank they were spread 
at the time of image acquisition (Fig. 2.73). 

2. Determining Sentinel 2 bands for calculation of NDVI vegetation index

Formula NDVI = (NIR – Red) / (NIR + Red), 

where RED is the red part of the spectrum with wavelengths ranging 0.62 – 0.75 
μm (which accounts for the maximum absorption of solar radiation by chlorophyll);
NIR is the near infrared part of the spectrum with wavelengths ranging 0.75 - 1.3 
μm (the spectral part with the maximum reflection of energy by the cellular struc-
ture of a leaf).

NDVI values vary from -1 to 1, vegetation is displayed in the shades of green 
(a shade depends on the intensity of vegetation development – dark green color 
denotes healthy and most developed vegetation, and it has a value from 0.2 to 1).

Depending on the satellite, the NDVI formula will vary. Do you remember 
why? If you don’t know the answer to this question, take a closer look at the Table, 
Correspondence of Landsat 5, 8 and Sentinel 2 satellite bands, in Annex 2. There-
fore, the formula is:

• For Landsat 8: NDVI = (B5 - B4) / (B5 + B4);

• Landsat 4-7: NDVI = (B4 - B3) / (B4 + B3);

• Sentinel 2: NDVI = (B8 - B4) / (B8 + B4). 

To calculate the NDVI in this Task, we will use the last formula in the list.
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3. Calculating vegetation indices for both images
Float is the format of floating point numbers (Fig. 2.74). Conversion to fractional 

format is necessary, because when calculating NDVI, the distribution will give a frac-
tional result in the range [–1 ... + 1]. If we convert the unit8 format, the output will be 
a file consisting of three values only: “0”, “-1” and “1”.

Fig. 2.74. Algorithm for operation of the Float tool, which converts each value of a raster 
pixel into a floating point number [7]

4. Selecting NDVI threshold values and creating water “blooming” 
distribution maps

The resulting NDVI rasters are now displayed in the shades of gray. Our goal 
at this point is to change the display style of the raster, i.e. to make our gray raster 
color. 

In order to show a color map of the water “blooming” distribution within the 
reservoir, it is necessary to change the display method to one that allows grouping 
pixels into a given number of classes with an option to change the threshold values 
of each class. 

We can set any number of classes and the range, and change them. In this case, 
our task will be to select the number of classes and the range that reflect the “bloom-
ing” classes we study the best.

Please note that the NDVI index is very sensitive to the atmosphere, so you must first 
perform an atmospheric correction of the output image. Without this correction, it may be 
difficult to compare the obtained NDVI values with the data of other studies, and the index 
values will be affected by atmospheric conditions, such as smoke content or temperature 
inversion, observed on the day of the image acquisition. However, if you are not going to 
compare the data with other results, such as values for other days, you can proceed without 
correction. 

As a rule, satellite data with the second level of processing (Level-2 data) already have 
atmospheric correction. That is, in fact, the data for which the EMR values recorded by the 
sensors at the top of the atmosphere (Top-Of Atmosphere Reflectance, TOA) were convert-
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ed into the EMR values of the features on the Earth's surface considering the atmospheric 
conditions at the time of survey. In particular, Landsat images with atmospheric correction 
may be obtained from the website earthexplorer.usgs.gov, category Landsat Collection 1 
Level-2 (On-Demand) → Landsat 8 OLI / TIRS C1 Level-2.

Sentinel 2 images are available with L1C processing level and Top-Of Atmosphere Re-
flectance (TOA) albedo data and radiometric and geometric correction for the entire period 
of satellite operation. L2A data with atmospheric correction (Surface reflection, SR) are also 
available for the majority of images.

MODIS imagery is characterized by a high level of processing, including correction for 
atmospheric effects, and therefore does not require additional processing.

In general, the issue of atmospheric correction is rather complicated, so we 
will discuss it briefly and will not include it in the algorithm. Please, remember, 
however, that it may cause slight differences between the values of our indices and 
real values.

Performing a Task in ArcGIS 

1. Downloading images and opening them in a new project
Download Sentinel 2 images dated August 6 and 9, 2016 of 

the Kyiv Cistern from the USGS Earth Explorer.
Use ArcToolBox → Data Management Tools → Raster → Raster Processing 

tools and double-click the Composite Bands tool (see paragraph 1. 4 for details) to 
unzip both images and make a synthesized image in a combination of bands 11, 8, 
4 (SWIR, NIR, Red) for each of them.

If you have done everything correctly in the previous steps, a new project will 
display two color images. To quickly find the objects of your interest, you can add 
an OSM base map by clicking the button  Add Data → Add Basemap → 
OpenStreetMap (see paragraph 1. 3 for details). 

2. Determining Sentinel 2 bands for calculation of NDVI vegetation index
Compare the vegetation index formula, NDVI = (NIR – RED) / (NIR + RED), 

with the Table of Sentinel 2 bands and determine the bands to be used in the formu-
la. For Sentinel 2, the NDVI formula will look like this: (B8 – B4) / (B8 + B4). We 
have already used bands B8 and B4 to make a synthesized image in the previous 
paragraph.
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3. Calculating vegetation indices for the both images
Open the ArcToolbox window (Fig. 2.75), find Spatial Analyst Tools and click 

(Fig. 2.76) Raster Calculator.

Fig. 2.75. Opening the Arc Toolbox window

Fig. 2.76. Raster Calculator Tool

In the Raster Calculator it is necessary to enter the formula for calculating the 
vegetation index (NIR – RED) / (NIR + RED), in our case it is:

 (Band8 – Band4) / (Band + Band4).

Prior to this, you need to convert certain bands to the “float” format using the 
following operations: ArcToolbox → Spatial Analyst Tools → Math → Float for 
each band separately, or you may simply include the float conversion directly in the 
formula for calculating NDVI in Raster Calculator:

Float(Band8 – Band4) / Float(Band8 + Band4).

To begin with, select appropriate bands from the Layers and variables menu 
in the Raster Calculator dialog box (Fig. 2.77), and insert formula symbols –, +, / 
using the Float tool in the right panel of the calculator and the appropriate Operator 
buttons. Note that the result is stored in a temporary file, which is added to the list 
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of layer as “Calculation”. If you want to save it to your computer, select the de-
sired folder by clicking the icon , type the name of the output layer, for example 
"NDVI_201686", and specify the data format, for example *.tif.

Fig. 2.77. NDVI calculation in a raster calculator

Thus, you will obtain two vegetation indices for the Cistern – as of August 6 
and 9, 2016, which will automatically upload to your project as black and white 
rasters with the values ranging from 1 to –1. 

4. Selecting NDVI threshold values and creating maps of water “blooming” 
distribution

To obtain a color map of water “blooming” distribution within the Cistern, 
you should perform several steps. As you see, the intensity of water “blooming” in 
different parts of the Cistern is irregular. Using the threshold classification of the 
NDVI raster layer, we can distinguish five classes: clear water and four “blooming” 
zones from low to high concentrations of blue-green algae. To access the raster dis-
play configuration tools, right-click on the NDVI raster in the Layers module and 
select Properties from the drop-down menu, then go to the Symbology tab in the 
Layer Properties window and select the Classified display method. This method 
allows grouping pixels into a given number of classes with the ability to change the 
threshold for each class.
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Fig. 2.78. Setting raster display using the Classified method

Then, using the Classify button, go to the additional menu to set the number of 
classes and the range they cover; in our case it is five classes (Fig. 2.78). 

By default, we have obtained the classification thresholds using the Natural 
Breaks method. By moving the sliders or directly changing the values in the Break 
Values field, we can change the values obtained automatically. By clicking Ok in 
the Classification window and in the display settings window, we can check the 
classification result, i.e. whether we have a raster layer divided into five color class-
es of the same type. If not, open the Classification window again and manually edit 
the thresholds for each class (Fig. 2.79). 

In our case, the threshold classification of the vegetation index was performed 
using the threshold values for clear water from -1 to -0.027 (first class); the remain-
ing four classes belong to the group of water “blooming” areas of different inten-
sity, from the slightest change in water color (threshold -0.027 – 0.285, or second 
class) to the largest accumulation of phytoplankton (threshold 0.646 – 0.999, or 
fifth class). Thus, we have adjusted the threshold values for five thematic classes, 
which can be later converted into a vector and, accordingly, used for calculating the 
areas of water “blooming” in the Cistern (Fig. 2.80).
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 Fig. 2.79. Adjusting the NDVI thresholds in the Classification window

а b
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c d

Fig. 2.80. Dynamics of water “blooming” distribution in the Kyiv Cistern in satellite images 
(a – 6.08.2016 and c – 9.08.2016) and thematic maps of blue-green algae distribution  

obtained on the basis of the vegetation index values (b – 6.08.2016 and d – 9.08.2016)) 

Performing a Task in QGIS
1. Downloading images and opening them in a new 

project
Download Sentinel 2 images dated August 6 and 9, 

2016 of the Kyiv Cistern from the  USGS Earth Explorer.
Unzip the images, run QGIS and create a new project in which you can upload 

an OSM map via Browser → XYZ Tiles → OpenStreetMap for better map orienta-
tion (see paragraph 1.3 for more details).

Download the synthesized image in a combination of bands 11, 8, 4 (SWIR, 
NIR, Red) via Raster → Miscellaneous → Merge to a new project: first for one 
image (you can select any image for calculation, since the order is not important) 
(see paragraph 1.4 for more details).

To calculate NDVI, it is important to convert the values for the bands used in 
the formula into “float” format. Therefore, when creating a synthesized image in 
Output data type, specify “float32” data type (Fig. 2.81).

Pay attention to the order of the bands when creating a synthesized image. If the bands 
are displayed in a different order, swap them by dragging the mouse as shown in Fig. 2.81.
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Fig. 2.81. The order of bands combination and the selection of output data type “float32”

Upon completion of the Merge operation, the synthesized image in the combi-
nation of bands 11-8-4 is added to the project as a new layer called “Merged”. To 
avoid confusion in the names, we recommend renaming this layer by adding the 
date of the photo.

Add the next image to the project following the same procedure.

2. Determining Sentinel 2 bands for calculation of NDVI vegetation index
Compare the formula of the vegetation index, NDVI = (NIR - RED) / (NIR + 

RED), with the Table of Sentinel 2 bands and determine the bands to be used in the 
formula. For Sentinel 2, the NDVI formula will look like: (B8 - B4) / (B8 + B4). 
We have already used bands B8 and B4 to make a synthesized image in the previous 
paragraph.

3. Calculating vegetation indices for the both images 
In the main menu, open the Raster tab → Raster Calculator.
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Fig. 2.82. Activating the Raster Calculator

In the appropriate field of the Raster Calculator window, enter the formula 
(NIR - RED) / (NIR + RED), where NIR and RED are the bands selected from the 
menu at the top of the calculator window (Fig. 2.82). 

The band values have been already converted into the “float” format in the first 
paragraph, so now we can simply enter the NDVI calculation formula in the Raster 
Calculator substituting the band values:

(Band8 – Band4) / (Band8 + Band4).

First, select appropriate bands from the Raster Bands menu in the open Raster 
Calculator dialog box (Fig. 2.83) at the top of the window using the Operators to 
select the symbols for the formula: −, +, /. To add layers, double-click on the desired 
layer with the left mouse button. 

Do not enter the band names from the keyboard – the formula will not work.

Note that the Ok button at the bottom of the calculator will not be active until you 
specify a name and location – the Output layer. Select the desired folder by clicking 

 icon and write the name of the output layer, for example: “ndvi_06_08_16”, 
where the numbers indicate the date of the image.

Do not use Cyrillic characters and spaces in paths and file names, since it may disable 
file saving.
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Fig. 2.83. Calculating NDVI in Raster Calculator

In our case the band names in the Raster Calculator were changed since we made a synthe-
sized image. However, they correspond to the combination B11, B8, B4. Accordingly, the band end-
ing in @1 is the first band in the combination, i.e. B11, @2 = B8, @3 = B4. Therefore, the expression 
to be entered in the Raster Calculator will be as follows: (.... @2-.... @3) / (.... @2 + .... @3), where 
the name of your file will replace the omission points in the formula.

After making calculations in the Raster Calculator, you should obtain two veg-
etation indices for the Cistern as of August 6 and 9, 2016, which will automatically 
open in your project as black and white rasters with values ranging from 1 to −1. 

To verify the correctness of our calculation of the index, open the Properties 
module of the created NDVI layer by right clicking on it and go to the Histogram 
tab. The tab that opens will initially be without a histogram; we need to calculate 
it by clicking the Compute Histogram button. If the pixel values in the calculated 
histogram are from −1 to 1, your calculation was correct (Fig. 2.84).
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Fig. 2.84. Calculating the histogram for the created NDVI raster

4. Selecting NDVI threshold values and creating water “blooming” 
distribution maps

To obtain a color map of water “blooming” distribution within the Cistern, you 
should perform several steps. As you see, the intensity of water “blooming” in dif-
ferent parts of the Cistern is uneven. Using the threshold classification of the NDVI 
raster layer, we can distinguish several classes of water surface ranging from clear 
water to areas with high concentrations of blue-green algae. To access the raster 
display configuration tools, right-click on the NDVI raster in the Layers module 
and select Properties from the drop-down menu, then go to the Symbology tab 
in the Layer Properties window and select the Singleband pseudocolor display 
method. This method allows grouping pixels into a given number of classes with 
the option to change the threshold values of each class. Next, select Color Inter-
polation – Discrete (for an exact discrete scale) or Linear (for a continuous color 
scale), and change the Color ramp to make the index map look the way we need. 
We recommend choosing shades of green.
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The Table shown below has three columns:

Value – the upper limit of the range;

Color – color of the range, which can be selected manually;

Label – a text line, where you can set digital limits for a range or make a short 
text description.

Using the Classify button, run the classification for the raster. Here you can 
also change the number of Classes and the range they cover by selecting the Value, 
which best reflects the “blooming” classes that we highlight (Fig. 2.85).

If the number next to Classes cannot be edited, change the Mode from Continuous to 
Equal Interval, or Quantile.

If you do not want to manually select value ranges, it will be easier to apply the 
NDVI scale, which is already divided into colors and values. For this purpose, find 
Style → Load Style at the bottom left part of the window and select the style file 
previously downloaded to your computer (Fig. 2.86). Download it by scanning the 
QR code (Fig. 2.87), unzip the folder, and you will see two files there – ndvi_dis-
crete and ndvi_linear (it has been discussed above that discrete and linear represent 
the type of data interpolation). Try displaying one style file first and then the other 
to see the difference between them. To apply the downloaded style to the selected 
raster, click Apply or Ok.

Fig. 2.85. Setting raster display mode using Classified method
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Fig.2.86. Load Style tool

In our case, the uploaded ndvi_linear style template 
is used for two rasters. Detailed analysis of the ranges of 
NDVI values in the scale showed that the classification 
of the vegetation index was performed using the thresh-
old for aquatic vegetation from 1 to -0.033; all other val-
ues were assigned to the water class. As a result of all 
transformations, thematic rasters were obtained, which 
can be further converted into a vector, and used to cal-
culate water “blooming” areas in a reservoir (Fig. 2.88). 

Fig. 2.87. QR code  
with NDVI style 

template
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а b

c d

Fig. 2.88. Dynamics of water “blooming” distribution in the Kyiv Cistern in satellite images 
(a – 6.08.2016 and c – 9.08.2016) and on thematic maps of blue-green algae distribution 

compiled according to vegetation index value (b - 6.08.2016 and d - 9.08.2016)
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2. 3. Automatic Classification (Unsupervised)

Satellite imagery is an important source of thematic information about land use 
and surface cover at various scales. The process of obtaining thematic information 
based on remote sensing data using automatic (computerized) image processing 
methods is called automatic thematic classification.

The classification involves analyzing the location of a pixel in the space of 
spectral features by comparing it with a certain class of terrestrial features, and is 
sometimes called spectral image recognition. From this point of view, it is import-
ant to distinguish between:

• spectral classes – groups of pixels that are uniform with respect to their loca-
tion in the space of spectral features and characterized by near-similar values 
of spectral reflection;

• thematic classes – types of terrestrial features, which should be recognized 
in the image (for example, coniferous and deciduous vegetation, water, open 
ground, etc.) [8].

Thus, the main task of classification is to establish the links between the spec-
tral classes and thematic ones. 

Loess subsidence. Kyiv Oblast, 
Baryshivskyi District, Morozivka Village.
WorldView 4 satellite image dated 08.06.2018
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SECTION 2. ІINTERPRETATION (DECODING) AND ANALYSIS OF SATELLITE IMAGES

Task

In Kyiv Oblast, the territories affected by various exogenic geological process-
es, such as landslides, karst formations, flooding, and loess subsidence, are con-
stantly growing. Loess soils prone to subsidence are spread over an area of 12.47 
thousand km2, and their prevalence is 43.13%.

The soil water regime in the fields with micro-depressions resulting from loess 
subsidence has a significant effect on the yield of winter wheat starting from the 
very period of snowmelt (Fig. 2.89). Substantial deterioration of crops, until their 
complete rotting, is undoubtedly caused by the thaw water that fills the depressions 
and stays there for a long period (this period of time depends on the water reserves 
from snow, the rate of temperature rise, precipitation intensity, etc.).

а b

Fig. 2.89. Manifestations of loess subsidence in Baryshivskyi District in the Google Earth 
Pro satellite image (a) and example of wheat yield reduction and intensification of weed 

overgrowth on aerial photo (b)

Let's discuss the peculiarities of classification of such depressed soils and the 
processes of plants suppression and crops weeding caused thereby that leads to the 
reduction of winter wheat yield.

Task

To assess the extent of loess subsidence and its impact on the crops’ conditions 
based on Sentinel 2 satellite images on the example of the area between Gostroluch-
chia and Paryshkiv urban type settlements, Baryshivskyi District of Kyiv Oblast. 

Data

Sentinel 2 satellite images dated April 18, 2018 and May 23, 2018 of the terri-
tory of Baryshivskyi District of Kyiv Oblast.
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Task Performance Algorithm

1. Downloading images and opening them in a new project

To begin with, run ArcMap, open a new project, upload two Sentinel 2 images 
dated April and May 2018 (see details in Section 1.3) and visualize them in a com-
bination of bands (11, 8, 4). By comparing these two images, you will see numerous 
rounded features that cover the fields in spring. These features are filled with water 
and are the areas of subsidence we need to classify (Fig. 2.90).

а b

Fig. 2.90. Loess subsidence detected in Sentinel 2 satellite images synthesized in a 
combination of bands (11, 8, 4): April 18, 2018 (a), May 23, 2018 (b)

2. Unsupervised classification
Automatic classification is one of the automated interpretation methods. With 

this method, the user has no need in manual delineation of the features’ boundar-
ies – it is made by a computer program. According to the degree of user participa-
tion in the automated interpretation, classification algorithms are divided into two 
groups: classification without training (autonomous classification, uncontrolled or 
unsupervised classification, clustering) and classification with training (controlled 
or supervised classification).

If you don’t know before starting the classification how many and which ob-
jects are in the image, you should use the classification without training (unsuper-
vised classification) [8].

Unsupervised classification, also referred to as classification without training, 
involves the distribution of all image pixels into relatively homogeneous classes 
based on the proximity of their spectral characteristics only. Unsupervised classifi-
cation is used when the reference data on terrestrial features are missing, i.e. when 
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SECTION 2. ІINTERPRETATION (DECODING) AND ANALYSIS OF SATELLITE IMAGES

their spectral properties are a priori unknown due to the lack of terrestrial informa-
tion or well-defined landscape attributes in the image itself. In this case, the main 
task of the analyst is to justify the optimal number of classes and determine their 
correspondence to the classes of terrestrial features [8].

Supervised classification, also referred to as classification with training, in-
volves assigning each pixel in an image to a known class of terrestrial features, 
which corresponds to a predetermined spectral image. To obtain this spectral image, 
signatures are used – reference areas of the image, which represent well certain 
thematic classes. Signature pixel values are used as training samples to configure 
(teach) the recognition algorithm. During recognition, each pixel of the image is 
consistently compared with the standards and assigned to a particular class. 

3. Reclassification of unsupervised classification result
Reclassification or merger of classes enables converting any gradient image 

(vegetation index value) or image with any number of different surface classes (pre-
vious result of unsupervised image classification) into a thematic map featuring se-
lected classes. To do this, reclassification tools are used, which include the follow-
ing options: manual, equal interval, defined interval, quantile, natural breakdown 
and standard deviation (Fig. 2.91).

Fig. 2.91. Example of reclassification by value ranges [9]

4. Converting a raster into a vector
Raster data can be automatically converted into vector; this process is called 

vectorization. You can convert raster data to both polygonal vector layers and linear 
ones. In such case, the corresponding value of the output class or each raster pixel 
is recorded in the Attribute Table for each polygon of the created vector. (Fig. 2.92).
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Fig. 2.92. Converting a raster into a vector using various simplified settings [10] 

Performing a Task in ArcGIS 

2. Unsupervised classification
To interpret the satellite image dated April 18, 2018 and 

make a thematic map of subsidence, use the Iso Cluster Unsu-
pervised Classification tool. With classification without train-
ing, the spectral classes (or clusters) are identified automatical-
ly in a multi-band image (Fig. 2.93). To perform a classification 
without training, select the Classification → Iso Cluster Unsu-
pervised Classification command in the Image Classification 
toolbar.

Fig. 2.93. Iso Cluster Unsupervised Classification tool

In the tool dialog box, specify the following: Input raster bands, Number of 
classes and Output classified raster. In this case, select the input data in the appro-
priate line – the image from April 2018, then specify the number of classes – 25 and 
select the path for saving the result. For other parameters, the default values may be 
used. Click Ok to run the tool (Fig. 2.94).
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Fig. 2.94. Iso Cluster Unsupervised Classification tool

Upon completing the unsupervised classification, you will receive a thematic 
raster divided into 25 conditional classes of spectral characteristics of the surface 
(Fig. 2.95).

Therefore, we have 25 different classes of the surface displayed in different col-
ors. Now your task is to review each class and make the transparent fill for unnec-
essary classes, and select one color, e.g. red, for the classes indicating subsidence 
areas. The analysis of the resulting thematic map shows that the subsidence areas 
are denoted by three codes (1, 2, 3) only, i.e. the first three spectral classes indicate 
the depressed areas in the fields (Fig. 2.96).
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Fig. 2.95. The result of the unsupervised classification with a random color scheme

Fig. 2.96. The result of the classification with selected symbols
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3. Reclassification of unsupervised classification result

The next step is to reduce 25 classes to two, and assign to depressions code 1 
(value with red fill color) and all the rest – code 0 (classes with transparent colors). 
To do this, use the Reclassify tool, which reclassifies (or changes) the raster value 
(Fig. 2.97).

ArcToolbox → Spatial Analyst Tools → Reclass → Reclassify.

Fig. 2.97 The Reclassify tool

We have created a new thematic raster with two classes (Fig. 2.98).
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Fig. 2.98. New Iso Cluster reclassification raster

4. Converting a raster into a vector

The final operation is the translation of the completed thematic raster into a 
vector layer to obtain the area of  loess subsidence. To do this, use the Raster to 
Polygon tool, which converts a set of raster data into polygonal spatial features 
(Fig. 2.99).

ArcToolbox → Conversion Tools → From Raster → Raster to Polygon.
In the window for converting a raster into vector, specify the reclassified raster 

in the Input raster line, and the name of the resulting layer in the Output polygon 
features line. All other parameters could be left unchanged. For example, the Field 
parameter allows you to select the attribute field of the input raster as an attribute 
in the output vector. Be sure to uncheck the Simplify parameter (disable default 
settings) so that the view of the final vector is not simplified.
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Fig. 2.99. Raster to Polygon tool window

 Fig. 2.100. Thematic vector layer of depressions superimposed on the Sentinel 2 satellite 
image dated April 18, 2018
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In the previous sections, we have discussed adding a new field with an area 
value to the Attribute Table. Let us calculate now the loess areas, i.e. plots from the 
vector layer, which were assigned code 1. Thus, we have obtained a vector map of 
loess subsidence and accordingly calculated the areas of agricultural land that suffer 
from wetting and weeding (Fig. 2.100).

Performing a Task in QGIS
To perform unsupervised classification in QGIS, you 

must first install the Orfeo ToolBox (OTB) plugin featuring 
the appropriate tools. For QGIS Desktop 3.4 version described in this Guidance 
Manual, the OTB plugin can not be installed using a standard installation through 
the plugin manager. This is a separate module, you can download it at www.or-
feo-toolbox.org/download/ or from the git repository at: https://gitlab.orfeo-tool-
box.org/orfeotoolbox/otb. 

2. Reclassification of unsupervised classification result.
3. Converting a raster into a vector.

Installing the Orfeo ToolBox (OTB) plugin
To begin with, open QGIS Desktop 3.4.13 with GRASS 7.8.0 (it is better to 

use this version of QGIS) and create a new project according to the instructions de-
scribed in paragraph 1.3. Next, open the QGIS plugin manager by selecting Plugins 
from the menu bar → Manage and Install Plugins. The plugin we need is available 
in the OTB repository at: orfeo-toolbox.org/qgis/. Select Settings in the left panel 
and click the Add button to add this plugin repository (Fig 2.101).
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Fig. 2.101. Adding a new plugin repository to QGIS

Write in the Name bar “CNES plugin repository” for our new repository.
In the URL bar, specify the address: http://orfeo-toolbox.org/qgis/plugins.xml.
Click Ok to add a new plugin library to QGIS (Fig. 2.102).

Fig. 2.102. Adding OTV plugin to QGIS

Once the plugin is obtained from the specified repository, it will be automatical-
ly added to the list of plugins (Fig. 2.103).
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Fig. 2.103. New plugin library added to QGIS

Select Not installed in the left panel and type “Processing OTB Provider” in the 
search bar at the top of the screen – the plugin will appear in the list below. Select 
it by clicking on the name and on the Install plugin to download and install the otb 
processing (Fig. 2.104).

Fig. 2.104 Installing OTV plugin
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Upon completion of the installation, QGIS (Fig. 2.105) will display the mes-
sage Plugin installed Successfully.

Fig. 2.105. Plugin installed successfully message

Go to the Installed tab on the left side of the window and make sure the check 
box next to Processing OTB provider is selected (Fig. 2.106).

Fig. 2.106. Checking the installation of the OTB plugin
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Go to Settings → Options → Processing in the left panel. OTB can be found 
in the Providers tab.

Open the OTB tab and check the Activate bar. Navigate to the OTB application 
folder below and specify the path to the “application” folder in the downloaded 
OTB installation folder. In the bar below the OTB folder, specify the path to the 
OTB installation folder and click Ok (Fig. 2.107).

Fig. 2.107. Activation of the OTB plugin

As a result, the OTV module will display in the Processing Toolbox (Fig. 
2.108). If the Processing Toolbox is not displayed in the application window, go to 
Processing → Toolbox menu to open it.
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Fig. 2.108. The OTV module in the Processing Toolbox panel

2. Performing Unsupervised Classification
To interpret the satellite image dated April 18, 2018 and make a thematic map 

of subsidences, we will use the unsupervised classification tool, KMeanClassifi-
cation. With classification without training, the spectral classes (or clusters) are 
identified automatically in a multi-band image without analyst’s intervention. To 
perform the classification without training, open the OTB tools tab on the Process-
ing Toolbox toolbar (Fig. 2.109) and select KMeanClassification.
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Fig. 2.109. Opening the KMeanClassification tool

In the tool dialog box, specify the values of the options: Input Image, Number 
of classes and Output Image. In this case, select the image as of April 2018 as input 
data, then specify the number of classes – 25 and select the path where to save the 
result. You may assign values to other parameters by default. Click Run to start the 
tool (Fig. 2.110).

As a result, you get a thematic raster divided into 25 conditional classes of the 
spectral characteristics of surface (Fig. 2.111).
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Fig. 2.110. Parameters of the KMeanClassification tool
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Fig. 2.111. The result of unsupervised classification

Therefore, we have 25 different classes of surface, which is represented in gray 
shades. To facilitate the identification of spectral class, which indicates the areas of 
subsidence, we will change the image in such a way that the classes are displayed 
with a gradation of different colors. To do this, open the image properties (dou-
ble-click the raster layer in the table of contents). In the Symbology tab, select the 
Paletted/Unique values type from the drop-down menu in the Render type bar. In 
the Color ramp bar, select, for example, red-green-blue color gamut. Then click 
Classify – as a result, all classes with the respective color should load into the ap-
propriate window with class values. Finally, click Ok (Fig. 2.112).
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Fig. 2.112. Adjusting the display of raster image classes by color gamut

Now, to see which spectral class indicates the subsidence areas, zoom into sev-
eral fields in the center of the image in the map window, and open the tab next to 
the image name in the table of contents as shown in Fig. 2.113. 

In this example, we see that the subsidence areas are displayed in red, i.e. have 
codes 0 and 1. 



REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS216

SE
C

T
IO

N
 2.

 I
N

T
E

R
P

R
E

T
A

T
IO

N
 (D

E
C

O
D

IN
G

)  
A

N
D

 A
N

A
LY

SI
S 

O
F 

SA
T

E
L

L
IT

E
 I

M
A

G
E

S

Fig. 2.113. Display of raster image classes by color gamut

3. Reclassification of unsupervised classification result

The next step is to reduce 25 classes to two, i.e. the areas of subsidence should 
be assigned code 1 (in the present raster image they have codes 0 and 1), and all 
other values (from 2 to 24) must be assigned code 0, which will indicate the entire 
area without depressions. As a result, it will be easier to further convert the raster 
image into a vector layer and calculate the area of depression. 

To reclassify the image (Fig. 2.114), i.e. to change the values (codes) of the 
raster, use the Reclass tool of the GRASS module from the Processing Toolbox 
toolbar. To quickly open this tool, you can enter “reclass” in the search bar in the 
Processing Toolbox; as a result, all tools that contain this word in the title would be 
filtered out. Select the R.reclass tool from this list.
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Fig. 2.114. Search and selection of a tool for reclassification of raster codes

Specify the raster image to be reclassified in the Input raster layer bar and type 
the following expression in the Reclass rules text bar:

0 thru 1 = 1
2 thru 24 = 0,

which means that classes with code 0 and 1 will be assigned value 1, and all other 
classes from 2 to 24 will be assigned value 0.

Next, specify the name and path for saving the resulting layer (Fig. 2.115) in the 
Reclassified bar and click Run. 
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Fig. 2.115. Tool for raster reclassification

Thus, we have obtained a new thematic raster with two classes (Fig. 2.116).
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Fig. 2.116. New reclassified raster

4. Converting a raster into a vector
The final operation is the transformation of the completed thematic raster into 

a vector layer to obtain the loess subsidence area. For this purpose, use the Poly-
gonize tool, which converts a set of raster data into polygonal spatial features (Fig. 
2.117). To open the tool, go to the Raster menu → Conversion → Polygonize. 
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Fig. 2.117. Selecting a tool for converting a raster into a vector

To convert a raster into a vector, specify the reclassified raster in the Input layer 
bar, and the name of the resulting layer in the Vectorized bar; all other parameters 
can remain unchanged (Fig. 2.118). For example, the Name of the field to create pa-
rameter allows you to specify a name for the attribute field in the output vector layer 
that will contain the corresponding class value from the raster layer (by default, this 
field is named DN, it may be left unchanged). 

Fig. 2.118. Polygonize tool window
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In the previous sections, we have discussed adding a new field with an area 
value to the Attribute Table. Let us calculate now the loess areas, i.e. plots from the 
vector layer with assigned code 1. Thus, we have obtained a vector map of loess 
subsidence areas and accordingly calculated the agricultural areas that suffer from 
wetting and weeding (Fig. 2.119).

Fig. 2.119. Thematic vector layer of depressions superimposed on the Sentinel 2 satellite 
image dated April 18, 2018
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2. 4. Analysis of Geophysical Data from Satellite Images
Satellite imagery allows not only to obtain images of the ground and water sur-

face and calculate different spectral indices, but also generate maps of geophysical 
data on a planetary scale using various climatic, hydrological, chemical and other 
models in combination with ground surveillance data from monitoring stations. 
These are, for example, temperature charts of the ground and water surfaces, the 
content of organic compounds in water, the amount of precipitation, the moisture 
content of the soil, the concentration of atmospheric gases in the air, the content 
of aerosols and much more. In particular, at the website of the National Aeronau-
tics and Space Administration (USA), https://giovanni.gsfc.nasa.gov, you can find 
and download more than a thousand data sets with different geophysical indicators 
obtained by different satellites. For example, the portal contains more than 400 
different data sets related to atmospheric processes and more than 650 different 
hydrological indicators (Fig. 2.120). 

Distribution of nitrogen dioxin over Europe, 
Sentinel 5P satellite image dated 01.12.2017
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SECTION 2. ІINTERPRETATION (DECODING) AND ANALYSIS OF SATELLITE IMAGES

Fig. 2.120. Selecting data to download from the Giovanni website

However, given the complexity of modeling such data and their significant de-
pendence on a network of ground-based surveillance units, these data have a low 
spatial resolution – from one to tens of kilometers. At the same time, their temporal 
resolution, i.e. the frequency of surveying, is usually quite high – once a day, which 
allows the monitoring services to effectively use these data and warn of emergencies 
such as floods, droughts or the spread of volcanic dust. 

In October 2017, the European Space Agency successfully put into orbit the Sentinel 
5P satellite, specifically designed for atmospheric monitoring. It features a Tropomi sensor 
(TROPOspheric Monitoring Instrument) capable of registering the content of ozone, methane, 
formaldehyde, aerosol, carbon monoxide, NO2 and SO2 in the atmosphere with a spatial 
resolution of 7 x 3.5 km. 

Task

In September 2019, similarly to the same period in recent years, Kyiv was 
dragged by smog and fog. The stated reasons for smokiness included the tempera-
ture inversion phenomenon, burning of peatlands near Kyiv, vehicle emissions or a 
fire at a landfill. In this Task, we will analyze the Sentinel 5P satellite images for the 
first week of September 2019 and see what was the content of NO2 and SO2 in Kyiv 
and Ukraine in general. It is believed that the main sources of NO2 and SO2 in the 
atmosphere are vehicles and thermal power plants (Fig. 2.121). 

Data 

Seven Sentinel 5P images of the territory of Ukraine covering the period from 
1 to 7 September, 2019 and containing data on NO2 and SO2 concentrations.
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Fig. 2.121. Map of NO2 concentration in the air over Ukraine and Eastern Europe according 
to Sentinel 5P (July 2018)

Task Performance Algorithm

1. Data downloading and preparation

We will find and download all available Sentinel 5P images capturing the ter-
ritory of Ukraine for the period from 1 to 7 September 2019 using EO Browser. 
Detailed description of EO Browser interface and images downloading is given in 
paragraph 1.2 of this Guidance Manual. Please refer to it if you have difficulty with 
completing this task. 

In this task, you need to log in to the portal and find Kyiv on the map (using the 
search bar), specify the period, select the data type (Sentinel 5P/NO2) as shown in 
Fig. 2.122, and click Search. 
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SECTION 2. ІINTERPRETATION (DECODING) AND ANALYSIS OF SATELLITE IMAGES

Fig. 2.122. Search for Sentinel 5P data in EO Browser

As a result, the list of images available for the specified period should be down-
loaded. Upload them in turn. To do this, click on the Visualize button displayed in 
the image results and adjust the download settings by clicking on the button . 

Fig. 2.123. Image download settings

From the download options, select:
• download type: Analytical;
• image format: tiff-32 bit;
• layers: RAW (raw data) / NO2 and click Download.
Then click on the “back” arrow next to the calendar icon in the upper left corner 

of the window to open the previous image, and save it, making sure to use the same 
save settings as shown in the figure above (Fig. 2.124). 
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Fig. 2.124. Opening the image for the previous date

Save all seven images dated September 1-7, 2019. Note that the boundaries of the saved 
image are the areas of the map window coverage in the EO Browser. Make sure that Ukraine is 
fully displayed in the map window.

Now download images with data on atmospheric content of SO2 for the same 
period (September 1–7, 2019).

2. Creating a cloud mask
When scrolling the images in the EO Browser, you may have noticed that the 

they were not solid and often contained areas with missing values. These areas in 
the images were covered with clouds, which prevented the sensor from detecting 
concentrations of the substances in the atmosphere. When we open the downloaded 
images, we will see that these areas are marked in the digital image with a certain 
code that indicates the clouds. The code usually has a numerical value (in this case 
“1”), and to correctly calculate the average weekly concentrations of substances, 
we need to exclude this value from the raster. Therefore, replace the code value of 
the clouds with NoData, i.e. cut them from the image. The easiest way to do this 
is to create a cloud mask by selecting from the digital image only the pixels with 
appropriate code and clipping the downloaded input image according to the cloud 
mask line (Fig. 2.125). 
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а b c

Fig. 2.125. Clipping the image along the cloud mask: the output image (a),  
the cloud mask (b), clipped image along the cloud mask (c)

3. Calculating average weekly concentrations of air pollutants 

Depending on the wind speed and direction, atmospheric pollutants can spread 
rather quickly along great distances away from the source of pollution. In such cas-
es, it may be difficult to identify a permanent source of pollution, so it is advisable 
to determine the average concentration of substances in the atmosphere for a certain 
period. Continuous emissions will be visible on each image from the entire time se-
ries and, accordingly, will contribute to the increase in average concentrations. The 
easiest way to create an averaged image over a period is to use a raster calculator: 
to sum up all the images of a particular time series and divide them by their number. 

Then we will open the images in ArcGIS or QGIS, cut out the clouds, calculate 
the average weekly concentration of pollutants in the atmosphere and create a map 
of its distribution in Ukraine. 

Performing a Task in ArcGIS

Analysis of NO2 concentration in the atmosphere

Using ArcMap application, we will create a map of the av-
erage weekly values of NO2 concentration in the atmosphere. 

Open ArcMap and create a new project called NO2 (according to the instruc-
tions specified in paragraph 1.3).

Open the first uploaded image dated September 1, 2019 and the Layers Properties 
window by double-clicking on the image. Go to the Symbology tab and select the dis-
play type: Show → Unique Values. It is important for us to check the range of values 
and see what values indicate the clouds. Change also the color scheme to a color mode 
for displaying values in ascending order from blue to red and click Ok (Fig. 2.126). 
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This visualization enables to notice that the maximum value within the studied 
area – 1, which differs significantly from the range of other values, therefore, it 
denotes the clouds (Fig. 2.27). 

To calculate the average weekly pollution, this value 1 should not be taken into 
account, otherwise we will get erroneous data. To do this, replace the value 1 for 
each image with NoData, i.e. you actually need to create a cloud mask and cut it 
out of the image (Fig. 2.128).

Use again the Raster Calculator tool from ArcToolbox → Spatial Analyst → 
Map algebra → Map algebra toolbar. Open it and in the raster calculator window, 
drag the Sentinel 5P_NO2_2019-09-01.tiff image from the top of the window to the 
calculation field below the list of layers and type <1. Specify the name of the output 
layer, e.g. mask_2019-09-01, and the path to the folder for saving the files. 

Fig. 2.126. Image visualization settings
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Fig. 2.129. Clipping the image along the cloud mask

Hence, you will create a new layer, in which all Sentinel 5P_NO2_2019-09-01.
tiff image pixels with value 1 have value 0, and all other pixels have value 1. 

Now again, using raster calculator, you need to divide the Sentinel 5P_
NO2_2019-09-01.tiff image into a cloud mask (mask_2019-09-01). As a result, we 
will get a new raster in which the values that were equal to 1 on the cloud mask will 
remain unchanged, and where the cloud mask was equal to 0, there will be NoData. 

However, we have cut clouds for one of the seven images only so far (Fig. 
2.129). Perform the same operations for each uploaded image. 

The last step will be performed using the tools from the Image Analyst win-
dow, which we have already used to stitch the images (paragraph 1.4). To open the 
Image Analyst window, go to Windows in the top menu and click Image Analyst. 
Select with your mouse seven resulting rasters with cut cloud masks at the top of the 
Image Analyst window. Then, open the drop-down menu and select the calculation 
method mean in the Processing window next to the tool  (Mosaic). 
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Fig. 2.130. Averaging the values of NO2 concentration in the atmosphere for a week

Based on the week-averaged data, you can create a map of pollutants distribu-
tion over the entire area under study (Fig. 2.130). Instructions for creating a map 
layout can be found in paragraph 2.2. 

Performing a task in QGIS

Analysis of SO2 concentration in the atmosphere

We will create a map of weekly average values of SO2 concentration in the 
atmosphere using QGIS application. 

Open QGIS Desktop 3.4.13 with GRASS and create a new project called SO2 
(according to the instructions in section 1.3).

Open the first uploaded image dated September 1, 2019 and the Layers Prop-
erties window by double-clicking on the image. It is important for us to check the 
range of values and see what values the clouds are marked by. To do this, adjust 
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the display of the image (Fig. 2.131). Click the Symbology tab, and select Render 
type → Singleband pseudocolor. In the same window, open the Min/Max value 
settings tab and check the box next to min/max; make sure that the whole raster 
is selected next to the Statistics extent menu. Change also the color ramp to a 
color scheme for displaying ascending values, for example, from red to blue, 
click Classify → Ok. 

Fig. 2.131. Image visualization settings

As a result, the image will be displayed in the appropriate color gradation, and 
the class gradation values will appear in the table of contents. If the gradations of 
classes are not opened by default in the table of contents, open the drop-down menu 
next to the name of the raster (Fig. 2.132).
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Fig. 2.132. Display of class gradations in pseudo-color image

This visualization demonstrates that the maximum value within the studied area 
is 1, which significantly differs from the range of other values, therefore, it rep-
resents clouds. 

To calculate the average weekly concentration of pollutants, this value 1 should 
be ignored in calculations, otherwise we will get erroneous data. To do this, replace 
the value 1 for each image with NoData, i.e. create a cloud mask and cut it out of 
the image.

Again, the Raster Calculator tool will come in useful. To open it, click on the 
Raster menu in the top of the screen and select the Raster Calculator tool. 

At the top of the Raster bands window, double-click the Sentinel 5P_
NO2_2019-09-01.tiff image – it will automatically appear at the bottom of the Ras-
ter Calculator Expression window. Type <1. Specify the name of the output layer, 
e.g. mask_2019-09-01, and the path to the folder for saving the files and click Ok 
(Fig. 2.133).
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Fig. 2.133. Creating a mask of clouds

As a result, we will obtain a new layer in which all Sentinel 5P_NO2_2019-09-
01.tiff image pixels that had value 1 will be assigned value 0, and all other pixels 
will have value 1. 

Now repeat the operation of dividing the Sentinel 5P_NO2_2019-09-01.tiff 
image on the cloud mask (mask_2019-09-01) using raster calculator, and you will 
get a new raster in which the values equaling to 1 on the mask of clouds remain un-
changed, and values equaling to 0 on the mask of clouds have NoData (Fig. 2.134). 
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Fig. 2.134. Clipping the image along the mask of clouds

However, we have cut the clouds for one of seven images only so far. Perform 
the same operations for each uploaded image. 

Then create a raster with average weekly values for SO2 air concentration. To 
do this, open the Raster → Miscellaneous menu and select the Merge tool.
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Fig. 2.135. Choosing a tool for images merging (mosaicking)

In the window for merging images (Fig. 2.135), check the box next to Grab 
pseudocolor table from the first layer, specify the path to save the file and click 
Run.

Fig. 2.136. Averaging the values of SO2 concentration in the atmosphere for a week

Based on the average weekly data you can create a map of pollutants distri-
bution over the entire area of the study (Fig. 2.136). You may find instructions for 
creating a map layout in paragraph 2.2. 
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SECTION 2. ІINTERPRETATION (DECODING) AND ANALYSIS OF SATELLITE IMAGES

Conclusions

The era of the Fourth Industrial Revolution demands from the humanity not 
only to reconsider its attitude to the role of information technologies in all spheres 
of life of a modern man, but also to prepare today's children for life in the second 
half of the 21st century through new approaches to learning. 

Today, in the age of big data, development and improvement of artificial intelligence, 
nanorobots and quantum computers, when devices have become an integral part of our life 
and we use them almost from the cradle (even if a child is imposed with use restrictions, 
the main factor of adaptation is that a child sees his/her parents using phones, computers, 
tablets, etc. and this is perceived as the norm), education cannot remain uninvolved.

One of the tenets of education in the early 2000's was to lay emphasis on the 
development of students' ability to acquire new information rather than focus on 
memorizing already existing one. This approach is driven by the comprehensive 
influence of the Internet, where any information can be found if you know where 
and how to search for it.

Given these two conditions as of 2020 – the total computerization and big data 
that can and should be used – a new tenet has been set up in education: to teach to 
verify information and identify true, reliable data.

We were governed by these factors when writing this Guidance Manual. The 
application of information technology in the natural sciences allows not only to 
verify information, but also to form (based on the concept of science education) 
a new, own system of knowledge and ideas about how our Earth functions and 
how we influence it. Currently, anyone can access satellite observation data. After 
completing the tasks contained in this Guidance Manual, you will be able to see 
how the Troieshchyna housing estate was built in Kyiv, determine the fire seat in 
the Darnytskyi forest, find areas of inwashed sand for construction in the Dnipro 
River floodplain, analyze the dynamics of felling in Fastivske Forestry Enterprise, 
determine the water “blooming” areas in the Kyiv Cistern, estimate the amount of 
loess subsidence in Baryshivskyi District of Kyiv Oblast, and determine the NO2 
and SO2 concentrations in Kyiv and Ukraine during the 2019 autumn smog period.

One may reasonably ask: why RS and GIS technologies have not been properly ap-
plied yet in school education? Perhaps the most correct answer is the need to adapt and 
test the pedagogical methods of the RS and GIS to be used for different age categories 
of schoolchildren, and to introduce the potential of these technologies to teachers. This 
Guidance Manual was preceded by the publication, “Fundamentals of Remote Sensing: 
History and Practice”, which allows to form a general idea of the mechanism and pos-
sibilities of remote sensing use in the natural sciences, and shows in practice how the 
GIS and RS are interrelated and what results can be achieved in the research process.

Given the total computerization that already exists and is rapidly developing, 
the use of information technology in science education will not lose its relevance.
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Glossary of GIS Terms

(adapted from the Manual, “Fundamentals of Creating Electronic Maps based on Arcgis 
10.1 Software / S. M. Brevus et al, Kyiv: CITIPRINT LLC, 2013, p. 142)

Address data feature refers to the data which contains information used for geoc-
oding. Address data may consist of one individual address or a table comprising 
many addresses. 

Attribute refers to nonspatial information about a geographic feature, which is 
usually stored in a table and linked to the feature by a unique identifier. For ex-
ample, attributes of a river might include its name, length, and sediment load at a 
gauging station. 

Attribute data is defined as GIS data that contains information about the coordi-
nates or location of features and data that describe the quantitative and qualitative 
characteristics of spatial features.

Attribute Table is a database or tabular file that contains information about a set 
of geographic features, usually organized so that each row represents one spatial 
feature, and each column represents an attribute. In raster data sets, each row of the 
Attribute Table corresponds to a specific area of cells with the same values.

Attribute query refers to a request for selection of spatial features or geodatabase 
records based on their attribute values. 

CAD refers to a system of automatic design for the development, drawing and display 
of graphic information. Such systems are often used in construction and planning.

Catalog tree refers to a hierarchical display of folders providing access to GIS 
data stored on local disks and in the network, which allows users to manage con-
nections to databases and GIS servers.

Cell refers to the smallest unit of information in an image, raster, or grid. On the 
map, each cell represents an area of the earth's surface, for example square meter or 
square mile, and usually has a related attribute value, such as soil type or vegetation.

Column refers to an element of the Attribute Table. Each column contains attri-
bute values of the same type, such as numbers, text, or dates only.  

Computer-aided design refers to a computer information processing system used 
for computer-aided design, development and manufacture of a final product, as well 
as for preparation of design and technological documentation.

Coordinate system refers to a system that determined the location in space and 
relationship between positions. Coordinate system allows individual determination 
of the data of each point. Defining a coordinate system is one of the main steps in 
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creating a new class of features or raster data. ArcGIS typically uses three coordi-
nate systems: geographic, projection, and vertical.

Database refers to an arranged set of logically interrelated data that is shared 
and designed to meet the users’ information needs. Storage of data in the database 
ensures the centralized management, compliance with standards, security and in-
tegrity of data, reduces redundancy and eliminates data inconsistencies.

Degrees/minutes/seconds denote units of measurement of latitude and longitude. Degree 
means 1/360 of a circle. One degree contains 60 minutes, and one minute – 60 seconds.

Desktop GIS refers to a mapping software that is installed onto and runs on a per-
sonal computer and allows users to display, query, update, and analyze data about 
geographic locations and the information linked to those locations.  

Digital map (numerical map) refers to a digital model of the surface, formed tak-
ing into account the laws of cartographic generalization using the projections, lay-
out, coordinate system and heights adopted for the maps. In fact, the term “digital 
map” means a digital model, digital cartographic data. A digital map is created with 
full observance of norms and rules for mapping, maps accuracy, generalization, 
and system of symbols. The digital map is the basis for the production of ordinary 
paper, computer, and electronic maps. It is included in the cartographic database. 
The digital map is one of the most important elements of GIS information support 
and at the same time may be the result of the GIS operation.  

E-map refers to an image formed on the display screen based on raster and vector 
digital maps, databases, symbols, legends and other elements of cartographic de-
sign of a given standard and scale.   

Extent refers to pairs of coordinates that define the minimum rectangle that limits the 
data source on the map. All coordinates of the data source fall within these boundaries.

Feature class refers to a set of geographic features with similar geometry type 
(points, lines, or polygons), attributes, and spatial reference. Classes of spatial ob-
ject can be stored in a geodatabase or included in shapefiles, covers, and other 
spatial data formats. 

Feature layer refers to a layer referencing to a set of feature data. Spatial data 
represent the following geographical elements: points, lines and polygons.

File geodatabase refers to a geodatabase that is stored in the form of file folders. Mul-
tiple users can use the file geodatabase at the same time, but only one of them can edit it.

Folder connection refers to ArcCatalog, an element of the top level of the Cata-
log tree that provides quick access to geographic data stored on local disks (includ-
ing CD-ROM) or shared on the network.

Geo-feature refers to a digital representation of a real-world feature (digital ter-
rain model) that contains information about its location and a set of properties, 
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characteristics, attributes, or the feature itself. There are four main types of spatial 
facilities: point, linear, planar (polygonal), contour and surface.  

Geographic data refers to the information about real-world objects including 
their shape, location, and descriptions.   

Geographic information system refers to an integrated set of hardware, software 
and information tools that provide input, storage, processing, manipulation, analy-
sis and display (presentation) of spatially coordinated data.

Geoinformatics refers to the science, technology, and applied activities related 
to the collection, storage, processing, analysis, and display of spatial data, as well 
as the design, creation, and use of geographic information systems. In a narrower 
sense (as a science), the geoinformatics is an interdisciplinary science about the 
means, methods and ways of collecting, storing, exchanging, processing, analyzing 
and displaying spatial (or spatially coordinated) information.

Geoinformation technologies refers to a set of tools, methods and techniques for 
automated collection, storage, manipulation, analysis and display (presentation) of 
spatial information.

Georeferencing refers to adjusting geographic data with a known coordinate sys-
tem to enable viewing, querying, and analyzing along with other geographic data. 
Georeferencing may include shifting, rotating, scaling.  

Geo-spatial analysis refers to an approach, which involves the application of statisti-
cal analysis methods and various information technologies to geographic or geospatial 
data (geodata). Such analysis involves the use of specialized software for geospatial 
processing and presentation, the application of analytical methods to terrestrial or geo-
graphic data, including geographic information systems (GIS) and geoinformatics.

Layer refers to a set of uniform (of same dimension) spatial objects that relates 
to a single theme (class of objects) within a territory and in a coordinate system 
common to a set of layers.

Layout refers to the organization of the elements of a digital or printed map dis-
play, including headings, legend, north arrows, scale and geographic data.

Legend is defined as a list of feature types displayed on a map; they are usually 
present in a map layout. Legends often contain symbols or map feature samples 
along with description of the meaning of each symbol.

Line refers to a shape on a map that connects a series of points, one after another, 
representing the x- and y-coordinates. The line can be straight or curved.

Map refers to a flat, mathematically defined, reduced, generalized symbol of the Earth's 
surface, other celestial body or outer space, showing the location, properties and relation-
ships of natural and socio-economic phenomena. The map is considered a figurative-sym-
bolic model with high information content, spatio-temporal similarity in relation to the 
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original, metricity, special visibility and clarity, which makes it the most important knowl-
edge acquisition tool in the area of Earth sciences and socio-economic sciences.

Map document refers to a file in ArcMap that contains a single map, its layout, 
and associated layers, tables, and charts. Map documents can be printed or inserted 
in other documents. Map document file has *mxd extension.

Map template refers to a map document that allows quick creation of a new map. 
Templates can contain data, user interface and predefined layout, in which such 
elements of a map as north arrows, scale bar and logos are already organized on 
the virtual page.

Metadata – information about the content, quality, status and other characteristics 
of data. Metadata may contain information about what geographic data represent, 
how and by whom it was collected, what is the projection, scale, resolution, accu-
racy, and compliance with certain standards.

Overlay analysis refers to operations of overlapping two or more layers, which 
results in either a graphic composition (graphic overlay) of the output layers, or one 
derived layer, which topological and semantic attributes are derived from the values 
of the output layers attributes.

Personal geodatabase refers to a geodatabase that stores data in a single-user 
relational Microsoft Access database management system. Multiple users can view 
the personal geodatabase at the same time, but only one of them can edit it.

Pixel refers to the smallest unit of information in an image or raster map, usually 
square or rectangular. The term “pixel” is often used synonymously with cell.

Point feature refers to a cartographic object that has neither length nor area 
on an accepted scale, such as a city on a world map or a house on a map of 
Ukraine.

Polygon refers to a closed shape on a map formed by sequentially connected 
points with X- and Y-coordinate pairs, where the first and last pairs coincide, and 
all other pairs are unique.

Polygon feature refers to a cartographic feature that delimits an area on a given 
scale, such as a country on a world map or a county on a city map.

Projection refers to a method of depicting the spherical surface of the Earth on 
a plane. Mathematically, this is a certain transformation of the angular values of 
longitude and latitude on a plane.

Raster refers to a model of spatial data, which defines space as a set of equal cells, 
arranged in rows and columns. Each cell contains an attribute value and location 
coordinates.

Reference scale refers to the scale at which symbols appear on a map at their true 
size, specified in page units. As the extent is changed, the size of text and symbols 
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will change along with the display. Without a reference scale, symbols will appear 
the same at all map scales. 

Scale refers to the ratio of a distance on the map to the corresponding distance on 
the ground, which is usually expressed as a fraction or the ratio of one number to 
another. A 1: 100,000 scale means that one unit on the map corresponds to 100,000 
same units on the ground.

Scale bar refers to an element of a map that graphically displays a scale.
Selectable layers refer to layers whose spatial objects can be selected in ArcMap 

using interactive sampling tools.
Shapefile refers to a vector format for storing the features (points, lines, poly-

gons, etc.) The format was introduced for ArcView GIS version 2 in the early 90's
Spatial database refers to a structured set of spatial data and related attributes 

organized for efficient storage and retrieval.
Symbol refers to a graphic representation of a geographical feature or a class of 

features that helps to identify and distinguish them from other features on the map. 
For example, linear symbols represent spatial objects – arcs; marker symbols – point 
features; fill characters – polygonal features; text symbols – annotations. The mean-
ing of the symbols is usually explained in the map legend.

Table of Contents refers to a list of data frames and layers (or tables) of the map, 
which shows the symbols of the data, the data source and availability of the layers 
for sampling.

Triangulated irregular network refers to a description of the map surface with 
triangular faces, according to which each data point in space corresponds to a trian-
gle of the reference grid.

Vector refers to a coordinate-based data model, which represents geographic features 
as points, lines, and polygons. Each point feature is represented as a single coordinate 
pair, while line and polygon features are represented as arranged lists of vertices. 

Visualization is defined as design and generation of geoimages and other graph-
ics on display devices (mainly on the display screen) based on the original digital 
data, rules, and algorithms for their conversion.

Workspace is defined as a repository for geographic data. The workspace can be 
a folder that contains Shapefiles, a geographic database, a set of feature classes, or 
an ArcMap workspace.

x, y coordinates – a pair of values that represents the distance from the starting 
point (0.0) along two axes: the horizontal axis (x), which represents East – West 
direction, the vertical axis (y), which represents North – South direction.
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Additional Resources Where You Can Search for Images:

LandLook (US Geological Survey, USGS) – https://landlook.usgs.gov/viewer.html.
Here you can search for available medium-resolution images collected by Landsat 
and Sentinel satellites. Using this resource, you can create features, and design 
maps for printing.

GeoVisual Search – https://www.descarteslabs.com/search.html.
This is a search engine that allows users to search for images for similar geograph-
ic features. The Descartes Labs platform is based on satellite images provided by 
Landsat, the National Agricultural Imagery Program (NAIP) and PlanetScope.

 OpenAerialMap – https://openaerialmap.org/.
The Open Imagery Network (OIN) collects data with open licenses. OIN providers 
allow using images and related metadata under a general license. The Open Imag-
ery Network brings together satellite and aerial imagery providers, governmental 
and non-governmental organizations, mapping companies and anyone involved in 
the production, distribution and use of aerial imagery. OpenAerialMap, based on 
the Open Imagery Network (OIN), is an open service that provides search and 
access to these images.

EarthTime – https://earthtime.org/.
A free platform developed by the CREATE Lab at the Carnegie Mellon University's 
in the United States, which “allows users to interact with Earth transformation 
visualization over time” and create animations.

Spectator – https://spectator.earth/.
This free web application simplifies the acquisition of images through verbal search, 
such as “cloudless images of New York for the last month”. A free account enables 
you to create your own repository to track changes in the area you are interested in.

Worldview – https://worldview.earthdata.nasa.gov/.
A browser provided by the NASA, which offers many options to visualize different 
layers of environmental information. 
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Annex 1 (continued)

Earthnet On Line Interactive Stand Alone client ( EOLI – SA ) – http//eoli.esa.int/.
A program to search for the images distributed under the auspices of the European 
Space Agency, for a fee and free of charge – ENVISAT ASAR, SPOT HRV (IR), ERS 
SAR, JERS SAR, Proba CHRIS, HRC, KOMPSAT.

Earth from Space – NASA Space Shuttle Earth Observations Photography data-
base of images – http://earth.jsc.nasa.gov/sseop/efs/.
Free – selected Shuttle images.

Global Change Master Directory – http://gcmd.gsfc.nasa.gov/.
Data for studying global changes. Free data, maps and images collected under the 
auspices of the Global Change Program.

Earth Science Data Interface (ESDI) at the Global Land Cover Facility –  
http://glcfapp.umiacs.umd.edu:8080/esdi/index.jsp.
Free - selected Landsat and Terra ASTER images, as well as SRTM digital terrain 
models.

Geostationary Satellite Server – www.goes.noaa.gov/.
Catalog of geostationary satellites images. Free – GOES images and images from 
other geostationary satellites.

Meteosat Image Services – 
http://www.eumetsat.int/Home/Main/DataAccess/EUMETSATDataCentre/index.ht-
m?l=en.
Free Meteosat satellites images.
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Correspondence of Landsat 5, 8 and Sentinel 2 Satellite Bands

Landsat 8 Landsat 5 Sentinel 2

Spectral 
bands

Wave 
length 
(μm)

Spatial 
resolution, 

m 

Spectral 
bands

Wave 
length 
(μm)

Spatial 
resolution, 

m

Spectral 
bands

Wave 
length 
(μm)

Spatial 
resolution, 

m 

Band 1
(Ultra 
Blue)

0.433–
0.453

30 – – 30 Band 1 
(Ultra 
Blue)

0.433–
0.453

60

Band 2 
(Blue)

0.45–
0.515

30 Band 1 
(Blue)

0.45–
0.52

30 Band 2 
(Blue)

0.458–
0.522

10

Band 3
(Green)

0.433 – 
0.453

60 Band 2  
(Green)

0.52–
0.6

30 Band 3  
(Green)

0.543–
0.577

10

Band 4 
(Red)

0.63–
0.68

30 Band 3  
(Red)

0.63–
0.69

30 Band 4 
(Red)

0.650–
0.680

10

– – – – – – Band 5  
(Vegetation 
Red Edge)

0.698–
0.712

20

– – – – – – Band 6  
(Vegetation 
Red Edge)

0.733–
0.747

20

– – – – – – Band 7  
(Vegetation 
Red Edge)

0.773–
0.793

20

Band 5  
(NIR)

0.845–
0.885

30 Band 4 
(NIR)

0.76–
0.9

30 Band 8 
 (NIR)

Band 8a  
(Vegetation 
Red Edge)

0.784–
0.899
0.855–
0.875

10
20

– – – – – – Band 9  
 (Water 
vapour)

0.935–
0.955

60

Band 6  
(SWIR1)

1.56–
1.66

30 Band 5 
(NIR2)

1.55–
1.75

30 Band 11 
(SWIR1)

1.565–
1.655

20

Band 7  
(SWIR2)

2.1– 
2.3

30 Band 7 
(SWIR)

2.08–
2.35

30 Band 12  
(SWIR2)

2.100–
2.280

20

Band 8  
(PAN)

0.50–
0.68

15
–

– – – – –
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Band 9 
(SWIR, 
Cirrus ) 

1.36–
1.39

30 – – – Band 10  
(SWIR, 
Cirrus) 

1.360–
1.390

60

Band 10  
(TIR1)

10.6–
11.2

100 *(30) Band 6  
(TIR)

10.40–
12.50

120 *(30) – – –

Band 11  
(TIR2)

11.5–
12.50

100 *(30) – – 120 *(30) – – –

Ultra Blue (Coastal / Aerosol) – ultraviolet (coast and aerosol); 
NIR  – Near Infrared;
SWIR – Short Wavelength Infrared; 
TIR  – Thermal Infrared;
Cirrus – cirrus clouds;
PAN – Panchromatic.
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Google Timelapse

Official webpage: https://earthengine.google.com/timelapse/

Timelapse is used to accelerate the reproduction of relatively slow processes, in 
our case – time series of the Earth satellite images. 

Back in 2013, the Google Earth mapping service created the Timelapse func-
tion, in which chronologically arranged satellite images give a full picture of the 
changes of our planet over a few decades. The animated map contains more than 
five million images: the oldest of them are from the Landsat 5 archive, and the 
latest – from the Landsat 8 and Sentinel 2 satellites. Thus, more than 25 million 
spectacular videos showing the Earth's surface for the period 1984-2018 have been 
created.

Animation of the construction of the Troieshchyna 
residential area in the Google Timelapse window
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The most common Band combinations for Landsat 5, 7, 8

Combination 
for Landsat 5, 7

Combination 
for Landsat 8 Information

В03, В02, В01 В04, В03, В02
A combination of “true colors”. 

In this combination, the features on 
the earth's surface are similar to how 
they are perceived by the human 
eye. Healthy vegetation looks green, 
cleared fields – light, unhealthy vegeta-
tion – brown and yellow, roads – gray, 
coastlines – white. This combination of 
bands enables us to analyze the con-
dition of water bodies, to estimate the 
depths. It is also used to study anthro-
pogenic objects. Cuttings and sparse 
vegetation are poorly differentiated; it 
is difficult to distinguish one type of 
vegetation from another. 

Red, Green, Blue

В04, В03, В02 В05, В04, В03
The standard combination of “ar-

tificial colors”. Vegetation is repre-
sented in shades of red, urban devel-
opment – green and blue, and soil 
colors vary from dark to light brown. 
Saturated shades of red are indicators 
of healthy and/or deciduous vegeta-
tion, while lighter shades characterize 
grassy or sparse / shrubby vegetation. 
This combination is very popular and 
is used to study the condition of veg-
etation, soil monitoring, as well as to 
study crops. 

NIR, Red, Green



REMOTE SENSING: ANALYSIS OF SATELLITE IMAGES IN GEOGRAPHIC INFORMATION SYSTEMS252

A
N

N
EX

ES

Annex 4 (continued)

В07, В04, В02 В07, В05, В03 This combination produces an im-
age close to true colors, but at the same 
time enables us to analyze the atmo-
sphere condition and smoke. Healthy 
vegetation looks bright green, grass – 
green, bright pink areas indicate open 
ground, brown and orange tones are 
characteristic of sparse vegetation. 
Dry vegetation looks orange, the wa-
ter – blue. This combination gives an 
excellent result in the analysis of des-
erts and desert areas. In addition, it can 
be used to study agricultural lands and 
wetlands. This combination is used to 
study the dynamics of fires and post-
fire analysis of the territory. The burned 
areas will look bright red.

SWIR-2, NIR, Green

В04, В05, В01 В05, В06, В02 Healthy vegetation appears in 
the shades of red, brown, orange and 
green. Soils can look green or brown, 
urban areas – whitish, gray and green-
blue, recently cut areas may appear 
bright blue, and restoration of vege-
tation or sparse vegetation may look 
reddish. Adding a middle infrared band 
enables to distinguish well the age of 
vegetation. 

NIR, SWIR-1, Blue
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В04, В05, В03 В05, В06, В04 This combination of the near, mid-
dle infrared bands and the red visible 
band enables us to clearly distinguish 
the boundary between water and land. 
Vegetation is depicted in different 
shades and tones of brown, green and 
orange. This combination allows us to 
analyze the moisture in the study of 
soils and vegetation. In general, the 
higher the soil moisture, the darker it 
will look, due to the absorption of wa-
ter by IR radiation.

NIR, SWIR-1, Red

В07, В05, В03 В07, В06, В04 This combination produces an im-
age close to natural colors, however 
at the same time allows us to analyze 
the atmosphere condition and smoke. 
Vegetation is depicted in shades of dark 
and light green, urban areas look white, 
green-blue and crimson; soil, sand and 
minerals can be depicted in very differ-
ent colors. Almost complete absorption 
in the middle IR range by water, snow 
and ice allows us to distinguish very 
clearly the shoreline and very clearly 
highlight bodies in the image. Hot spots 
(such as volcanic craters and fires) look 
red or yellow. One of the possible ap-
plications of this combination of bands 
is fire monitoring. 

SWIR-2, SWIR-1, Red
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В05, В04, В03 В06, В05, В04 Similar to combination 4-5-1, this 
combination provides a lot of informa-
tion and color contrasts. Healthy vege-
tation looks bright green, and the soil 
is pinkish-purple. Unlike 7-4-2, which 
includes 7 bands and allows us to study 
geological processes, this combination 
enables us to analyze agricultural lands. 
It is very convenient for studying vege-
tation and is widely used to analyze the 
condition of forest communities.

SWIR-1, NIR, Red

В07, В05, В04 В07, В06, В05 This combination does not in-
clude any band in the visible range 
and provides optimal analysis of the 
atmosphere. The coastlines are clearly 
visible. It can be used to analyze the 
texture and moisture of soils.

Vegetation looks blue
.

SWIR-2, SWIR-1, NIR
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The most common Band combinations for Sentinel 2а

Sentinel 2а combination Information

Natural colors

B04, B03, B02

A combination of “true colors”. 
Since this combination uses visible 
bands, terrestrial objects are displayed 
in colors which are customary for 
a human eye: healthy vegetation is 
green, freshly cleared fields are light, 
unhealthy vegetation is brown and yel-
low, roads are gray, and the shoreline is 
white. However, water bodies here will 
be too dark due to insufficient passage 
of blue color through the atmosphere, 
and you can analyze their condition and 
assess their depth based on color inten-
sity. This combination is also used to 
study anthropogenic objects. 

Red, Green, Blue

Artificial colors (vegetation)

B08, B04, B03

A combination of “artificial col-
ors”. Vegetation is depicted in shades 
of red, urban development – blue, and 
the soil varies from dark to light brown. 
Ice, snow and clouds are white or light 
blue. This is a very popular combination 
of bands, which is useful for studying 
vegetation, monitoring soils and dif-
ferent stages of crop growth. Typically, 
deep shades of red indicate deciduous 
and healthier vegetation, while lighter 
shades of red indicate meadows or ar-
eas with sparse vegetation. This com-
bination gives results similar to those 
obtained through the infrared aerial 
survey.

NIR, Red, Green
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Agro
B11, B8A, B02

This combination is useful for crop 
monitoring. Bright green color rep-
resents energetic, healthy vegetation. 
Coniferous forests look dark green, 
and deciduous – bright green. Areas 
with sparse vegetation and bare areas 
are displayed in brown and purple.

SWIR1, Red8, Blue

Artificial colors (urbo)
B12, B11, B04

This combination also provides a 
“natural” image. Vegetation is reflect-
ed in shades of dark and light green 
during the growing season, urban 
development – white, gray, blue or 
purple. Virtually complete absorption 
of medium infrared bands in water, 
ice and snow provides well-defined 
shorelines. Snow and ice are blue, and 
waters are black or dark blue. Hot sur-
faces, such as forest fires and volcanic 
craters, saturate the mid-infrared bands 
and appear in shades of red or yellow. 
This combination is, among others, 
used for forest fires monitoring.

SWIR2, SWIR1, Red

Annex 5 (continued)
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Land/water: B8A, B11, B04 This combination of bands is suit-
able for displaying lands and waters. 
The ground is depicted in shades of or-
ange and green, ice – in bright purple, 
and water – in shades of blue.

Red8, SWIR1, Red

Healthy vegetation: B8A, B11, B02 Healthy vegetation is depicted in 
shades of red, brown, orange and yel-
low. Soils can be green and brown, 
urban developments – white, blue and 
gray, reddish areas represent new vege-
tation, probably sparse meadows. Pure 
deep water in this combination will be 
very dark. If the waters are shallow or 
contain sediments, they will look like 
shades of light blue. This is not a good 
combination for studying man-made 
features, such as roads or runways.

Red8, SWIR1, Blue

Annex 5 (continued)
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Vegetation analysis
B11, B8A, B04

This combination provides a user 
with big volumes of information and 
color contrasts. Healthy vegetation is 
bright green, and soils are purple. It is 
useful for studying vegetation and is 
widely used in forestry to identify ar-
eas of insect-infested trees.

SWIR1, Red8, Red

Shortwave infrared
B12, B8A, B04

This combination of bands is very 
useful for vegetation research, because 
here the reflectivity in SWIR depends 
on the moisture content in leaves or 
soil. Thus, healthy vegetation with 
high moisture content, as well as coast-
al areas are reflected in bright green, 
while arid areas in dark green. The co-
niferous forest is deep green, and the 
deciduous forest is bright green. The 
soil looks brown and purple. This com-
bination of bands is suitable for study-
ing the vegetation condition, detecting 
soil disturbances, soil type, etc.

SWIR2, Red8, Red

Annex 5 (continued)
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Elimination of atmospheric 
influences

B12, B8A, B03

This combination provides a “true 
colors” reproduction. Healthy vege-
tation will be bright green, its color 
intensity may be changed during dif-
ferent growing seasons. Meadows are 
green, barren soils are depicted as pink 
areas. Dry vegetation will be orange 
and water will be blue. This combina-
tion of bands provides vivid images of 
desert areas. The combination is useful 
for geological, agricultural and wet-
land research. The fire looks red in the 
images, and this combination is used to 
control fires and analyze burned forest 
areas. Urban buildings are displayed in 
different shades of purple. Meadows 
look light green. Light green spots in 
the city indicate the grassy vegetation 
of parks, cemeteries, and golf cours-
es. Olive-green or bright green shades 
usually indicate areas covered with 
coniferous forest, and dark green mas-
sifs – deciduous forest.

SWIR2, Red8, Green

Annex 5 (continued)
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Snow / Clouds
B02, B11, B12

This combination is good for de-
tecting snow and ice because they 
are reflected in the visible part of the 
spectrum and highly absorbed in the 
shortwave infrared range. Snow and 
ice look bright red. The more ice, the 
stronger the absorption in SWIR and 
the more saturated the red color. Thick 
ice and snow are depicted in bright 
red (or red-orange). The vegetation 
will look greenish in this combination. 
Bare soil will look bright blue. The wa-
ter will be very dark as it absorbs red 
and SWIR, but small drops of sparse 
water in the clouds scatter light equally 
in both the visible and SWIR ranges 
and will therefore appear white.

Blue, SWIR1, SWIR2

End of Annex 5
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The most common spectral indices

NDVI Sentinel 2
(B8A-B04) /
(B8A+B04)
NDVI Landsat 8
(B5-B4)/(B5+B4)

The normalized differential vegetation index is often 
used for drought monitoring, agricultural production, etc. 
NDVI is a standardized vegetation index that allows us to 
generate images showing relative biomass. The absorption 
of chlorophyll in the red band and the relatively high 
reflectivity of vegetation in the near infrared band (NIR) 
are used to calculate NDVI.

ARVI Sentinel 2
(B08-(B04-
1*(B02-B04))) /
(B08+(B04-
1*(B02-B04)))
ARVI Landsat 8
(B5-(B4-1*(B2-B4))) /
(B5+(B4-1*(B2-B4)))

The vegetation index is resistant to atmospheric 
influences. This is an improved NDVI, which is used to 
correct the atmospheric influences. It is mostly useful 
in regions with a high content of atmospheric aerosol, 
including in tropical areas contaminated with soot. Users 
apply it with NDVI.

EVI Sentinel 2
2.5*((B8A-B04) /
((B8A+6*B04-
7.5*B02)+1))
EVI Landsat 8
2.5*((B5-B4) /
((B5+6*B4-
7.5*B2)+1))

The Extended Vegetation Index EVI is an “optimized” 
vegetation index designed to enhance the signal of 
vegetation with improved sensitivity in regions with high 
biomass and improved vegetation monitoring by reducing 
atmospheric exposure.

SIPI Sentinel 2
(B08-B02) / (B08-B04)
SIPI Landsat 8
(B5-B2) / (B5-B4)

SIPI enables us to determine the initial stage of 
plant disease. It is analyzed together with NDVI. SIPI is 
a good indicator for use in areas with high variability in 
vegetation structure.

NBR Sentinel 2
(B8A-B12) /
(B8A+B12)
NBR Landsat 8
(B5-B7) / (B5+B7)

The standardized NBR combustion index uses NIR 
and SWIR bands to highlight burnt areas, attenuating 
differences in lighting and weather conditions. Before 
using this index, your images must be adjusted for 
reflection values.
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NDWI Sentinel 2
(B03-B08) / 
(B03+B08)
NDWI Landsat 8
(B3-B5) / (B3+B5)

The NDWI Normalized Difference Water Index uses 
reflected near-infrared radiation and visible green light 
to enhance the presence of such elements, excluding 
the presence of soil and terrestrial vegetation elements. 
NDWI allows researchers to estimate the turbidity of 
water bodies with the help of satellite images.

Index Stack Sentinel 2
(B03-B11) /
(B03+B11), 
(B8A-B04) /
(B8A+B04), 
(B03-B08) / 
(B03+B08)
INDEX STACK 
Landsat 8
(B3-B6)/
(B3+B6),(B5-B4)/
(B5+B4),(B3-B5)/
(B3+B5)

In this index, the images are changing, and certain 
colors can be equated to different elements of the 
landscape. For example, the vegetation here turns green, 
the water turns purple, the snow/ice turns purple, and the 
soil, rocks, and barren land turn blue.

NDSI Sentinel 2
(B03-B11) / (B03+B11)
NDSI Landsat 8
(B3-B6) / (B3+B6)

The Normalized Difference Snow Index (NDSI) is 
a spectral band ratio that uses the spectral differences of 
snow in the shortwave infrared and visible spectral ranges 
to identify snow compared to other features in the scene. 
At visible wavelengths, the snow cover is as bright as 
clouds, and therefore difficult to be distinguish from the 
cloud cover. However, at a wavelength of 1.6 microns, the 
snow cover absorbs sunlight, and therefore has a much 
darker view than clouds. This allows us to effectively 
distinguish between snow cover and clouds. Values of 
NDSI “> 0.4” usually indicate the presence of snow.

End of Annex 6
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List of Satellite Images Used for Tasks Performance 
in this Guidance Manual

Section І

Landsat 5 satellite images capturing the territory of Kyiv as of April 7, 1984 
and Sentinel 2 as of September 10, 2019.

Sentinel 2 satellite images capturing the territory of Kyiv as of  October 4, 2015 
with tile numbers 36UUB and 36UUA.

Section ІІ

Sentinel 2 satellite images capturing the Fastivske Forestry Enterprise territory 
as of October 4, 2015 and September 10, 2019.

Sentinel 2 satellite images capturing the Kyiv Cistern territory as of August 6 
and 9, 2016.

Sentinel 2 satellite images capturing the the Baryshivskyi District of Kyiv 
Oblast territory as of April 18, 2018 and May 23, 2018 of.

Seven Sentinel 5P images capturing the territory of Ukraine for the period from 
September 1 to September 7, 2019 showing NO2 and SO2 concentration.

You can use this QR code to download all the sat-
ellite images used by us for Tasks performance in 
this Guidance Manual.
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